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DYNAMIC HOST CONFIGURATION PROTOCOL (DHCP)

Prerequisites:

Before working on this lab, you must have

1. A computer running windows 2008 server or Domain Controller.

2. A computer running windows 2008 server or windows 7.

SYS1

SYS2

MICROSOFT.COM

SYS1

Domain Controller / DHCP Server
IP Address 10.0.0.1

Subnet Mask  255.0.0.0

Preferred DNS 10.0.0.1

SYS2

Member Server / Client
IP Address 10.0.0.2
Subnet Mask ~ 255.0.0.0

Preferred DNS 10.0.0.1
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Lab — 1: Installing DHCP Service
SYS1 - CONFIGURATION

1.  Select Start >Programs > Administrative Tools > Server Manager.

LI

Administra.. Recyde Bin

K Terminal Services
o =3 Active Directory Domains and Trusts

Computer Ml Active Directory Sites and Services

] Active Directory Users and Computers
DHC ADST Edit

&, Component Services
| Computer Management
Data Sources {ODBC)
DNS
Event Viewer
Group Policy Management
|. Accessories ISCSI Initiator

Local Security Palicy

|. Extras and Upgrades Memary Diagnostics Tool
. Maintenance Reliability and Performance Manitor
|. Microsoft Office Security Configuration Wizard
|, Startup
& nternet Explorer G services
Windows Contacts | Share and Storage Management
Storage Explorer

] System Configuration

@ Windaws Firewall with Advanced Security

[ 7start | G B | U Windows Server Backup

Wi My 10:17PM

2. In the Server Manager Console, Select Roles

i

File Action View Help

@ 7@

e
=

52] Roles
ﬁ Features N
ﬁ Diagnostics ) }new the health of the roles installed on your server and add or remove roles and
. 4 eatures.
i} Configuration 2
=5 storage =
A Roles Summary Roles Summary Help
~) Roles: 2 of 16 installed 3{) Add Roles

35 Remove Roles
/1. Active Directory Domain Services

&5 DNS Server

(~) Active Directory Domain Services AD DS Help
Stores directory data and manages communication between users and domains, including
user logon hentication, and directory hes.
R [ Go to Active Directory Domain
Role Status e vives
Messages: None

System Services: 9 Running, 1 Stopped

/L. Events: 11 warnings, 55 informational in the
last 24 hours

%:; Last Refresh: 12/17/2008 7:27:38 AM Configure refresh
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Right click Roles and Click Add Roles.

E Server Manager B alg.lﬁl
File Action View Help

@ |7[m|
% e e
) R
i Feat

., View the health of the roles installed on your server and add or remove roles and

ﬁé Contf : _~features.
53 storg View

(~) Roles Summary ﬂ Roles Summary Help

Help

~) Roles: 2 of 16 installed 32 Add Roles

i Remove Roles
/& Active Directory Domain Services

3 DNS Server

(~) Active Directory Domain Services AD DS Help
Stores di y data and i between users and domains, including
user logon h and directory %
R [ Go to Active Directory Domain
Role Status e Chvives
Messages: None

System Services: 9 Running, 1 Stopped

& Events: 11 warnings, 55 informational in the
last 24 hours

£J Last Refresh: 12/17/2008 7:27:38 AM Configure refresh
|add roles to this server. [

In Add Roles dialog box select the check box next to DHCP Server Role & click
Next.

Add Roles Wizard B x|
ﬂ Select Server Roles
Before You Begin Select one or more roles to install on this server.
Server Roles Roles: Description:
DHCP Server 5 i DynamicHost ConfigurationProtocol
3] ».\cme Directory Certificate Services (DHCP) Server enables you to
Network Connection Bindings A ey centrally configure, manage, and
AT S [] Active Directory Federation Services providetemporary IP addresses and
S [] Active Directory Lightweight Directory Services related information for client.
1Pv4 WINS Settings [] Active Directory Rights Management Services computers.
DHCP Scopes Application Server
DHCPv6 Stateless Mode
IPv6 DNS Settings [] Fax Serv
DHCP Server Authorization [E] e Services
[] Network Policy and Access Services
Confirmation [ Print Services
Progress [] Terminal Services
e [] uDDI Services
= [ web Server (115)
[] windows Deployment Services

< Previous I Next > I Instal Cancel
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5.  Again click Next, and Select the Network Interface that the DHCP Server will use

to serve the Clients (By default it will be selected) and click Next.

Add Roles Wizard T x|

ﬁi Select Network Connection Bindings

PRI One or more network connections having a static IP address were detected. Each network connection can
Server Roles be used to service DHCP dients on a separate subnet.
DHCP Server Select the network connections that this DHCP server will use for servicing clients.

Network Connection Bindings
Network Connections:

IPV3DNS Settings IP Address I Type I
1Pv4 WINS Settings 10.0.0.1 Pv4
DHCP Scopes
DHCPv6 Stateless Mode
1Pv6 DNS Settings
DHCP Server Authorization
Confirmation
Progress
Results
[~ Details
Name: Local Area Connection 2
Network Adapter: Realtek RTL8139/8 10x Family Fast Ethernet NIC =2
Physical Address: 00-13-8F-EE-B9-87

Cancel

< Previous l Next > l

6. Mention the Parent Domain name & DNS server IP address (By default it will be

given) click Validate & click Next.
Add Roles Wizard i x|

& Specify IPv4 DNS Server Settings

Before You Begin . . = .
When dients obtain an IP address from the DHCP server, they can be given DHCP options such as the IP
Server Roles addresses of DNS servers and the parent domain name. The settings you provide here will be applied to clients
Server using IPv4,
Network Connection Bindings Specify the name of the parent domain that clients will use for name resolution. This domain will be used for all

scopes you create on this DHCP server,

IPv4 DNS Settings

1Pv4 WINS Setti Parent Domain:
Jmicrosoft.com

DHCP Scopes

DHCPv6 Stateless Mode

IPv6 DNS Settings

DHCP Server Authorization

Specify the IP addresses of the DNS servers that dliients will use for name resolution. These DNS servers will be
used for all scopes you create on this DHCP server.

Preferred DNS Server IPv4 Address:

Confirmation

|10.0.0. 1 Validate
Progress
Results

Alternate DNS Server IPv4 Address:

More about DNS server settings

< Previous | Next > I

Cancel
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Select WINS is not required (Default) click Next.

Add Roles Wizard

& Specify IPv4 WINS Server Settings
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9. Select Disable IPv6 Stateless mode & click Next.

Add Roles Wizard x|

ﬁ Configure DHCPv6 Stateless Mode

Before You Begin DHCP Server supports the DHCPv6 protocol for servicing IPv6 clients. Using DHCPvS, clients can
- i ir own IPV6. using stateless mode, or they can acquire IPv6

Server Rol addresses in stateful mode from the DHCP server. If routers on your network are configured to support
DHCP Server DHCPvS, verify that your selection below matches the router configuration.

Network Connection Bindings

1Pv4 DNS Settings Select the DHCPV stateless mode configuration for this server,

RIS etxie € Enable DHCPY6 stateless mode for this server

DHCP Scopes 1Pv6 clients will be automatically configured without using this DHCP server.

DHCPv6 Stateless Mode

DHCP Server Authorization (% Disable DHCPV6 stateless made for this server
Confirmation After installing DHCP Server, you can configure the DHCPv6 mode using the DHCP Management console.
Progress
Results

More about DHCPv6 stateless mode

< Previous l Next > I

Cancel

10. To authorize the DHCP server select Use Current Credentials & click Next.

Add Roles Wizard I x|
@ Authorize DHCP Server
Before You Begin Active Directory Domain Services (AD DS)stores a list of DHCP servers that are authorized to service

clients onthe network. Authorizing DHCP servers helps avoid accidental damage caused by running DHCP

Server Roles servers with incorrect configurations or DHCP servers with correct configurations onthe wrong network.
Specify credentials to use for authorizing this DHCP server in AD DS.
Network Connection Bindings
Pv4 i
DS Setiings % Use current credentials
IRVAWIE Sty The credential of the current user will be used to authorize this DHCP server in AD DS,
DHCP Scopes User Name:  [MICROSOFT\Administrator
DHCPv6 Stateless Mode
Confirmation
" Use alternate credentials
Progress
Results Specify domain administrator credentials for authorizing this DHCP server in AD DS.

User Name: | Specify... I

" Skip authorization of this DHCP server in AD DS

/4, This DHCP server must be authorized in AD DS before it can service dients.

More about authorizing DHCP servers in AD DS

Cancel

< Previous I Next > I

10



11.

12.

13.

Confirm the Installation Selections & click Install.

Add Roles Wizard

E Confirm Installation Selections

Before You Begin
Server Roles
DHCP Server
Network Connection Bindings
1Pv4DNS Settings
1Pv4 WINS Settings
DHCP Scopes
DHCPv6 Stateless Mode
DHCP Server Authorization
Progress
Results

Installation will Start & Installation will be Succeeded, and click Close.

To install the following roles, role services, or features, click Install.

@ 1informational message below

~) DHCP Server

IPv4 DNS Settings

Network Connection Bindings:

(@) This server might need to be restarted after the installation completes.

10.0.0.1 (IPv4)

DNS Parent Domain: Microsoft.com
DNS Servers: 10.0.0.1
WINS Servers: None
Scopes: No scopes defined
DHCPv6 Stateless Mode: Disabled
DHCP Server Authorization: Authorize using credentials associated with
MICROSOFT \Administrator

Print, e-mail, or save this information

< Previous Next >

Cancel I

Add Roles Wizard

ﬁ Installation Results

Before You Begin
Server Roles
DHCP Server
Network Connection Bindings
1Pv4 DNS Settings
IPv4 WINS Settings
DHCP Scopes
DHCPy6 Stateless Mode
DHCP Server Authorization
Confirmation

Progress

The following roles, role services, or features were installed successfully:

1 1warning message below

jj} Windows automatic updating is not enabled. To install the latest updates, use Windows Update in
Control Panel to check for updates.

DHCP Server @' Installation succeeded

Print, e-mail, or save the installation report

DHCP Server Role will be installed.

Windows Server 2008 - Network Administration

x|
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Lab — 2: Creating a scope

Select Start = Programs = Administrative Tools > DHCP.

L

Administra.. Recydle Bin

Terminal Services

Active Directory Domains and Trusts
g Active Directory Sites and Services
Active Directory Users and Computers

ADSI Edit
*« Component Services

Computer

Computer Management
Data Sources (ODBC)

DNS
Event Viewer
Group Policy Management

TRAATC O e

Accessories » |&&, iSCSI Initiator
»| 3 Local Security Policy

Documents Extras and Upgrades ¥ | 3| Memory Diagnostics Tool

Maintenance > @ Reliability and Performance Monitor
SR *| | Mcosoftofice |3 Security Configuration Wizard
Search »| ). Startup »| o Server Manager

@ Internet Explorer . Services

Help and Support [5=] Windows Contacts 2 Share and Storage Management

8 Storage Explorer

System Configuration

() Task Scheduler

@ Windows Firewall with Advanced Security
W Windows Server Backup

Orstart| | 3 M | y #25PM

Expand the System name =>Right click IPv4=>select New Scope

Conce R - £
‘Flle Action View Help ‘
A EERE ]
Do I —

= B sysimicosoft.com

Display Statistics... Add a Scope

New Scope

T is a range of IP addresses assigned to computers requesting a dynamic IP address. You must create and

re & scope before dynamic IP addresses can be assigned.

Define User Classes...
Define Vendor Classes...

anew scope, on the Action menu, click New Scope.

& information about setting up a DHCP server, see online Help.
Reconclle Al Scopes...

Set Predefined Options...
View »
Refresh

Properties

Help

(Create a new scope [

The New Scope wizard starts. click Next.

New Scope Wizar

Welcome to the New Scope
Wizard

Thiz wizard helps vou set up a scope for distributing [P
addiesses to computers on your netwark.

To continue, click Mest

< Back Cancel

12
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In the Scope Name screen, type in a name and a description for the scope in the

text boxes provided. Click Next.

New Scope Wizard

Scope Name )
You have to provide an identifving scope name. You alzo have the option of

providing a description.

Tvpe a name and description for this scope. T his information helps you quickly identify
how the scope iz to be uzed on your netwark.

Name: ISEDPE1

Description: I

< Back I Hest > I Cancel

The IP Address Range screen appears. In the “Start IP address” and “End IP
address” text boxes, enter the IP addresses that will define the range of the

scope and the subnet mask. click Next.

New Scope Wizard )

IP Addiess: Range =
Yeus define the scope addiess raroe by dentiyng a et of contecutive IP |
addiesses

Enter the sange of addeesses that the scope datrbeses

StiPaddess [ 10 0 0 1

EndiPaddess: | 10 0 . 0 255

A subnet mask defines how many bits of an IP addiess 10 use for the network/subnet
105 8nd how mary bits to use for the host 1D, You can specly the subnet mask by
length c¢ a3 an IP addess

Length |
Sybnet mask: &S50 0 0

< Bock Nest > Concel |

Note: Mention the scope range in the same network of DHCP server.

13
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6. To exclude IP addresses, enter the Start and end IP address of the range you

want to exclude and click Add. click Next.

New Scope Wizard

Add Exclusions —
Excluzions are addresses or a range of addresses that are not distributed by the

SRIVEL

Tuvpe the IP address range that you want to exclude. |f you want to exclude a single
address, type an address in Start IP address anly.

Start IP address: End IP address:

m.0.0.1 m. 0.0 .10 Add |
Excluded address range:
Femove |

< Back I Hest > I Cancel

7. In the Lease Duration screen, either accept the default DHCP lease duration of

eight days, or configure custom lease duration. click Next.

New Scope Wizard

Lease Duration ——
The leaze duration specifies how long a client can use an IP address from this

SCOPE.

Lease durations should tpically be equal ta the average time the computer iz
connected to the zame phyzical network. For mobile network. s that conzist mainly of
portable computers or dialup clients, shorter lease durations can be useful
Likewize, for a stable network that congists mainly of desktop computers at fixed
locations, longer lease durations are mare appropriate.

Set the duration for scope leases when distibuted by this server.
Limited to:

Daps: Hours: Minutes:
P PP

< Back I Mest » I Cancel

14
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In the Configure DHCP Options screen, choose Yes, | want to configure these
options now to configure DHCP options for this scope (such as routers, DNS, and

WINS settings) now. click Next.

Configure DHCP Options —
“You have to configure the most common DHCP options before clients can use the

SCOPE.

‘when clients obtain an address, they are given DHCP options such as the IP
addrezses of routers [default gateways), DMS servers, and WINS settings for that
scope.

The =ettings vou select here are for thiz scope and override zettings configured in the
Server Options folder for this server.

Do you want to configure the DHCP options for this scope now?

' ¥es, | want to configure these options nov

€ Mo, | will configure these options later

< Back I Mest » I Cancel

In the Router (Default Gateway) screen, enter the IP address of the router that
will function as the default gateway for this scope clients and click Add. Or, if you

don’t have a Router in your network, just click Next.

New Scope Wizard

Router [Default Gateway] )
“You can gpecify the routers, or default gateways, to be distributed by thiz scope.

To add an IP address for a router used by clients, enter the address below.

IP address:

||... Add

Bemove

[

Up

[rotwr

i

< Back I Hest > I Cancel
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10. In the Domain Name and DNS Servers screen enter the name of the Parent
Domain &IP address of the DNS server, click Add=> click Next.

Domain Name and DNS Servers
The Domain Name System {DNS) maps and translates domain names used by
clients on your network.

You can specify the parent domain you want the client computers on your network to use for
DNS name resolution.

Parent domain: IM\Crcsoft.com

To corfigure scope clients to use DNS servers on your network, enter the |P addresses forthose

servers.
Server name: |P address:
SYS1 |1c,:.:.1

Resolve I

11. In the WINS Servers screen enter the IP address of the WINS server. Click Add.

click Next. Or, if you don’t have a WINS server on your network, just click Next.

New Scope Wizard

WINS Servers —
Computers running Windows can use WINS servers to convert NetBI0S computer

names to [P addresses.

Entering server IP addresses here enables Windows clients to queny WINS before they use
broadcasts to register and resolve NetBIDS names.

Server name: |IP address:

| L .

Fesalve | Bemave

L1

Dot

To change this behavior for Windows DHCP clients modify option 046, WINS/MNET Node
Tvpe. in Scope Options.

< Back I Mest > I Cancel
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12. Inthe Activate Scope screen, select YES and click Next.

New Scope Wizard

Activate Scope -
Clientz can obtain address leazes only if a scope is activated.

Do you want to activate this scope now?

& ¥es, | warl to activate this scope now

7 Mo, L will activate this scope later

< Back I Mest » I Cancel |

Note: A DHCP server can’t assign IP addresses until the scope is activated.

13. Click Finish to complete the creation of Scope.

New Scope Wizard

Completing the New Scope
Wizard
Y'ou have successfully completed the Mew Scope wizard.

To close this wizard, click Finish.

Cancel

< Back

17
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SYS2 - CONFIGURATION
Verification: In DHCP Client

1.  Right click on network Icon =>Select properties =>click View Status and select
properties > Select Internet protocol Version 4 (TCP/IPv4) Properties and select
Obtain an IP Address automatically & Obtain an DNS Server Address

Automatically > 0K
2| ]

General |Alternate Configuration |
‘fou can get IP settings assigned automatically if your network supports

this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

% Ohtain an IP address automatically
—" Use the following IP address:

IF address: I
Sutbmet mask: I
Default gateway: I

¥ Dbtain DNS server address automatically!

—{" Use the following DMS server addresses:

Ereferred DHS servet: I
Alternate DHS server: I

Advanced... |
OK I Cancel |

2.  Open the Command Prompt = and type ipconfig /release

[c+. Administrator: C:\Windows\system32\cmd.exe

C:\>ipconfig /release
Windows IP Configuration

An error occurred while releasing interface Loophack Pseudo—-Interface 1 : The sy
stem cannot find the file specified.

Ethernet adapter Local Area Connection:

Connection—specific DNS Suffix .
Default Gateway . .

C:\>ipconfig /renew

Ethernet adapter Local Area Connection:

L T e It Microsoft.com
1Pu4 Addy Y 10.60.8.11
Subnet Mask . TN OLC (3.8.0

Default Gateway .

18
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4.  After that Right click on network Icon >Select properties 2> click View Status and

click Details to View the IP address.
x|

General l
Connection
IPv4 Connectivity: Local
1Pv6 Connectivity: Limited
Media State: Enabled
Duration: 00:43:27
Speed: 100.0 Mbps

Activity

Sent — &E — Received
E 24
Bytes: 16,50 | 15,479

@Properﬁesl @Disable I Diagnose |

Close I
x

Network Connection Details:
Property | Value
Connection-specific DN... Microsoft.com
Description Realtek RTL8139/810x Family Fast Ether
Physical Address 00-13-8F-F3-05CF
DHCP Enabled Yes
IPv4 IP Address 10.00.11
IPv4 Subnet Mask 255.0.0.0
Lease Obtained Sunday, October 18, 2009 8:48:08 PM
Lease Expires Monday, October 26, 2008 8:48:08 PM

|Pv4 Default Gateway
IPv4 DHCP Server 10.0.
IPv4 DNS Server 10.0.
IPv4 WINS Server

NetBIOS over Tepip En...  No

1
1

c
© o

«| | i

19



Windows Server 2008 - Network Administration

Lab — 3:_ Creating DHCP Reservations

SYS1 - CONFIGURATION

1.  Select Start = Programs = Administrative Tools =>DHCP

Administra.. Recydle Bin

A

-
Computer

Terminal Services
5 Active Directory Domains and Trusts
[ Active Directory Sites and Services

| Active Directory Users and Computers
Z' ADSI Edit

%. Component Services

& Computer Management

5 Data Sources (ODBC)
Host NameZ
2 bns

1P Addl‘eSS Event Viewer

i _é Group Policy Management

»| L Accessories »|&, iSCSI Initiator
b »| 34 Local Security Policy
| Extrasand Upgrades » |(x| Memory Diagnostics Tool
| Maintenance »|@ Reliabilty and Performance Monitor
v |. Microsoft Office »| 34 Security Configuration Wizard
»| |, Startup »| 5o Server Manager
& Internet Explorer . Services
@ Help and Support [2=] Windows Contacts 2 Share and Storage Management

L# Storage Explorer

System Configuration

(©) Task Scheduler

@ Windows Firewall with Advanced Security
& Windows Server Backup

15 Run...

@ Shut Down...
Lrstan] | 5, m |

Windows Server 2008 Enterprise

E2S @iy +25PM

2. In the left pane of the DHCP dialog box, expand the scope=> Right click

Reservation = Select New Reservation
oonce R - |

File Acton View Help

@ | 5w o B[k

= E sys1.microsoft.com

ERcY
=1 (23 Scope [10.0.0.0] SCOPE | Reservations
({2) Address Pool
@ Address Leases A reservation ensures that a DHCP client is always assigned the same IP address.

New Reservation... tion, on the Action menu, click New Reservation.

View » |n prevents a DHCP client from ever obtaining an address from a specified address range.
an be defined in Address Pool.

(L3 Server Options
B @ P

(Cg Server Options

Refresh
Help

tion about reservations and exclusions, see online Help.

I |

[Creahe a new reservation

20
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3. Type in a name for the reservation in the “Reservation name” text box. Then, in
the “IP address” text box, mention the IP address that you want to be reserved.
Then, enter the MAC address of the network adapter of the computer for which
the reservation is being made in the box provided =>click add =>click close.

Note: To Know the MAC or Physical address of the client type ipconfig /all or

getmac in command prompt of client computer.
[

Provide information for a reserved client.

Reservation name: ISVSZ

|P address:

MAC zddress:

Description: I

— Supported types
(% Both
" DHCP only
" BOOTP only

Close

Check the output in the client computer (SYS2).

4. Inthe command prompt type ipconfig /release and ipconfig /renew.
Select Administrator: C:\Windows\system32\cmd.exe

Media State . . . . . . . . . . . : Media disconnected
Connection—specific DNS Suffix . =

C:\Users\Administrator.S¥S2.0810>ipconfig /renew
Windows IP Configuration

An error occurred while releasing interface Loophack Pseudo—Interface
stem cannot find the file specified.

Ethernet adapter 18.8.68.1:

Connection—specific DNS Suffix . SN ELIaaa
IPv4 Address. . . . .

Subnet Mask . . .

Default Gateway .

21
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Lab — 4: DHCP Server Backup and Restore

Open DHCP server > Right click the system name > select Backup

8 pHCP

File Acton View Help
€9 2R IRE o= |HE EE
B0
= 8 sys1.microsoft.com N—'—
Add/Remove Bindings... Sa T:\ 3
Unauthorize !
B
Restore...
All Tasks »
View »
Delete
Refresh
Export List...
Properties
Help

Select the Location to save the backup file 20K

Browse For Folder 21
Select the Falder where the DHCP server should place the
backed up files.

[ CatRoot =]

|2) CatRoot2

L0 certsry

L3 clients
) Com

I3 config

Bl ) dhep

= backup =
____=¢ -

[Make Mew Folder |

Cancel |

4

Delete the scope

File Acton View Help
&5 [ 2nEe:E HE|S2E

Do e

S| 8 sys1.microsoft.com —l—
B [ Pv4 Contents of DHCP Server Status
Ef=] Scope [10.0.0.0] SCOPE (A Scope [10.0.0.0] SCOPE1 == Active **
Ad Display Statistics... [ OPtons
(@ Ac

@@ Re Reconcile...
@ S peactivate

(A server
8 ws
Refresh
Properties
Help

22
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Open DHCP server > Right click the system name > select Restore.

File Acton View Help
& || RE o= | HE|EE
Toc
= 8
ame
Add/Remove Bindings... Brva
E . v
Unauthorize Byeve
Backup...
All Tasks >
View »
Delete
Refresh
Export List...
Properties
Help

Select the location of file for restoring.

Browse For Folder 2 x|
Select the folder where the DHCP server can find the
backed up files,
[ CatRoot2 =]
£ certsry
I3 clients
I3) Com
confi
] g .
= 3 dhep
El=]backup |
) new -
« - I _'I_I
Make Mew Folder | [s]4 I Cancel |
A

Click yes in the message and refresh.
once ]

/g, Inorder for changes to take effect, the service must be stopped
;LA and restarted. Would you like to do this now?

Yes No

23
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DOMAIN NAMING SYSTEM (DNS)
Prerequisites:

Before working on this lab, you must have
1. A computer running windows 2008 server or Domain Controller.

2. A computer running windows 2008 server.

SYS1 SYS2

MICROSOFT.COM

SYs1 SYS2

Domain Controller / DNS Server Member Server / DNS Server
IP Address 10.0.0.1 IP Address 10.0.0.2
Subnet Mask  255.0.0.0 Subnet Mask  255.0.0.0
Preferred DNS 10.0.0.1 Preferred DNS 10.0.0.2
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Lab — 1: Installing DNS Service

SYS1 -CONFIGURATION

1.  Select Start »Programs > Administrative Tools->Server Manager.

LR

Administra.. Recyde Bin

| Terminal Services
b =3 Active Directory Domains and Trusts

Ml Active Directory Sites and Services
] Active Directory Users and Computers
DNS 2 ADSI Edit
. Component Services
A Computer Management
HOSt Nan]f Data Sources (ODEC)

DNS

=)
Windows Update IP Address Q Event Viewer

Group Palicy Management

Computer

DA O e -
B rrooams || pccessories 6, st Intor

- [ - Loce secunty Polcy
brznes | Extras and Upgrades b (] Memory Diagnostics Tool

=j

23
O]

Fit

. Maintenance

. MNero 7 Essentials Security Configuration Wizard
. Startup Server Manager

@ Internet Explorer
Viindows Contacts

p Search »
@ Help and Support

j Run...

L4 Services
'z Share and Storage Management

'# Storage Explorer

System Configuration

() Task Scheduler

@ Windows Firewall with Advanced Security
W Windows Server Backup

‘Windows Server 2008 Enterprice

Shut Down...

« [V0n 323PM

2. In the Server Manager Console, Select Roles

o

File Action View Help

@ 7@

e
= 7

52] Roles
ﬁ Features N
ﬁ Diagnostics , View the health of the roles installed on your server and add or remove roles and
= features.
i} Configuration 2
=5 storage =
A Roles Summary Roles Summary Help
~) Roles: 2 of 16 installed 3{) Add Roles

5,' Remove Roles
/i Active Directory Domain Services

&5 DNS Server

~) Active Directory Domain Services AD DS Help

Stores directory data and manages communication between users and domains, including
user logon hentication, and directory hes.

S [ Go to Active Directory Domain
Role Status & ey

Messages: None

System Services: 9 Running, 1 Stopped

/L. Events: 11 warnings, 55 informational in the
last 24 hours

%:; Last Refresh: 12/17/2008 7:27:38 AM Configure refresh
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Right click on Roles and click Add Roles.

=Tk
File Acton View Help

Lo A ol 7]

Add Roles
2

, View the health of the roles installed on your server and add or remove roles and

Remove Roles

features.
View »
g New A =
Refresh ~) Roles Summary Roles Summary Help
Help -
~ Roles: 2 of 16 installed % Add Roles

3;' Remove Roles
/1. Active Directory Domain Services

4 DNS Server

~! Active Directory Domain Services AD DS Help b
Stores directory data and manages communication between users and domains, including
user logon hentication, and directory h
R [F Go to Active Directory Domain
Role Status o

Messages: None
System Services: 9 Running, 1 Stopped

/1. Events: 11 warnings, 55 informational in the
last 24 hours

') Last Refresh: 12/17/2008 7:27:38 AM  Configure refresh
|Add roles to this server. [

In Add Roles dialog box select the check box next to DNS Server Role & click Next
- Next-> Install = Finish.

Add Roles Wizard 3 x|
ﬁ Select Server Roles
Before You Begin Select one or more roles to install on this server.
Server Roles Roles: Description:
Confirmation = Active Directory Certificate Services
L Active Directory Certificate Servtce's [AD CS)is used to create certification
Progress =2 authorities and related role services
Results LJ v that allow you to issue and manage
[] Active Directory Lightweight Directory Services certificates usedin a variety of
] Active Directory Rights Management Services applications.
[] Application Server
[[] pHcP Server
g
[] File Services
[] Network Policy and Access Services
[] Print Services
[] Terminal Services
[] uDDI Services
[] web server (115)
[[] windows Deployment Services
More about server roles

<Prevmus| Next> | Install I Cancel I

Note: On Domain Controller, by default DNS Server Role will be installed.

On Member Server we have to install the DNS Server Role Manually using the

same process.
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Lab — 2: Creating Standard Primary - Forward Lookup Zone

Select Start = Programs = Administrative Tools > DNS.

L

Administra.. Recyde Bin

. Terminal Services
5 Active Directory Domains and Trusts
Ml Active Directory Sites and Services
| Active Directory Users and Computers

DNS 2 ADSIEdit

#. Component Services

& Computer Management

HOSt Nan]f Data Sources (ODBC)

twork & DNS

Windows Update 1P Addl‘ess Event Yiewer
2 Groun Policy Management

'B-B Programs e iSCSI Initiator
i Local Security Policy

Documents

» @ Relisbility and Performance Monitor

v | 3 Security Configuration Wizard

3 i Server Manager

. Services

'z Share and Storage Management

% Storage Explorer

& system Configuration

(1) Task Scheduler

@ Windows Firewall with Advanced Security
W Windows Server Backup

. Maintenance

Settings »
. MNero 7 Essentials

. Startup
& Tnternet Explorer
Windows Contacts

Search 3

« @il 3:21PM

In the DNS dialog box, Expand the DNS server name in the left pane Right click

the Forward Lookup Zones = select New Zone
=T

File Action View Help
o9 Hmlc= HElEED

Name | Type | Status |
=] _msdcs.microsoft.com Active Direct...  Running
iccgsoft.com Active Direct...  Running

View

Conditional Fory
Global Logs

Refresh
Export List...

BRE

Help

Create a new zone.
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In the welcome to new zone wizard click Next

New Zone Wizard |

Welcome to the New Zone
Wizard

This wizard helps you create a new zone for your DNS
SErver,

A zone translates DNS names to related data, such as IP
addresses or network services,

To continue, click Mext.

= Back

Cancel |

Select “Primary Zone” and Remove the check box for "Store the zone in Active

Directory", click Next.
x

Zone Type
The DNS server supports various types of zones and storage. 2

Select the type of zone you want to create:
P :

Creates a copy of a zone that can be updated directly on this server,

(" Secondary zone
Creates a copy of a zone that exists on another server. This option helps balance
the processing load of primary servers and provides fault tolerance.

" Stub zone

Creates a copy of a zone containing only Name Server (NS), Start of Authority
(SOA), and possibly glue Host {(A) records. A server containing a stub zone is not
authoritative for that zone,

[~ Store the zone in Active Directory (available only if DNS server is a writeable domain
controller)

< Back I Next = I Cancel
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5. In the Zone Name screen, type in the name of the zone you are creating. This
name is usually the FQDN of the DNS domain that the zone will contain, such as

YAHOO.COM —>click Next.
T E— x

Zone Name
What is the name of the new zone? 2

The zone name specifies the portion of the DNS namespace for which this server is
authoritative. It might be your organization's domain name (for example, microsoft.com)
or a portion of the domain name (for example, newzone.microsoft.com). The zone name is
not the name of the DNS server,

Zone name:
YAHOO.COM|

< Back I Next = I Cancel

6. The Zone File screen appears. In this screen, you can either create a new zone file

for the new zone, or configure the new zone to use an existing file. click Next.

New Zone Wizard i x|
Zone File
You can create a new zone file or use a file copied from another DNS server, 2

Do you want to create a new zone file or use an existing file that you have copied
from another DNS server?

% Create a new file with this file name::

| YAHOO.COM.dns

" Use this existing file:

To use this existing file, ensure that it has been copied to the folder
%SystemRoot%% \system32'\dns on this server, and then click Next.

< Back I Mext = I Cancel
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7. In dynamic Update Select "Allow both non-secure and secure dynamic
update"->click Next.

New Zone Wizard x|

Dynamic Update
You can specify that this DNS zone accepts secure, nonsecure, or no dynamic v
updates. >

Dynamic updates enable DNS client computers to register and dynamically update their
resource records with a DNS server whenever changes occur,

Select the type of dynamic updates you want to allow:

€ allovs only secure dynamic updates {recommended for. Active Directary)
This option is available only for Active Directory-integrated zones.

{+ Aliow both nonsecure and secure dynamic updates:
Dynamic updates of resource records are accepted from any dlient.

’ This option is a significant security vulnerability because updates can be
“22  accepted from untrusted sources.

" Do not allow dynamic updates
Dynamic updates of resource records are not accepted by this zone. You must update
these records manually.

< Back I Next = I Cancel |

8. The Completing the New Zone Wizard screen appears. Click Finish.

New Zone Wizard i x|

Completing the New Zone Wizard

You have successfully completed the New Zone Wizard, You
specified the following settings:

[Name:  Yaroo.com =]
Type:  Standard Primary
Lookup type: Forward
H
Note: You should now add records to the zone or ensure

that records are updated dynamically. You can then verify
name resolution using nslookup.

To dlose this wizard and create the new zone, click Finish.

Cancel I

9. Inthe DNS Console, the new zone you created appears in the right pane.
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Creating Host Records for the standard primary zone

Select Start = Programs = Administrative Tools > DNS.

Right click the zone and select New Host.

iommansger

File Acton View Help

e HmI RO ci=@BEd 80
2 DNS Name [ Type | pata
B g svst :| (same as parent folder) Start of Authority (SOA) [1], sys1.microsoft.com.,
B [ Forward Lookup Zones ] (same as parent folder) Name Server (NS) sys1.microsoft.com.
M = _msdcs.microsoft.com
[z] microsoft.com
| Reverse Lookd  Update Server Data File
] Conditional Fof  Reload

[g1) Global Logs New Host (A or AAAA)...

New Alias (CNAME)...

New Mail Exchanger (MX)...
New Domain...

New Delegation...

Other New Records...

All Tasks 4

View »

Delete
Refresh
Export List...

Properties

Help

In the host name dialog box enter the Host name for which you are configuring
the record Ex: SYS1 & enter the corresponding IP address of the host —>click
‘Add Host’ 2 OK = Done.

ewrost x|

Name {uses parent domain name if blank):
| 5Y51

Fully qualified domain name (FQDN):
| SYS1.YAHOO.COM.

IP address:
| 10.0.0.1

[" Create associated pointer (PTR) record

Add Host Cancel
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Creating an Alias record for the host record

Select Start = Programs > Administrative Tools > DNS.
Right click the zone and select New Alias.

Enter the name in the ‘Alias Name’ dialog box Ex: www

P W NP

Click Browse =>»Double click system name =>double click Forward Lookup Zone
—>double click the zone name > select the host name 2> click OK> 0K
B2

Alias (CNAME) [

Alias name {uses parent domain if left blank):

Fully qualified domain name (FQDN):
I WWW.YAHOO,COM,

Eully qualified domain name (FQDN) for target host:

SYS1.YAHOO.COM

OK Cancel

VERIFICATION:

1. Open Command Prompt =>type ping FQDN (Fully Qualified Domain Name)
Ex: Ping SYS1.YAHOO.COM (or) Ping WWW.YAHOO.COM
2. Name should be resolved into IP Address.

[+, Administrator: C:\Windows\system32\CMD.exe

Microsoft Windows [Uersion 6.8.600811]
Copyright {(c)> 20086 Microsoft Corporation. All rights reserved.

C:\Users\Administrator.S¥S1.008>PING WWW.YAHOO.COM

Pinging sys1.YAHOO.COM [18.0.8.1]1 with 32 hytes of data:
18.8.8.1: bytes=32 time<{ims TTL=128
180.8.0.1: bytes=32 time<{ims TTL=128
10.0.8.1: bytes=32 time<ims TTL=128

Reply from 18.8.68.1: bhytes=32 time<ims TTL=128

Ping statistics for 10.0.0.1:

Packets: Sent = 4. Received = 4, Lost = 8 (8% loss).
Approximate round trip times in milli-seconds:

Minimum = Bms, Maximum = @Oms. Average = Bms

C:\Users\Administrator.S¥S1.0008>
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Select Start = Programs = Administrative Tools > DNS.

In the DNS dialog box, Expand the DNS server’s name in the left pane Right click

the Reverse Lookup Zones > Select New Zone.

Fle Acton View Help

A EIEI I EE

= DNS
B F svs1
| Forward Lookup Zones
i Reverse Lookup Zones:

MNew Zone... aers

View

3

e
I_O_\ Add a New Zone
wr

The Domain Mame System {DNS) allows & DNS namespace to be divided into zones. Each zone sto
contiguous DNS domains.

To add a new zone, on the Action menu, dick New Zone,

Refresh

Help

Click Next
Hew Zone Wizard x|
Welcome to the New Zone
Wizard
This wizard helps you create & new zone for your DNS
server,
2

A zone translates DNS names to related data, such as IP
addresses or network services,

To continue, dlick Mext.

= Back I Mext = I Cancel
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4. Select “Primary Zone” and Remove the check box for "Store the zone in Active

Directory", click Next.

x

Zone Type
The DMS server supports various types of zones and storage.

.

Select the type of zone you want to create:

{* Primary zone
Creates a copy of a zone that can be updated directly on this server,

{~ Secondary zone
Creates a copy of a zone that exists on another server, This option helps balance
the processing load of primary servers and provides fault tolerance.,

" stub zone

Creates a copy of & zone containing anly Mame Server (NS), Start of Authority
(504), and possibly glue Host (A) records, A server containing a stub zone is not
authoritative for that zone.

™ store the zone in Active Directory (available only if DNS server is a writeable domain
controller)

« Back

Cancel |

5. Check IPv4 Reverse Lookup Zone
|

Reverse Lookup Zone Name
A& reverse lookup zone translates IP addresses into DNS names,

Choose whether you want to create a reverse lookup zone for IPv4 addresses or IPvé
addresses.

o IPv4 Reverse Lookup Zone

(o IPvé Reverse Lookup Zone

Cancel
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6. Inthe network ID give the first three octets Ex: 10.0.0->Next
x

Reverse Lookup Zone Name
A& reverse lookup zone translates IP addresses into DNS names,

To identify the reverse lookup zone, type the network ID or the name of the zone.

' Network ID:
m 0 0
The network ID is the portion of the IP addresses that belongs to this zone, Enter the
network ID in its narmal {not reversed) order.

If you use a zero in the network ID, it will appear in the zone name. For example,
network ID 10 would create zone 10.in-addr.arpa, and network ID 10.0 would create
zone 0. 10.in-addr.arpa.

™ Reverse lookup zone name:

0.0. 10.in-addr.arpa

< Back Cancel

7. Click Next
x

Zone File
‘You can create a new zone file or use a file copied from another DNS server,

Do you want to create a new zone file or use an existing file that you have copied
from another DMNS server?

% Create a new file with this file name:

ID.D.lD.in-addr.arpa.dns

" Use this existing file:

To use this existing file, ensure that it has been copied to the folder
SystemRoot3csystem32\dns on this server, and then dick Mext,

« Back

Cancel |
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In dynamic Update Select "Allow both non-secure and secure dynamic
update"->click Next = Finish
x

Dynamic Update
‘You can specify that this DNS zone accepts secure, nonsecure, or no dynamic
updates,

Dynamic updates enable DMS dient computers to register and dynamically update their
resource records with a DNS server whenever changes occur.

Select the type of dynamic updates you want to allow:

) allovsonly. secure dynamic updates (recommended for Ackive Bireckory)
This option is available only for Active Directory-integrated zones.

& Allow both nonsecure and secure dynamic updates
Dynamic updates of resource records are accepted from any dient.
This option is a significant security vulnerability because updates can be
“  accepted from untrusted sources,

" Do not allow dynamic updates:
Dynamic updates of resource records are not accepted by this zone. You must update
these records manually.

« Back I Mext = I Cancel

Creating pointer record

Select Start = Programs = Administrative Tools > DNS

Expand Reverse lookup zone and Right click the zone >select New Pointer

File Acton View Help

s | 5 REc=Hm 8

2 DNS Name | Type | Data
B § svst £ (same as parent folder) Start of Authority (SOA) [1], sys1.microsoft.com.
74 Forward Lookup Zones £ (same as parent folder) Name Server (NS) sys1.microsoft.com.
= || Reverse Lookup Zones
8

] Conditional i Update Server Data File
[£] Global Logs |  Reload

New Pointer (PTR)...
New Alias {CNAME)...
New Delegation...
Other New Records...

All Tasks >

View »

Delete
Refresh
Export List...

Properties

Help
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3. In the pointer record give the fourth octet - click browse =>double click server
name (SYS1) ->double click Forward Lookup Zone —>double click the zone
name(Yahoo.com) = double click the host name (SYS1) 20K
x|

Pointer (PTR) l

Host IP Address:
I 10.0.0.1

Eully qualified domain name (FQDN):
I 1,0.0.10.in-addr.arpa

Host name:

SYS1,YAHOO.COM

OK Cancel

Verification:
1.  Openthe command prompt and type nslookup 10.0.0.1

[+, Administrator: C:\Windows \system32\cmd.exe

Microsoft Windows [Uersion 6.60.608011
Copyright {(c)> 28086 Microsoft Corporation. All rights reserved.

C:\Users\Administrator.S¥S1.000>nslookup 10.0.0.1
Server: sysl.yahoo.com
Address: 10.6.6.1

Name : sysl.yahoo.com
Address: 10.68.68.1

C:\Users\Administrator.S¥S1.06000> _
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SYS1 - CONFIGURATION

1.

2.
3.
4.

5.

Windows Server 2008 - Network Administration

In SYS1 one primary zone should be present. E.g.: Yahoo.com

SYS2 - CONFIGURATION

Select Start = Programs > Administrative Tools > DNS.

In the DNS dialog box, Expand the DNS server’s name in the left pane.

Right click Forward Lookup Zones > select new zone > Next

File Action View Help

&= 7rle B 5 BE

Select Secondary zone = Next

New Zone Wizard

=, DNS
B g srs2 e
(i | Add a New Z
Global Logs 0 allew fone
B Forward Lookup Zones
= ,—| " The Domain Name System (DNS) allows a DNS namespace to be divided into zones, Each zone stores information about one or n
~ View ) B To add a new zone, on the Action menu, dick New Zone.
Refresh
Help

Zone Type
The DMS server supports various types of zones and storage. /‘5

Select the type of zone you want to create:

" Primary zone
Creates a copy of a zone that can be updated directly on this server,

o -
Creates a copy of a zone that exists on another server. This option helps balance
the processing load of primary servers and provides fault tolerance.

" stub zone

Creates a copy of & zone containing anly Mame Server (NS), Start of Authority
(S0A), and possibly glue Host (A} records. A server containing a stub zone is not
authoritative for that zone.

™| store the zonein Ackive Direckary (ayvaiable only if DS server is a writeable domain
contraller)

« Back I Mext = I Cancel
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6.  Give the name of primary zone > click Next.

New Zone Wizard

Windows Server 2008 - Network Administration

Zone Name
What is the name of the new zone? ¢

The zone name specifies the portion of the DNS namespace for which this server is
authoritative. It might be your organization's domain name (for example, microsoft.com)
or a portion of the domain name (for example, newzone.microsoft.com). The zone name is

not the name of the DNS server.

Zone name:

YAHOO.COM|

< Back I Next = I Cancel

7.  Give the IP address of primary zone Ex: 10.0.0.1 <> click Next.
x|

Master DNS Servers
The secondary zone is copied from one ar mare DNS servers,

0

Specify the DNS servers from which you want to copy the zone. Servers are

contacted in the order shawn.

Master Servers:

IP Address | Server FQDMN | Validated Delete |
-~ <Click here to ...
'@' 10.0.0.1 <Attempting tor... OK U |
oW |
« Back Cancel |
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8.  Click Next—> Finish.

New Zone Wizard |

Completing the New Zone Wizard

You have successfully completed the MNew Zone Wizard. You
specified the following settings:

Name: YAHOO.COM =]
Type:  Secondary
Lookup type: Forward
[
Mote: You should now add records to the zone or ensure

that records are updated dynamically. You can then verify
name resolution using nslookup,

To dose this wizard and create the new zone, dick Finish,

< Back Cancel

Allow zone transfers to secondary zone

SYS1-CONFIGURATION
1.  Select Start 2 Programs = Administrative Tools > DNS.
2. In the DNS dialog box, Expand the DNS server’s name in the left pane = Expand

Forward Lookup Zone > Right click primary zone > select properties.

File Acton View Help

& | ?mlo=z|Hsli8c

ggm D_N'-‘r Name | Type | Status I
S| SY51 -] _msdcs.microsoft.com Active Direct...  Running
[l [ Forward Lookup Zones microsoft.com Active Direct...  Running
5 _msdes.microsoft.com | = yaH00.COM Standard Pri...  Running
= microsoft.com

|

B[] Reverse Look] Update Server Data File
(2] 0.0.10.in{ Reload

| Conditional Fo  Mew Host (A or AAAA). ..

E}jl Global Logs New Alias (CNAME)...

New Mail Exchanger (MX)...

New Domain...

New Delegation...

Other New Records...

All Tasks »

Delete
Refresh

Help
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3.  Select zone transfers Tab > check the box for Allow zone transfers > select only
to the following servers.
General l Start of Authority (SOA) I
Name Servers I WINS Zone Transfers
A zone transfer sends a copy of the zone to the servers that request a
copy.
[V allgw zone transfers:
" To any server
{" Only to servers listed on the Name Servers tab
" Only to the following servers:
IP Address I Server FODN I
Edit |
To specify secondary servers to be notified of zone Notify...
updates, click Notify. L‘
oK I Cancel Apply | Help |
4.

Click Edit and mention the Computer IP address of secondary zone. Click Notify

- Select to the following servers >and mention the Computer IP address of
secondary zone.

Notify E x|

To automatically notify secondary servers when the zone changes, select the Automatically Notify check
box, and then specify the servers.

[V Automatically notify:
" servers listed on the Name Servers tab

(% The following servers

IP Address Server FODN I Validated I Delete
<Click here to add an IP Address or DNS Name > |
@ w.0.0.2 sys2.microsoft.com OK

OK I Cancel

5.  Click Apply 20K = Again Click Apply 2 OK.
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Lab — 5: Creating Stub zone
SYS1-CONFIGURATION

1. Log on to SYS1 and create a primary zone Msn.com along with host and alias

records.
SYS2-CONFIGURATION

1. Log on to SYS2 and Select Start & Programs = Administrative Tools = DNS.
2. In the DNS dialog box, Expand DNS server name in the left pane Right click
Forward Lookup Zones > Select new zone - Next

.;L DNS Manager

File Acton View Help

s rmc= Bl d 8.

2 NS Name | Type | status
B g syst 21 _msdcs.microsoft.com Active Direct...  Running
SRBSY Forward Lookup Zones ~| micrgsoft.com Active Direct...  Running

[ _msdcs.mic
(2] microsoft.cd

] Reverse Lookup View—b
(] Conditional Fory  pofach
(g] Global Logs Export List...

Help

4. Select Stub zone = Next

Hew Zone Wizard x|
Zone Type
The DMS server supports various types of zones and storage. /‘5

Select the type of zone you want to create:

" Primary zone
Creates a copy of a zone that can be updated directly on this server,

{~ Secondary zone
Creates a copy of a zone that exists on another server, This option helps balance
the processing load of primary servers and provides fault tolerance.

¢ stub zone
Creates a copy of & zone containing anly Mame Server (NS), Start of Authority

(504), and possibly glue Host (A) records, A server containing a stub zone is not
authoritative for that zone.

™| store the zonein Ackive Direckary (ayvaiable only if DS server is a writeable domain
contraller)

« Back

Cancel |
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5.  Give the name of primary zone (Msn.com) 2> click Next.

6.  Give the IP address of primary zone Ex: 10.0.0.1->click Next.
x

Master DNS Servers
The stub zone is loaded from one or more master servers, /‘5

Specify the DNS servers from which you want to load the zone, A stub zone is loaded
by querying the zone's master server for the SOA resource record, the NS resource
records at the zone's root, and glue A resource records.

Master Servers:

IP Address | Server FQDMN | Validated | [elete
<Click here to ...

@woo <Attempting tor...  OK Up |
{Bf]hip] |

« Back

9.  Click Next > Finish.

10. Refresh the stub zone and verify for records.
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Lab — 6: Creating Active Directory Integrated Primary zone

Select Start = Programs = Administrative Tools > DNS.

In the DNS dialog box, expand the DNS server’s name in the left pane Right click
Forward Lookup Zones > select new zone

Click Next = Accept the default option of “Primary Zone” and Select the check

box for "Store the zone in Active Directory" > click Next.

New Zone Wizard |
Zone Type
The DNS server supports various types of zones and storage.

Select the type of zone vou want to create:

o Primary zone
Creates a copy of & zone that can be updated directly on this server.

" Secondary zone
Creates & copy of & zone that exists on another server, This option helps balance
the processing load of primary servers and provides fault tolerance,

™ Stub zone

Creates a copy of a zone containing only Mame Server (NS}, Start of Autharity
(504), and possibly glue Host (A) records. A server containing a stub zone is not
authoritative for that zone,

v Store the zone in Active Directory (available only if DNS server is a writeable domain
controller)

< Back I MNext = I Cancel

In AD Zone Replication Scope, Select the “To all DNS servers in Active directory

domain” > click Next.

New Zone Wizard x|
Active Directory Zone Replication Scope
You can select how you want DNS data replicated throughout your network. D
5

Select how you want zone data replicated:
" To all DNS servers in this forest: microsoft.com

@ To all DNS servers in this domain: microsoft.com

" To all domain controllers in this domain (for Windows 2000 compatibility):
microsoft.com

€ To &l domain contrallers specified in the scope of this directory. partition:

| |

< Back I Next = I Cancel
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5.  Give the Zone Name same as the domain name (Ex: Microsoft.com) click Next.

New Zone Wizard x|

Zone Name
What is the name of the new zone?

The zone name specifies the portion of the DNS namespace for which this server is
authoritative. It might be your organization's domain name (for example, microsoft.com)
or a portion of the domain name (for example, newzone.microsoft.com). The zone name is
not the name of the DNS server.

Zone name:

microsoft.com

< Back I Next = I Cancel

6. Select “Allow only secure and dynamic update” > click Next > Finish.

x

Dynamic Update
‘You can specify that this DNS zone accepts secure, nonsecure, or no dynamic
updates,

Dynamic updates enable DMS dient computers to register and dynamically update their
resource records with a DNS server whenever changes occur.

Select the type of dynamic updates you want to allow:

& Allow only secure dynamic updates {recommended for Active Directory)
This option is available only for Active Directory-integrated zones.

™ Allow both nonsecure and secure dynamic updates
Dynamic updates of resource records are accepted from any dient.

This option is a significant security vulnerability because updates can be
“  accepted from untrusted sources,

™ Do not allow dynamic updates
Dynamic updates of resource records are not accepted by this zone. You must update
these records manually.

« Back

Cancel |
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Verification:

1.  Verify for the Service records in Microsoft.com zone.
NOTE: Service records are available only for the zone with the domain name.

2. In DC by default the service records are created in the DNS server in the zone
with domain name.

& DNS Manager

File Acton View Help

e | ?[mIXEB o= HR 385

&, DNS Name l Type I Data
B F svst | _sites
B [ Forward Lookup Zones 7 _tep
[+ _msdcs.microsoft.com 7 _udp
o) ~| DomainDnsZones
@ TALo0:com _| ForestDnsZones

| Revi Zones g \ A "
- Reverse Lookup Zones ~] {same as parent folder) Start of Authority (SOA) [18], sys1.microsoft.com.,
_| Conditional Forwarders —I 3 R . er NG F ;
- i=| (same as parent folder) Name Server (NS) sys1,microsoft.com.
g2 Global Logs =7 \ )
'_] (same as parent folder) Host (A) 10.0.0.1
Hsyst Host (A) 10.0.0.1

Note: To get the missing records restart the services Netlogon and DNS Server.
3. Select Start =»Programs =>Administrative Tools =>Services = Right click on
Netlogon and click restart, Right click on DNS Server and click restart.

File Action View Help

Y EEEEN R

. Services (Local) £} Services (Local)

Netlogon Name = ion Status Startup T

Stop the service £ 2:“ .. Enables Net... Manual
Pause the service 5 20 L.. Manages ob.. Started Manual
Restart the service 1 Pause
= Identifies t.. Started Automatic
Resurme

Collects and Started Automatic

Description: -4 |1 This service... Started Automatic

Maintains a secure channel

between this computer and the 4 AllTasks » .. Savesinstal.. Manual
domain controller for 9 = The Offline ... Disabled
auth_entica_ting! users and services. Refresh . Performanc... Manual
If this service is stopped, the * .
computer may not authenticate ‘| Properties Enablesac.. Started  Automatic
users and services and the domain |~ |.. The PnP-Xb.. Disabled
controller cannot register DNS 7 Help .. Enforces gr... Manual
;?12'0;2:';{::;:iizir:;;elilc?tf\;s;:;ee‘#d L Print Spooler Loads files t... Started Automatic
on it will fail to start. % Problem Reports... This service... Manual

. Protected Storage Provides pr... Manual

L. Remote Access.. Createsac. Manual

L. Remote Access ... Manages di.. Started Manual

L. Remote Procedu... Servesast.. Started Automatic

.. Remote Procedu... Manages th... Manual

%v:Remote Registry  Enables re.. Started Automatic

% Resultant Set of ... Providesa ... Manual

%+ Routing and Rem... Offers routi... Disabled

‘i Secondarv lonon  Fnahles sta...  Started Antomatic
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Lab — 7: Conditional Forwarders

In SYS1 create a zone with the name Ex: MCITP.COM with host and alias records.

In SYS1 open the command prompt and type ping www.MCITP.COM

There will be a reply from 10.0.0.1
In SYS2 assign the IP Address and Preferred DNS as 10.0.0.2
In SYS2 open the command prompt and type ping www.MCITP.COM

There will not be any reply because the information isin 10.0.0.1
If SYS2 has to resolve the query then configure forwarders in SYS2 properties.
Go to DNS dialog box in SYS2 > Right click on conditional forwarders > select

New conditional forwarders

File Action View Help
&9 Fmlc = dEEEE
% ons Hame Type [

= 5 svs2 ] o
| Forward Lookup Zones There are no items to show in this view.

| Reverse Lookup Zones
Bl Conditional Forwarders

S

View L3

®
(=5

Refresh
ExportList. ..

Help

Mention the DNS Domain as MCITP.COM and add the IP address of primary zone.
x|

DMS Domain:

| MCITP.COM

IF addresses of the master gervers:

IP Address | Server FQDN | Validated | Delete |

<Click here to add a...
10.0.0. | ] |
Do |

I | Store this conditional Farwarder in Active Directory, and replicate it as follovs:

I-‘a\\l DNS servers in this forest j

Mumber of seconds before forward queries time out: I 5

The server FQDN will not be available if the appropriate reverse lookup zones and entries are not

configured.
CK I Cancel
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10. In SYS2 open the command prompt and type ping www.MCITP.COM

11. There will be a reply from 10.0.0.1

Note: Only MCITP.COM names can be resolved with the above process.

Lab — 8: Forwarders

1. In SYS1 create a zone with the domain name Ex: Microsoft.com with host and
alias records.

In SYS1 open the command prompt and type ping www.Microsoft.com

There will be a reply from 10.0.0.1
In SYS2 assign the IP Address and Preferred DNS as 10.0.0.2

In SYS2 open the command prompt and type ping www.Microsoft.com

There will not be any reply because the information isin 10.0.0.1

If SYS2 has to resolve the query then configure forwarders in SYS2 properties.

©® N o Uu A W N

Open DNS in SYS2->Right clickSYS2->select properties >select forwarders =2

click Edit.

9.  Mention the IP address of primary zone = click OK =>click OK.
x|

IP addresses of farwarding servers:

IP Address | Server FQDMN | Validated | | Delete I
10.0.0.1 |

Mumber of seconds before farward queries time out: I 3

The server FQDN will not be available if the appropriate reverse lookup zones and entries are not

configured.
OK I Cancel |

10. In SYS2 open the command prompt and type ping www.Microsoft.com

11. There will be a reply from 10.0.0.1

48


http://www.zoomgroup.com/
http://www.zoom.com/
http://www.zoom.com/
http://www.zoom.com/

1.
2.

Windows Server 2008 - Network Administration

Lab — 9: Root Hints

Root hints contain the information of 13 root servers

Open DNS = Right click the system name =>select properties = select root hints

SYS1 Properties 2 x|
Debug Logging ] Ewvent Logaging ] Manitoring ] Security ]
Interfaces ] Forwarders ] Advanced Foot Hints

Roat hints are used ta find other DNS servers on the network.

Mame servers:

Server Fully Qualified Domain Mame [FODN) | IP Address -
""" [135.41.0.4]
[128.9.0.107]
[192.33.4.12]
d.root-zervers.net. [128.8.10.50]
e.root-zervers.net. [1592.203.230.10]
f.root-gervers. net. [192.655.241]
g.root-zervers.net. [192.112.36.4]
h.root-zervers.net. [128.63.253]
L.root-servers. net. [192.36.148.17]
|-roct-servers. net. [192.58.128.30]
k.roat-zervers.net. [193.0.14.129] -
| rmb-anars wet M2 3 F4 1
. | »
Add.. | Edit... Remove LCopy from Server |

oK | Cancel

Lab — 10: Cache server

To see the information present in the cache type the command
“Ipconfig /displaydns”

To clear the cache information type the command

“Ipconfig /flushdns”

Microsoft Windows [Uersion 6.08.68811
Copyright <c> 2006 Microsoft Corporation. All rights reserved.

C:slserssAdministrator>ipeconfig Aflushdns
Windows IP Configuration
Successfully flushed the DNS Resolver Cache.

C:sUserssAdministrator>
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INTERNET INFORMATION SERVICES (IIS) - WEB SERVER
Prerequisites:

Before working on this lab, you must have
1. A computer running windows 2008 server or Domain Controller.

2. A computer running windows 2008 server or Windows 7.

SYSs1 SYS2

MICROSOFT.COM

SYs1 SYS2

Domain Controller/DNS/Web Server Member Server / Client
IP Address 10.0.0.1 IP Address 10.0.0.2
Subnet Mask  255.0.0.0 Subnet Mask  255.0.0.0
Preferred DNS 10.0.0.1 Preferred DNS 10.0.0.1
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Lab — 1: Installing Internet Information Services - Web Server

SYS1- CONFIGURATION
1.  Go to Start »>Programs ->Administrative Tools = Server Manager.

LI

Administrator  Recyde Bin

'

Computer

Web Server
Host Name - SYs1
IP Address :  10.0.0.1

DNS Server : 10.0.0.1
User Name : Administrator

Internet
Explorer

.’*stml Jam | 4 @y n21aAM

Administrator  Recyde Bin

| Terminal Services
5 Active Directory Domains and Trusts
[l Active Directory Sites and Services
| Active Directory Users and Computers

WE ADST Edit
Host Namdisssment
IP Address Data Sources (ODEC)

2 ons

e DNS ServelFEESEs
Y TR . Grouo Policy Management
oy Progams [ | dccessories | st nitstor

[ IR = Local Security Rolicy

» |8 Relizbility and Performance Monitor

. Maintenance

. Microsoft Office 3 i Security Configuration Wizard
. Startup (Y E. server Manager
& Internet Explorer (e vices

Windaws Contacts '32] Share and Storage Management
% Storage Explorer

& system Configuration

(%) Task Scheduler

@ Windaws Firewall with Advanced Security

W windows Server Backup

& W L2aAM
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In the Server Manager - Select Roles and select Add Roles.

=

File Acton View Help

B Diagnostics

fh configuration
Storage

# View the health of the roles installed on your server and add or remove roles and features.

“ Roles Summary Ruoles Summary Help

(2] Roles: 2 of 16 installed iﬂa Add Roles

35; Remove Roles
/&, Active Directory Domain Services

&4 DNS Server

“ Active Directory Domain Services AD DS Help

Stores directory data and manages communication between users and domains, induding user logon
processes, authentication, and directory searches.

— Go to Active Directory Domain
=)
~| Role Status Services

Messages: None
System Services: 9 Running, 1 Stopped

AL Events: 8 warnings, 61 informational in the last 24
hours

{"i Last Refresh: 1/4/2004 1:26:50 AM  Configure refresh

In the Add Roles wizard = select the Check box for Web Server (lIS).

Select Server Roles
Before You Begin Select one or more roles to install on this server.
Server Roles Roles: Description:
Web Server (II5) ] Active Directory Certificate Services Web Server (TI5) provides a reliable,
L X X i ) manageable, and scalable Web
Role Services Active Directory Domain Services (Installed) applicationinfrastructure.
Confrmati |:| Active Directory Federation Services
enfirmation |:| Active Directory Lightweight Directory Services
Progress |:| Active Directory Rights Management Services
Results [] Application Server

|:| DHCP Server
DMS Server (Installed)
|:| Fax Server
[] File services
[ metwork Policy and Access Services
|:| Print Services
[] Terminal Services
|:| UDDI Services

ndows Deployment Services

More about server roles

< Previous I Mext > I Install Cancel
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4, Select the Check box for HTTP Redirection.

Select Role Services

Before You Begin
Server Roles

Web Server (II5)

Confirmation
Progress

Results

Select the role services to install for Web Server (11S):
Role services:

Description:

= [E web Server
Common HTTP Features
Static Content
Default Document
Directory Browsing
HTTF Errors
5
= [] Application Development
[ asp.uET
[] .MET Extensibility
] asp
[ car
[] 154PI Extensions
[] 154PI Filters
[] server side Indudes
B [H] Health and Diagnostics
HTTP Logging
[] Loaging Toals
Reguest Monitor
|:| Tracing
|:| Custom Logging

APDE | i

More about role services

HTTFP Redirection provides supportto

— redirect user requests to a specific

destination. Use HTTP redirection
whenever you want customers who
might use one URL to actually end up
at another URL. This is helpful in

many situations, from simply
renaming your Web site, to
overcoming a domain name that is
difficultto spell, orforcing clients to
use a secure channel.

=

Install Cancel

< Previous | Mext > I

5. Click Next and click Install.

Confirm Installation Selections

Before You Begin
Server Roles
Web Server (IIS)
Role Services
Progress

Results

7. Click Finish.

To install the following roles, role services, or features, dlick Install.

® 2 informational messages below

-~ Web Server (IIS)

CPU usage

Web Server
Common HTTP Features
Static Content
Default Document
Directory Browsing
HTTF Errors
HTTP Redirection
Health and Diagnostics
HTTP Logging
Request Monitor
Security
Request Filtering
Performance
Static Content Compression
Management Tools
115 Management Console

Print, e-mail, or save this information

< Previous

@ This server might need to be restarted after the installation completes.

Find out more about Windows System Resource Manager (WSRM) and how it can help optimize

Mext =

| v

Install Cancel

53




Windows Server 2008 - Network Administration

Lab — 2: Creating a Web Site

Select Start->Programs—>Administrative Tools—>Internet Information Services

Manager.

LI

Administrator Recyde Bin

| Terminal Services
<3 Active Directory Domains and Trusts
= [Hls Active Directary Sites and Services
Computer : Active Directary Users and Computers

2 ADSIEdit

WG %. Component Services
Host Nan]f Computer Management

= Data Sources (ODEC)

IP Addressil

Netw 8] Eventviewer
DNS Serve] Group Policy Management
[ C PR <, i5CS! Initiatar
Programs é Local Security Palicy
[ e e (x| emory Diagnostics Tool
. Extras and Upgrades b (@8 Relisbility and Performance Monitor
. Maintenance ¥| 3y Security Configuration Wizard
. Microsoft Office ¥ |k Server Manager
. Startup »|Sh Services
& Internet Explorer ' Share and Storage Management
Windows Contacts g Storage Explarer
2 System Configuration
(T) Task Scheduler
P Windows Firewall with Advanced Security
@ Windows Server Backup

™ Intemet Information Services (I15) Manager & mils 204aM

In the left pane of the Internet Information Services, Expand the server = Right

click on sites and select Add Web Site.

-laix]
'g; [ » svs1 » sites » &~ @~

File View Help

e @) Sites
@-H|Z |8 i! @ Add Web Site...
€ Start Page — ,—[—] T Set Web Site Defaults...
193 5Y51 (MICROSOFT\Administrato) =8 rj#fica - Ggshowal | =
Q Application Pools Name » ] ID ] Status ] Binding @ Help
o] Online Help
[@ Addwebsie...
543 Refresh
{Z Switch to Content View
| | i
4 | v [EllFeatures view |77 Content View

Ready

4
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3. Add Web Site wizard opens = In the Site name type a Name for the Website

Ex:YAHOO.COM

Add Web Site 2=
Site name: Application pool:
IYAHOO.CDM Select.., |

IYAHOO.COM
— Content Directory

Physical path:
| =

Pass-through suthentication

Connect as... TestSettings...
—Binding
Type: IP address: Port:
Ihttp j IAII Unassigned j IBD
Host name:

Example: www.contoso, com or marketing. contoso. com

¥ Start Web site immediately

oK I Cancel

In Physical path, browse and select the location of Home Directory (webpage)

Browse For Folder x|

Select a directory for the application.

4.

| »

P Desktop
H Administrator
) Public
=M Computer
ﬂ_‘i Local Disk {C:)
Bl =y Local Disk (D:)
) GMAILL B
) Latest Webpages
o
) ‘Yahoo!_files

Make MNew Folder | OK I Cancel
A4
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Select one IP address (10.0.0.1) from the drop-down list.
Specify the Host name Ex: WWW.YAHOQ.COM & click OK.

Site name: Application pool:
|varoo.com |aHoO.Com Select... |
— Content Directory

Physical path:

|D: \YAHOO _|

Pass-through suthentication

Connect as... Test Settings...

—Binding
Type: IP address: Part:
[t =] [10.0.0.1 =] o
Host name:

[ Yaroo.com|

Example: www.contoso, com or marketing. contoso. com

¥ Start Web site immediately

QK I Cancel

Web Site will be successfully added.

Adding the Default Document for the website

Open IS >expand sites >select website =>on Actions pane —>click Explore
- Select the Webpage 2> Right click & select Rename—> Copy the webpage name

In 1IS 2 expand sites = select website> Open Default Document feature.

& Internet Information Services (IIS) Manager | =18 x|
@'c; [ @ » sts1 » sites » vasoo.com » |88 = 1@ -

File View Help

- ; _p. YAHOO.COM Home
€- |7 |8 0 Open Feature =
-5 Start Page ==
- 2 v G5~ 2. Explore
£-83 5Y51 (MICROSOFT\Administrato] | | STOUPEY: Area e L
) Application Pools s Edit Permissions...
El-[e] Sites ~ . Edit Site
=€ YAHOO.COM a 2 | = e
= Y - EE] Bindings...
-] Yahoo!_files L
Authentication Compression Default Directory D Basic Settings...
Document. Browsing
| Open Feature View Applications
'y =y b —————————————————| View Virtual Directories
404 | {;_ﬂ &&= &) Explore _—
. TP lanage Web Site &
Error Pages ’:iand_ler 2 Edit Permissions. .. 5 =
lappings espo... b Restart
- R [y Bindings... Start
ﬂ,}- é}’:?ﬂ i” 2 [E] Basic settings... } stop
MIME Types Modules Qutput
¥p Ca cﬁng View Applications Browse Web Site
View Virtual b Browse WW\W.YAHOO.COM
View Virtual Directories | on 10.0.0. 1:80 (http)
Manage \Web Site » Advanced Settings...
.@ Help Configure
Online Help Limits...
H (7] Help
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Click Add

"E Internet Information Services (IIS) Manager

_ =181x]|
@@ [@ » srs1 » sies » varoo.coM » @ fh @ -
File View Help
(Comections e i Bincumer actons
CEETEI) o .
e @3 Start Page i i isabi
B'“ﬂ SYS1 (MICROSOFT \Administratol Use this feature to specify the default file(s) to return when a dlient does Disable
i Q Application Pools not request a specific file. Set default documents in order of priority. Revert To Inherited
- e Sites Name | Entry Type | @ Hep
B YAHOO.COM Default.htm Therited, | B
] Yahoo!_files Default.asp Inherited Oxline b
index.htm Inherited
index.html Inherited
iisstart.htm Inherited
- { 5] [remres ven] - Contentien
Configuration: 'YAHOO.COM' web.config 05

Mention (Paste) the html file name (with Extension of file) Ex: Yahoo!.htm =>click
OK.

Add Default Document 2x|

Mame:
IYahnn 1 htm|

QK I Cancel
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Enable Directory Browsing for the web site

Open IIS 2expand sites and select the website (YAHOO.COM)

@!") [@ » srs1 v sies » varHoo.coM »

File View Help

CHETE

§5 Start Page

4. Explore

Comnections Adions
@ YAHOO.COM Home

= Edit Permissions...

563 SYS1 (MICROSOFT\Administrato| | STOUPEYE Area T 88~

i[5} Application Pools s Edit Site

- e Sites = Bindings...
€@ vaHo0.com %E) \2| @ [£] Basic settings...
Authentication Compression Default Directory View Applications

Document Browsing View Virtual Directories
! e 3 o Manage Web Site a)
Error Pages Handler Logging w Restart
Mappings P start

5 = e n B Stop
J’j’," @?ﬂ f"‘ 2| 5] Browse Web Site

MIME Types Modules Qutput SSL Settings & Browse WWW.YAHOO.COM on
Caching 10.0.0. 1§g§hﬁttpl
Advanced Settings...
Configure
Limits...

@ Help

«| | » (=] Features view 1= Content View

Online Help

Ready

b

Open Directory Browsing Feature =>and click Enable. (on Actions pane)

DNS Configuration for the Website

Select Start = Programs = Administrative Tools >DNS

Administrator Recyde Bin

|. Terminal Services
5 Active Directory Domains and Trusts
g Ml Active Directory Sites and Services
| Active Directory Users and Computers

Z ADSIEdit
. Component Services

Computer

We
A Computer Management
HOSt Nan]f Data Sources {ODBC)

18] Eventviewer

DNS ServelF s
& iscsl Initiator
f—

i Local Security Policy
B Administrative Tools

(3] Memary Diagnostics Tool
. Extras and Upgrades # @ Reliability and Performance Monitor

Documents

. Maintenance v | 3 Security Configuration Wizard
Settings » -

. Microsoft Office 3 é Server Manager
Search . Startup ¥ |5 Services

& Internet Explorer
Windows Contacts

'z Share and Storage Management

'3 Storage Explorer

& system Configuration

(1) Task Scheduler

@ Windows Firewall with Advanced Security
W Windows Server Backup

‘qﬁ Internet Information Services (IIS) Manager

Help and Support

& mdy 234aM
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2.  Select forward lookup zone > Right click select new zone

_|olx|
File Action View Help
O ENEEN SN ElE
£ ons Name [ Type | status |
= j 5Y51 éj_msdcs.Microsoﬂ.com Active Direct...  Running
Global Logs =1 Microsoft.com Active Direct...  Running
il Forward Lookup Zones

| Reverse Lookup Zo
| Conditional Forwarg

View 3

Refresh
Export List. ..

Help

Create a new zone.

Create a new primary zone in forward lookup zone & mention the website
domain name (Ex:YAHOO.COM)

New Zone Wizard

x|
Zone Name

What s the name of the new zone? @

The zone name specifies the portion of the DNS namespace for which this server is
authoritative, It might be your organization's domain name (for example, microsoft.com)

or a portion of the domain name (for example, newzone.microsoft.com). The zone name is
not the name of the DNS server.

Zone name:

yahoo.com

Cancel
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Select the zone > Right click select New Host

File

Action  View Help

L EE EEEI T EEERE

Mew Alias (CMAME). ..

Mew Mail Exchanger (MX)...
Mew Damair. . .

Mew Delegation...

Other New Records...

All Tasks

View

Delete
Refresh
Export List...

Properties

Help

Mention the Web Server name and IP Address >Add Host 2 OK > Done.

Mewtost x|

Name (uses parent domain name if blank):

Isysl

Fully qualified domain name (FQDM):

I sys 1. yahoo.com.

IP address:

| 10,0.0.1

[™ Create associated pointer (FTR) record

Cancel |

60

é DNS Mame | Type | Data |
= _ﬂ 51 a (same as parent folder) Start of Authority (SOA) [1], sysl.microsoft.com., h...
B = Fo_r',\-ard Lockup Zones Q (same as parent folder) MName Server (NS) sys1.microsaft, com,
=l _msdcs Microsoft.com
= Microsoft.com
3
“1 Reyf  Update Server Data File
| Corl Reload
G
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6. Select the zone >Right click select New Alias &Create an Alias (E.g.: www) for
the host, which you specified in the host header for the site > click OK.
x|

Alias (CNAME) |

Aliag name (uses parent domain if left blank):

I .

Fully qualified domain name (FQDM):

I wwwe, yahoo,com,

Fully qualified domain name (FQDN) for target host:

I sysl .yahoo.c0m| Browse... |

oK I Cancel

VERIFICATION:

1.  Open Internet Explorer or any browser and access the website

/2 yYahoo! - Windows Internet Explorer =
ésf/‘ - I@‘ hittp:/ fwww.yahoo.com)| j NIE ILi'.eSear-:h o
; — o= »
o ) Yahoo! | | 3 - B - o= - |=FPage - (0 Tods -
Make Y! your home page | Get IE7 Now! Top Holiday Gifts: Cell Phones, MP3 Blayers, Cameras, Laptops 4|
H o’ Web | Images | Video | Local | Shopping | more
AHOO)! | | WebSearch
IS vy vahoo | vinda Page Options
Answers HotJobs Personals  Travel Check your mail status: Sign In Free mail: Sign Up | —
Autos Maps Real Estate TV
Finance Mobile Web  Shopping Yellow Pages Mail | Messenger Radio |
Games Movies Sports ¥! International
Groups Music Tech Weather Local | Horoscopes
Small Business
In the News World | Lacal | Finance
Get a Web Site sell online
Domain Names Search Ads
= Mukasey vows to be independent Confirmed by Senats
= Suu Kyi ‘optimistic’ about talks with Myanmar's junta Envoy Featured Services
« Merck approves 54.85 billion settlement with Vioxx plaintiffs o load Kid e | Websit
« Former NYC police commissioner surrenders to feds Fraud Hnwlltlloa s G' sc‘t' ersonal Website
»  Live: O.J Simpson retumns to court to face robbery charges satth cotities
- U.S. stocks fall on more credit write-downs Slump - - =l
- N = S P SO T Inside Yahon! India Farechase

|{11 items rem-a.iﬁi-r;.g.}-Do;\lnlcading pict. | I ’-_ ’__ ’_ ’_ ’_ ’_ ’@ @ Internet | Protected Mode: Off FUW0% - g
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Lab — 3: Configuring redirection of Websites

Select Start > Programs - Administrative Tools - Internet Information Services
Manager, Create two websites, Ex: YAHOO.COM and MICROSOFT.COM

If YAHOO has to be redirected to MICROSOFT then Select YAHOO.COM ->Open
HTTP Redirect feature

"-'E Internet Information Services (IIS) Manager ==l
@g) [@ b SYS1 b Sites b YAHOO.COM b | & e -
File view Help
_ VAHOO.COM Home CAcdons
ﬁ,' ]_J l Ll l@, q Open Feature =
gy startPage —
: - - . Explore
€5 5Y51 (MICROSOFT\administf | | 5P BY: Area = Zp'
: icati Edit Permissions...
Q Application Pools s
B8] Sites —-| Edit Site
-4 MICROSOFT.COM ‘(!‘.E) @ - 1N
a YAHOO.COM |@| Bindings. ..
Authentication Compression Default Directory Error Pages B Basic Settings...
Document Browsing
View Applications
sy 2= = = View Virtual Directories
& W € B r o e
SO HT TP Fedirect| HTTP Logaing MIME Types Manage Web Site &)
Mappings |— Open Feature | 2 Restart
a P Start
= 48| pJ Explore
‘QE%H ? IR B Stop
Modules Qutpu T PErmissions. .. i
Cachin - Browse Web Site
Eodng=sy Erowse WWWW. YAHOO.COM
B Basic Settings. .. on 10.0.0.1:80 (htp)
- Advanced Settings...
View Applications
Confi
View Virtual Directories o
E Limits...
Manage Web Site 3
= @ reb
Help Online Help —
] o Features View ¢z Con @ =
Online Help
Ready

%
Select the check box Redirect requests to this destination give the destination as

http://www.MICROSOFT.com & click Apply in the actions Pane.

=l8] x|
@E) [@ » svs1 b st b vanoo.cow b |& @

File View Help

. Adtons
@ id|2 |8 @) HTTP Redirect

5/ Apply
H:'j Start Page B ¢ |
) . S ) =x Cancel
_gﬂ SY51 (MICROSCFT \dministi Use this feature to specify rules for redirecting incoming requests to another file
! o or URL. @ el
fe o) Application Poals P

I Redirect requests to this destination: Cninekic
& MICROSOFT.COM

€ varoo.com [T sgpvavavs MicroSORT.COM

Example: http:/fwww.contoso.com/sales

Redirect Behavior
- Redirect all requests to exact destination (instead of relative to destination)
- Only redirect requests to content in this directory {not subdirectories)

Status code:
[Found (302) =l

< | |
4 | B (2 Content View

Configuration: "YAHOO.COM' web. config

%
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Open Internet Explorer or any browser and access Yahoo (www.yahoo.com) and

it will be automatically redirected to MICROSOFT (www.MICROSOFT.com).

/2 Microsoft Corporation - Windows Internet Explorer T

- _(8(x]
—

@/ ~ |e] vrey MICROSOFT.COM =[] | Juive seard L~

%% & @ micosoft Corporation | | {3 - B - i - o Page » (G Tooks + 7

United States Change ‘

Windows ' Office ' All Products | Buy Now Downloads & Trials ' Partner & Customer Solutions = Security & Updates | Training & Events | Support | About Microsoft

Experience this in Silverlight
@' Download the free plug-in -

Microsoft
Download Center
©)

Your destination for trials,
updates, & service packs.

5 ways to speed x A
& 2 ree security
up your computel downloads

Keep your PC running in top form » & more »

3 2
Highlights » Is your PC ready for Windows 7 Popu[a[ Downloads
You may be able to run Windows 7 on =
- S ar
=

your current PC, Download the free o - Inter IEES

_Latest releases

Ll “ B o = g S RSt ks .. . - = .
1| === = — e === = = |”n »

N Internet | Protected Mode: Off H100% ~
4
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Lab — 4: Creating virtual directory

Select Start > Programs > Administrative Tools = Internet Information Services
Manager.
Expand the system name, Select the Web Site (Yahoo) for which you want to

create Virtual Directory =>Right click and select Add Virtual Directory.

"-'E Internet Information Services (IIS) Manager = ]5 |5]
@G) [O » SYS1 b Sites » YAHOO.COM » & = 1@ -
File View Help
3 | g YAHOO.COM Home
T b : B v
€ Start Page £dit Permissions.
-85 5Y51 (MICROSOFT Administrato] | | STOUPBY: Area M =
[} Application Paols s Edit Site
- @ Sites Bindings...
&€ 1ANA ,\g‘ . | Basic Settings..
- YAHO = - V]
£ Explore Compression  Default View Applications
Edit Permissions... Document View Virtual Directories
@  Add Appication.... 2 | P & Manage Web Site A
Z "y, L= — -
11 Add Vrtwal Diectory.» Handler  HTTP Redirect HTTP o’ Restart
Edit Bindings Mappings Respo... P Start
T —— s @ Stop
s R
M Vieb Sit I "‘*ﬂ E N
w J] =t ;”1 Browse Web Site
3 Refresh MIME Types Modules Qutput rg) Browse WWW.YAHOO.COM on
X ® Caching 10.0.0.1:80 (http)
emove
Rename
Configure
s Switch to Content View Limits...
© Heb
Oniline Help
< | =] Features View ;- Content View
Ready "3

Specify the Alias name to the virtual directory (Ex: mail), and Browse to select
the physical path Ex:(D:\Yahoomail) = click OK.

Site name:  YAHOO
Path: !

Alias:

Imail
Example: images

Physical path:

ID: Yyahaomail |

Pass-through suthentication

Connect as... Test Settings...

Cancel
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=18]x]|

6@ [ > svs1 v sites

» YAHOO.COM » MAIL »

&~ 1@

File view Help

Q- -z |8

o l‘g Start Page
= Gs SYS1 (MICROSOFT \Administrato|
2 Application Pools
[ @] Sites
@ 1ana
=69 YAHOO.COM
+ Yahoo!_files
MAII
-] Yahoo! Mail - Th

]
!

& i MAIL Home

Group by: Area

B d o

Authentication Compression Default
Document
B i
5l 40
Error Pages Handler HTTP Redirect
Mappings
] =] "
‘ = &
Logging MIME Types Modules
SSL Settings

Directory
Browsing

QOutput
Caching

21 Explore

Edit Permissions...

Basic Settings...

Manage Virtual Directory | ’) )

Browse Virtual Directory
] Browse WWW.YAHOO on
10.0.0.1:80 (http)
Browse WWW.YAHOO.COM on
10.0.0.1:80 (http)

Edit Virtual Directory
Advanced Settings...
@ reb

Online Help

Ready

Features View [{7: Content View

%

Add the Default Document for the Virtual Directory - OK

‘E Internet Information Services (IIS) Manager

=18]x]

@-@ [_EJ » SYS1 » Sites » YAHOO.COM » MAIL »

&~ %@ -

File View Help

Q- |z

‘@3 Start Page

=] qs SYS1 (MICROSOFT \Administrato|
i[5} Application Pools
Sites
@ 1ana
- YAHOO.COM
7] Yahoo!_files
MAIL
-] Yahoo! Mail - Th

E\_] MAIL Home

Group by: Area

- [

d 9 B

Directory
Browsing

Open Feature
4 Explore

Edit Permissions...

Basic Settings...

Manage Virtual Directory (A
Browse Virtual Directory

Authentication Compression pec
o | Configure defauit files to return when dlients do not specify a file in a request

i iy
il S
Error Pages Handler ~ HTTP Redirect
Mappings
:I = I
(= = L i
Logging MIME Types Modules

SSL Settings

HTTP
Respo...

Output
Caching

Ready

Features View [{7: Content View
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To access the virtual directory specify the syntax in Internet Explorer

http://websitename/virtualdirectoryname

Ex: http://www.Yahoo.com/mail

/= Yahoo! Maik The best web-based emaill - Windows Internet Explorer g =18 x|

——

T [ o Sl M ove sexc o
e e ) Yahoo! Mail: The best web-based email! l l Q - - dmh v |:.rPage v () Tools v o

YaHOO! MaIL —— =

Don't have a

Chat right from Yahoo! ID?
& Signing up Is easy,
Ve your Inbox.
- A\ Sign up for Yahoo!
- » See how -
o See how
— Already have a Yahoo! ID?
Sign in

Your Inbox understands you've got news to share.

'13\' Are you protected?
“x Create your sign-n seal
. Why7)
\':._;)O See which of your contacts are online at a glance

“ Yahoo! ID:
|

k‘_y Easily switch from email to chat and back again (e.9. free2ehyme@yahoo.com)

Password

"'_9 Start right away, no download or setup needed

[J Keep me signed in
for 2 weeks uriess | sign out. ™
[Uncheck if o & shared computer]

Forget your ID or password? | Help :l

(1 item remaining) Downloading picture | I [T 1T T [{6 [onknown Zone | Protected Mode: OFF [R100% -~

See how to instantly reach friends and family from the New Yahoo! Mail fo
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Lab - 5: Changing the Web Site IP address or Port no

Select Start = Programs > Administrative Tools—>Internet Information Services

Manager.

Select the Web site = and click Bindings in the Actions Pane.

“E Internet Information Services (IIS) Manager

File View Help

Q- |2 |8

©5 Start Page

- @] Sites

=18]x]
() [@ » sys1 » sites » vaHoO.COM » & = 5@ -
YAHOO.COM Home
2. Explore
o A == Edit Permissions...
©-93 5751 (MICROSOFT\Administrato) s 22 B o
Q Application Paols IS Edit Site
== _ Bindings...
@ YaHOO.CoM 38) x;:_]‘ - I:J Basic Settings...
§ d o = E|
Authentication Compression Default Directory View Applications
Document Browsing View Virtual Directories
r ; ,.#’a L = Manage Web Site &)
404 e = L?J o
Error Pages Handler HTTP Logging w Restare
Mappings Respo... P Start
S 1 B n 8 Stop
BiS "ﬂﬂ fwﬁ
J <t y ng Browse Web Site
MIME Types Modules Output SSL Settings > Browse WWW.YAHOO.COM on
Caching

= 10.0.0.1:80 (http)
Advanced Settings...
Configure

Limits...

@ Help

Online Help

| 3] [Eressresver] - Conent v

Ready

Click edit and change the IP address or port number or host name.

If the port number is changed then the website can be accessed only by

specifying the port number http://www.yahoo.com:port number
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Lab — 6: Creating Self-Signed Certificate for HTTPS Website

Select Start = Programs - Administrative Tools - Internet Information

Services Manager.

Select the system name

\'E Internet Information Services (IIS) Manager

g =18 x|
63) (83> svs1 v | & = 5@

File View Help

femeceR | Adiens
FEETEI) 0‘;! SYS1 Home

Manage Server
-4 Start Page — & Restart
[ERCET 55 1 (MICROSOFT\Administrato ) skt ~E- b Start
i[5} Application Pools s A T
R B Stop
- @] Sites = §
I =0) View Application Pools
S 49 L o :
Authentication Compression Default Directory View Sites
Document Browsing @ Help
o — BED Online Help
A " =5 =|
& € B8
Error Pages Handler HTTP Logging

Mappings Respo...
\

S .,_—,PDM o
= L i e g
MIME Types Modules Qutput Server

Caching Certificates

@y
Worker
Processes

Management LI

- [ 5] [remesven ] - conentven

Ready

&

Double-click on “Server Certificates”

.'»'E Internet Information Services (IIS) Manager

, =181
(< SNETECE |@ = 1@

File View Help

(s @3 SYS1 Home L
e&' l!:i | |& $ Open Feature
- 33 Start Page
- s v 25~ Manage Server
363 5Y1(MICROSOFT\Administrato| | S0P LY Area E o <
{2} Application Pools s A ¢« Restart
#- @] Sites = P start
& 9 (s -
Authentication Compression Default Directory View Application Pools
Document Browsing View Sites
2 < § .
404 = = 3 i
Online Help
Error Pages Handler HTTP Logging
Mappings Respo...
A i R _far
= o e »
MIME Types Modules Qutput Server
Caching Certificates
ey
Worker
Processes
Management ;l
J | 5| e ] ot
Ready

4
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Click “Create Self-Signed Certificate”

"E Internet Information Services (IIS) Manager

== x|
@‘E} (835 srs1 0

|& -~ 1@ -
File View Help
- @) Server Certificates
ea' H I | & z Import...
B @j Start Page &
-5 SYS1 (MICROSOFT\Administratol Use this feature to request and manage certificates that the Web server Create Certificate Request...
F can use with Web sites configured for SSL. c te Certificate R t
; J Application Paols omplete Certificate Request...
6] Sites Nome', = | tssued To Create Domain Certificate...

Crante Saif Sioned CoriRcats. . &

@ tep

Online Help

Ao 0000 i
” | 3] [Eresiresver] - Conent v

Ready

&

Mention the Certificate name E.g.: Sys1.Microsoft.com (FQDN of Web server)

Create Self-Signed Certificate 3

%lll Specify Friendly Name

20

Specify a file name for the certificate request. This information can be sent to a certificate authority
for signing:

Specify a friendly name for the certificate:

Isvs 1.microsoft.com

Cancel I

Click OK.
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7. Certificate is created

-'E Internet Information Services (IIS) Manager

i =18(x]
6@ [3§>5Ys1» ];}jmﬁlﬂv

File View Help

- @ Server Certificates
e,' H | | @, kg Import...
- ?3 Start Page . ¢
= 63 $Y51 (MICROSOFT\Administrato) Use this feature to request and manage certificates that the Web server Create Certificate Request...
~-) Application Pools can use with Web sites configured for SSL. Complete Certificate Request...
ol Sites R e Create Domain Certificate...
sys1.microsoft.com sys1l.microsoft.com
Create Self-Signed Certificate...
View...
Export...
x Remove
@ Hep
Online Help
[ — o
’ | 5| Frmeve | cmeien
Ready G§
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Lab — 7: Creating a HTTPS Web Site

Select Start = Programs > Administrative Tools - Internet Information

Services Manager.

Administrator

A

Computer

]

Recyde Bin

We
Host Name
IP Address
DNS ServelE iy .

Netwe

Windows Update

Pr . Accessories
_ [

. Extres and Upgrades

ograms

. Maintenance

. Microsoft Office
. startup
& Internet Explorer

Tl mnms BT mnn |

| Terminal Services
<3 Active Directory Domains and Trusts
[Hls Active Directary Sites and Services
: Active Directary Users and Computers
2 ADSIEdit
%. Component Services
B Computer Management
= Data Sources (ODEC)
2 ons
8] Eventviewer

&, iSCST Initiator
»| 3 Local Security Policy
] Memary Diagnostics Tool
» (@) Relizbility and Performance Monitor
3 i Security Configuration Wizard
» |3k Server Manager
¥ [.Ch Services

¢ Share and Storage Mansgement

Windows Contacts ¥ Storage Explarer

2 System Configuration

(T) Task Scheduler

P Windows Firewall with Advanced Security
@ Windows Server Backup

™ Intemet Information Services (I1S) Manager

& mils 204aM

In the left pane of the Internet Information Services, Expand the server = Right

click on sites and select Add Web Site.

?E Internet Information Services (IIS) Manager

=181

Py

3 [ S| b SYS1 b Sites b |~ e~
Eile Vview Help
ectons —— Actons
€--|Z |8 i' @ Add Web Site...
©5 Start Page — S = —— Set Web Site Defails...
-5 Y51 (MICROSOFT \Administrato ilter: ~ BEco - Eyshowal | g
: Q Application Pools Name ~ I 1D l Status | Binding @ heb
B-e] : ult Web Site 1 Started (http) *:30 (http) Online Help
% Add Web Ste... 2 el =t
i3 Refresh

{Z, Switch to Content View

< |

(= |Features view

i Content View

Ready

&
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Add Web Site wizard opens = In the Site name type a Name for the Web site

Ex: Microsoft.com

Site name: Application pool:
Ilﬂicrosnﬂ.com| IMia’osoft. com Select... |
— Content Directory

Physical path:

| ]

Pass-through suthentication

Connect as... TestSettings...
—Binding
Type: IP address: Port:
Ihttp j IAII Unassigned j IBD
Host name:

Example: www.contoso, com or marketing. contoso. com

¥ Start Web site immediately

oK I Cancel

In Physical path, browse and select the location of Home Directory (Webpage’s
Folder)
|

Select a directory for the application.

= . Webpages -
, Brw
| Google
, Iana
| Kaspersky
= ). [y
, Microsoft Corparation_files .
| Rediff
| Yahoo
J Yahoomail —

Make MNew Folder | oK I Cancel

4
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5.  Select the protocol as HTTPS

Site name:

Application pool:

Irﬂicrosnﬁ.com

IMicrosoﬂ:.mrn

6.

— Content Directory
Physical path:

ID: \Webpages\Microsoft |

Pass-through authentication

Connect as... Test Settings...

—Einding
Type: IF address: Port:
https ﬂ IAII Unassigned j ISD
ht

Example: www.contosa.com or marketing.contoso.com

¥ Start Web site immediately

[ o< |

Cancel

Select one IP address from the drop-down list box.

Site name: Application pool:

Irﬂicrosnﬂ.com IMicrosoFt.mm

— Content Directory
Physical path:

ID: \Webpages\Microsoft |

Pass-through suthentication

Connect as... Test Settings... |

—Binding
Type: IP address: Port:

Ihttps v[ 10.0.0.1

Host name:

551 certificate:

INnt selected

¥ Start Web site immediately

Cancel
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7.  Select the SSL Certificate, Ex: SYS1.MICROSOFT.COM.

Site name: Application pool:
Irﬂicrosnﬁ.com IMicrosoﬂ:. cam Select... |
— Content Directory

Physical path:

ID: \Webpages\Microsoft |

Pass-through authentication

Connect as... Test Settings...

—Einding
Type: IF address: Port:
rttps =] 10.0.0.1 =] ==
Host name:

S5L certificate:

sys1.microsoft.com hd View,.. |

¥ Start Web site immediately

oK I Cancel

8. Click OK.

Site name: Application pool:

Irﬂicrosnﬂ.com IMia’osoft. com Select... |

— Content Directory
Physical path:

ID: \Webpages\Microsoft |

Pass-through suthentication

Connect as... Test Settings...

—Binding
Type: IP address: Port:
[hws =] [o.0.0.1 =] fs
Host name:

551 certificate:
Isys 1.microsoft. com j View,.. |

¥ Start Web site immediately

; Cancel |

9. Web Site will be successfully added.
10. Enable Directory Browsing.(Repeat the process of Directory Browsing)

11. Apply Default Document. (Repeat the process of Default Document)
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Accessing the HTTPS site from the Web Server
SYS1 - CONFIGURATION

1. Open the browser and type https://certificate-name
Ex: Https://sysl.microsoft.com

,(.; Internet Explorer Enhanced Security Configuration is enabled - Windows Internet Explorer

_1E1x
L S5A |g https: /fsys 1.microsaft, com| j 2| X I_ P~
‘12? “1'{.‘\-? '_r,élnbernetExp\orer Enhanced Security Configuration is ... | | @ - b I;é; - Q}’EEQE - _{_)J- Toaols = ®

B

Internet Explorer Enhanced Security Configuration is enabled

Internet Explorer Enhanced Security Ceonfiguration is currently enabled on your server. This configures
a number of security settings that define how users browse Internet and intranet Web sites. The
configuration also reduces the exposure of your server to Web sites that might pose a security risk. For

a complete list of the security settings in this configuration, see Effects of Internet Explorer Enhanced
Security Configuration.

This enhanced level of security can prevent Web sites from displaying correctly in Internet Explorer and
restrict access to netwark resources, such as files on Universal Naming Convention (UNC) shares. If
you want to browse a Web site that requires Internet Explorer functionality that has been disabled, you
can add the Web site to the inclusion lists in the Local intranet or Trusted sites zones. For more
information, see Manaaing Internet Explorer Enhanced Security Configuration.

[~
Done l_ l_ l_ ’_ l_ l_ '@ ‘0 Internet | Protected Mode: Off * 100% - A

2. An warning will be given, click OK to proceed
Seourity mlert i
? i) You are about to view pages over a secure connection.

(o

Any information you exchange with this site cannot be
viewed by anyone else on the web.

I~ Inthe future, do not show this waming
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3. Web site is displayed

/2 Microsoft Corporation - Windows Internet Explorer =& x|
e ==
(CIONIEF o - oo o] =1 & [l e ol

% 4 @ wmicosoft Corporation [ | - B - & - [hPage + G Tooks + 7

United States Change ‘

E f oing [N

Windows ' Office ' All Products  Buy Now ' Downloads &Trials | Partner & Customer Solutions | Security & Updates | Training & Events | Support = About Microsoft

Experience this in Silverlight
& Download the free plug-in -»

rosoft
Download Center

D)
Your destination for trials,
updates, & service

5 ways to speed . A
7 ree security
up your computer downloads

Keep your PC running in top form » & more »

Is your PC ready for Windows 72 Popular Downloads
You may be able to run Windows 7 on

your current PC. Download the free eLExorech

[T T [ [ [ [@ nternet | Protected Mode: Off [®10% - 4

4. Click on the Yellow Lock beside Address bar, to see the website security status.

/2 Microsoft Corporation - Windows Internet Explorer -8 x|
—
@&/'t; =00 & 4] ] [ove ol

U ¢ @ Microsoft Corporation | I o - R

|“ 2 Website Identification
£

United States Change

sys1.microsoft.com
has identified this site as

sys1.microsoft.com

p o = = e F This connection to the server is encrypted.

Windows ' Office | All Products ' Buy Now ' Downloads & Trials | Party ~ Should | trust this site? iEvents ' Support  About Microsoft

Experience this in Silverlight View certificates
&' Download the free plug-in >

Microsoft
Download Center

v
Your destination for trials,
updates, & service packs

5 ways to speed . 4
= 2 ree security
up your computel downloads

Keep your PC running in top form » & more »

i Is your PC ready for Windows 7? popu|a[- Downloads
Hmoniokt=y - You may be able to run Windows 7 on B
your current PC. Download the free U plorer 8

Latest releases =

r ull

| [ [ [ [ @ internet | protected Made: Off [®w0% - 4
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5. Sometimes Website will not be displayed. If it is not displayed, then go to cmd and
type Route Delete ::1/128

Administrator: C:\Windows\system32\cmd.exe
icrosoft Windows [Uersion 6.0.606011]

Copyright (c)> 2806 Microsoft Corporation. All rights reserved.

C:\Users\Administrator>route delete ::1,/128
OK?

C:\Users\Administrator>
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Accessing the HTTPS site from the Client Computer
SYS2 — CONFIGURATION

1. Open the browser and type https://certificate-name

Ex: Https://sysl.microsoft.com

/‘ Internet Explorer Enhanced Security Configuration is enabled - Windows Internet Explorer

_(&x
ey - |g https: /jsys 1.microsoft.com| j 2| X I_ P
12? '1'% '_r,élnbernetExp\orer Enhanced Security Configuration is ... | | @ o K é& o r_:‘,"EEQE A -{}} Taols - ?

El

Internet Explorer Enhanced Security Configuration is enabled

Internet Explorer Enhanced Security Configuration is currently enabled on your server. This configures
a number of security settings that define how users browse Internet and intranet Web sites. The
canfiguration also reduces the exposure of yvour server to Web sites that might pose a security risk. For
a complete list of the security settings in this configuration, see Effects of Internet Explorer Enhanced
Security Configuraticn,

This enhanced level of security can prevent Web sites from displaying correctly in Internet Explorer and
restrict access to network resources, such as files on Universal Naming Convention (UNC) shares. If
you want to browse a Web site that requires Internet Explorer functionality that has been disabled, you
can add the Web site to the inclusion lists in the Local intranet or Trusted sites zones. For more
information, see Manaaging Internet Explorer Enhanced Security Configuration.

El
Done ’_ ’_ ’_ ’_ ’_ ’_ m @ Internet | Protected Mode: OFf 0% v

2. An warning will be given, click OK to proceed
Seourity mlert i
? i) You are about to view pages over a secure connection.

(o

Any information you exchange with this site cannot be
viewed by anyone else on the web.

I~ Inthe future, do not show this waming
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3. There is a problem with Website’s Security Certificate (The Security Certificate

presented by website was not issued by a Trusted Certification Authority), Click on

Continue to this Web site (Not Recommended)

/2 Certificate Error: Navigation Blocked - Windows Internet Explorer
o
@ - IQ https: //sys 1.microsoft.com/

W ok (@ Certificate Error: Navigation Blocked | I

] =181x]|
LI 2| X I_ e Search P~

[ - () v |:bPage v { Tools v 7

] =
@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server.

We recommend that you close this webpage and do not continue to this website.

@ Click here to close this webpage.

& iContinue to this website (not recommended);

®@ More information

|ht‘lps: f/sys1.microsoft.com/

=
[T T T T T [l I itemet [ roteciea oge: o

H100% ~ 4

4. Web site is displayed but there is a Certificate Error
/2 Microsoft Corporation - Windows Internet Explorer

I =18(x]
@-\ 5~ [ httos:fjsyst.microsoft.com/ [ certificate Error | {49|| X | [uive searc P~
9% &% @ wmicrosoft Corporation | |

{2~ B - & - [=hpage » GTods ~

PN

United States Change ‘

Windows ' Office ' All Products  Buy Now ' Downloads &Trials ' Partner & Customer Solutions | Security & Updates ' Training & Events ' Support = About Microsoft

Experience this in Silverlight
@& Download the free plug-in -

Microsoft wd
Download Center

()
Your destination for trials,
updates, & service packs.

~

5 ways to speed : .
& 2 ree security
Up yOUf G6) putel downloads

Keep your PC running in top form » & more »

) Is your PC ready for Windows 7?2 Popular Downloads
Hotiights ) Pl vou e be abi torn vindons 7on o
. L your current PC, Download the free Qe &
[ [T T T [ [ @ mntermet | Protected Mode: OFf

[R1w00% -~ 4
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5. Click on Certificate Error and Click on View Certificates

/= Microsoft Corporation - Windows Internet Explorer I -8 _)g
N = .
@ (& )i [g https: //sys 1.microsoft.com/ l] "fé‘ Certificate Error | | ¥4 X ], e Search L~
n 2 x . - 3 - »
W 4 @wicrosoft Corporation | | : 2 - B - = - |k Page + (G Took ~
€ P ‘&3‘ Untrusted Certificate -8 = =
> United States Change ‘ =

= y  The security certificate presented by this
website was notissued by a trusted
certificate authority.

This problem may indicate an attemptto
fool you orintercept any data you send to
the server.

Windows « Office - All Products ' Buy Now ' Downloads & Trials | Part

Ve recommend that you close this
webpage.
Experience this in Silverlight

& Download the free plug-in -

About certificate errors

crosoft

View certificates Dé d Center
(¥ )

Your destination for trials,

updates, & service packs.

5 ways to speed .
2 Free security
up your computer downloads

Keep your PC running in top form » & more »

o Is your PC ready for Windows 72 Popular Downloads
ighitghts_y PR ou may be able to run Windows 7 on
‘ your current PC, Download the free

o Internet Explorer 8
Latest releases —

il

| [T [ [ [ [@ Internet | Protected Mode: OFF

6. Click on Install Certificate

x

General lDetaiIsI Certification Path |

@g Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: sysl.microsoft.com

Issued by: sysl.microsoft.com

Valid from 12/31/200% to 12/30/2010

Issuer Statement

Learn more about certificates

OK I

[H100% -~ 4
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7. Click Next = Select Place all certificates in the following store - Click Browse.

Certificate Import Wizard 3 x|

Certificate Store
Certificate stores are system areas where certificates are kept,

Windaws can automatically select a certificate store, or you can specify a location for
the certificate.

" Automatically select the certificate store based on the type of certificate
' place all certificates in the following store
Certificate store:

Learn more about certificate stores

< Back Next > Cancel

8. Select Trusted Root Certification Authority = Click OK - Click Next
x

Select the certificate store you want to use.

Personal -

Trusted Root Certification Authorities

Enterprise Trust
Intermediate Certification Authorities
Active Directory User Object

| Trusted Puhlishers ¥
«| | »

[ show physical stores

| OK I Cancel I
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9. Click Finish

F O E——r—r I X|

Completing the Certificate Import
Wizard

The certificate will be imported after you click Finish.

You have specified the following settings:

Certificate Store Selected by User Trusted Root Certifice
Content Certificate

10. Click Yes = Click OK = Click OK.
Security Warning N ﬁl

& You are about to install a certificate from a certification authority
/_IA (CA) daiming to represent:

sys1.microsoft.com

Windows cannot validate that the certificate is actually from
“sys 1.microsoft.com”. You should confirm its origin by contacting
“sys1.microsoft.com”. The following number will assist you in this
process:

Thumbprint (sha1): 438F49ES 96E9CBBB 608515FE 7AAS5BA4
15DFD8C7

Warning:

If you install this root certificate, Windows will automatically trust
any certificate issued by this CA. Installing a certificate with an
unconfirmed thumbprint is a security risk. If you dick “Yes™ you
acknowledge this risk.

Do you want to install this certificate?

Certificate Import Wizard 7|

.

/a D
4 )
\0} The import was successful.
W
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11. Web site is displayed

/2 Microsoft Corporation - Windows Internet Explorer =& x|
= —

O - o Tommm EE1E R 2k

% 4 @ wmicosoft Corporation [ | - B - & - [hPage + G Tooks + 7

United States Change ‘

E f oing [N

Windows ' Office ' All Products  Buy Now ' Downloads &Trials | Partner & Customer Solutions | Security & Updates | Training & Events | Support = About Microsoft

Experience this in Silverlight
& Download the free plug-in -»

rosoft
Download Center

D)
Your destination for trials,
updates, & service

5 ways to speed . A
7 ree security
up your computer downloads

Keep your PC running in top form » & more »

) Is your PC ready for Windows 72 Popular Downloads
Highghts ) You may be able to run Windows 7 on
&

your current PC. Download the free eLExorech

[ [T T [ [ [ [@ nternet | Protected Mode: Off [®10% - 4

12. Click on the Yellow Lock beside Address bar, to see the website security status.

/2 Microsoft Corporation - Windows Internet Explorer -8 x|
—
@&/'t; =00 & 4] ] [ove ol

x Q-8

8 ¢ @wmicosoft Corporat | = : T
NS I 14‘? Website Identification
e

United States Change

sys1.microsoft.com
has identified this site as

sys1.microsoft.com
p o = = e F This connection to the server is encrypted.

Windows ' Office | All Products ' Buy Now ' Downloads & Trials | Party ~ Should | trust this site? iEvents ' Support  About Microsoft

Experience this in Silverlight View certificates
&' Download the free plug-in >

Microsoft
Download Center

v
Your destination for trials,
updates, & service packs

5 ways to speed . 4
= 2 ree security
up your computel downloads

Keep your PC running in top form » & more »

Highlights » Is your PC ready for Windows 72 Popula[‘ Downloads ‘

= You may be able to run Windows 7 on
[ _>l_J

your current PC. Download the free
| [ [ [ [ @ internet | protected Made: Off [®w0% - 4

. plorer 8

Latest releases =
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INTERNET INFORMATION SERVICES (IIS) - FTP SERVER
Prerequisites:

Before working on this lab, you must have
1. A computer running windows 2008 server or Domain Controller.

2. A computer running windows 2008 server or windows 7.

SYSs1 SYS2

MICROSOFT.COM

SYs1 SYS2

Domain Controller/FTP Server Member Server / Client
IP Address 10.0.0.1 IP Address 10.0.0.2
Subnet Mask  255.0.0.0 Subnet Mask  255.0.0.0
Preferred DNS 10.0.0.1 Preferred DNS 10.0.0.1
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Lab — 1: Installing Internet Information Services - FTP Server

SYS1- CONFIGURATION

1.  Web server (lIS) should be installed.
2. Open any Drive Ex:- D:\ and install the FTP Application (ftp7).

i
Welcome to the FTP Service 7.5 for IIS 7.0 Setup e

The Setup Wizard will install FTP Service 7.5 for IIS 7.0 on
your computer, Click Next to continue or Cancel to exit the
Setup Wizard.

3.  Click Next & Check the box “I accept the license terms” = Click Next = Click
Next - Click Install
JSIeIT

Ready to install e

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Cancel

4, Click Finish.
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Lab — 2: Creating Do not Isolate user FTP Site

Open any drive and create a folder (Ex: FTP Dir) = Open the folder and create
some files Ex: 1.txt, 2.txt, 3.txt.

\t)v | |. v Computer v Local Disk (F:)  FTP Dir . m

Eile Edit View Tools Help

Organize v {1 Views v (€3 Bun

Favorite Links Nan?e - |-| Datg rnodiﬁed Ivl Type I-I Size lvl Tags
=il 11/3/2009 12:39... TextDocument 0KB
E‘ Documents =2 11/3/2009 12:39... TextDocument 0KB
E Pictures =3 11/3/2009 12:39... TextDocument 0KB
B music
More »
Folders Vi
Bl Desktop
ﬁ} administrator
) Public

1 Computer
‘:_? Local Disk {C:)
(s Local Disk (D:)
L—é’a DVD RW Drive {E:)
Cw Local Disk (F:)

&¥ Network

[# control Panel

Select Start = Programs =2 Administrative Tools = Internet Information

Services (IIS) Manager.

LI

Administrator  Recyde Bin

. Terminal Services
=5 Active Directory Domains and Trusts
e ﬁﬂ Active Directory Sites and Services
Computer : Active Directory Users and Computers
2 ADSIEdit

WE . Component Services
HOSt Nan]( Computer Management

E Data Sources (ODBC)
IP Addressf
{2 Eventviewer
DNS Serve] = Group Palicy Management
&, iSCST Initiator
S Local Security Policy
[a] Memory Diagnostics Tool
| Extres and Upgrades  #| (@) Relisbility and Performance Manitar
. Maintenance v| 3 Security Configuration Wizard
. Microsoft Office 3 i Server Manager
. Startup b\ Services
& Internet Explorer ‘32| Share and Storage Management
Windows Contacts ¥ Storage Explorer
= system Configuration
(L) Task Scheduler
ﬂ Windows Firewall with Advanced Security
@ Windows Server Backup

™ Intemet Information Services (II5) Manager 4 Ws 204AM
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In the left pane of the Internet Information Services dialog box = Expand the

server = Right click on Sites and select ADD FTP Site

ﬁ<'E Internet Information Services (IIS) Manager

@’G‘) | 8] > Svs1 b Sites » [a; »~ fa
File View Help
tons G e .
e il |8 E & situna
&5 Start Page Set Web Site Defaults...
=-95 Y51 (MICROSOFT\Administratof | | Titer: - s - Eshowal | Al .——
&} Application Pools Name ~ [ [ status [ Binding @ AddFTPsite...
&8l €D Default Web Site 1 Started (http)  *:30 (http) Set FTP Site Defaults...
0@ Addwebsite... @ Heb
Online Help

%3 Refresh

@ addresite... |

{5 Switch to Content View

«| | i3
J Plemmmi

In Site Information screen, enter the FTP site name, and enter the path to the
home folder (Content Directory) you want to assign to this FTP site. This can be
either a local path or a UNC path of the shared folder = you can browse for this

folder if you need to = click Next.

Add FTP Site 3 21x|

@ Site Information

ETP site name:
[Do NOT ISOLATE USERS)|

Content Directory
Physical path:

|E:FTP DR _]

Previous l Next I Eirish I Cancel I

87



Windows Server 2008 - Network Administration

In the Bindings and SSL Settings dialog box select the IP address and port no. and
select “NO SSL”.

Add FTP Site i 21|
q Binding and SSL Settings
—Binding
IP Address: Port:
J10.00.1 =l o

™ Enable Virtual Host Names:

Virtual Host {(example: ftp.contoso,com):

V' start FTP site automatically

—ssL
& NossL

" Allgw SSL

" Require SSL
SSL Certificate:

IHot Selected j View, v I
Previous I Next I Eirish l Cancel

In Authentication and Authorization Information dialog box Check the box for
Anonymous and Basic, Select All Users, Check the box for Read and Write -

click Finish.

Add FTP Site i 21|

q Authentication and Authorization Information

—Authentication
v Anonymous
v Basic

— Authorization

Allow access to:

IAH users ﬂ
I

Permissions

V' Read
v Write

Previous Next I
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Accessing the FTP site from the Client systems

SYS2 — CONFIGURATION

Go to any Computer = Open Internet Explorer and type ftp://ftp _ip address

and Press Enter.

Ex: ftp://10.0.0.1

_isix
@: v IE. ftp://10.0.0.1/ j 2| X Ilee Search Rl
T8 df  @FTProotat 10.0.0.1 | | %2 - B - &= ~ |irPage ~ () Tools ~ 7

FTP root at 10.0.0.1

To view this FTP site in Windows Explorer, click Page, and then click Open FTP Site in Windows Explorer.

01/04/2004 09:24FM 0 1.txt
1/04/2004 09:249FH 0 2.txC
/2004 09:24PM 0 3.txt

=
[pore ’_’_’_ ’_ ’_ m ’E [@ mnternet | Protected Mode: Off [%100% -~ ,
Lostart| | 5 M & || @ FTP rootat 10.0.0.1 - .. 5 @iy 56
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Lab — 3: Creating Isolate user FTP site

SYS1 —-CONFIGURATION

Open Active directory users and computers and create users (Ex: Userl, User2).

In any Drive create a folder named Root.

Open root and create a folder with the domain’s NetBIOS name MICROSOFT.

P w N oe

Open the folder MICROSOFT and create folders with user names Userl, User2.

=
‘Gév | - Computer = Local Disk (E:) = ROOT - MICROSOFT - - m ISEE":"‘ @

File Edit View Tools Help

Organize v {Hviews v [W7Explore 23 Share (@ Bun (7]

Favorite Links Mame * |-l Date modified |+ Tvpe |-lsze  |-|tses  [-]
) Userl 142010 1:50 PM  File Folder

[El pocuments 1/4/2010 1:46PM  File Folder
EE Pictures

!B' Music

More »

Folders hd

Bl Desktop
[ﬁ Administrator
J Public
1M Computer
& Local Disk (C:)
= Local Disk (D:)
(=g Local Disk (E:)
ROOT
. MICROSOFT
. Userl
User2

5.  Open user name folders and create some files.

-Ioix]
T, -
‘ 3 ( b | ~ Computer + Local Disk (E:) = ROOT » MICROSOFT = Useri v & [search (2]
File Edit View Tools Help
Organize + Eviews = (@ Bun @
Favorite Links Mame = I 'I D‘?t‘? modified | 'I Type I'I Size I ‘I
=/ 1/4/2010 1:50 PM  Text Document OKB
[El Documents =2 1/4/2010 L50PM  Text Document 0KE
EE Pictures Ei3 1/4/2010 1:50PM  Text Document 0KEB |
!B' Music
Maore  »
Folders v
B Desktop
rﬁ Administrator
J Public
18 Computer

a, Lacal Disk (C:)
(g Local Disk (i)
(= Local Disk (E:)
, ROCT
., MICROSOFT
) Userl
J User2
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6.

Select Start = Programs > Administrative Tools - Internet Information

Services (IIS) Manager.

LI

Administrator  Recyde Bin

. Terminal Services
=5 Active Directory Domains and Trusts
g ﬁﬂ Active Directory Sites and Services
: Active Directory Users and Computers
2 ADSIEdit

WE . Component Services

;g-‘ Computer Management

HOSt Nan]‘ Data Sources (ODEC)
IP Addressils

{2 Eventviewer
DNS SEI'VEI (= Group Policy Management
PR PR <, (=Sl Initiator

[ e 4 % sy oy

B Administrative Tools (| Memory Diagnostics Taol
), Documents . Extras and Upgrades ¥ @ Reliability and Performance Monitar
. Maintenance ¥| 3 Security Configuration Wizard
. Microsoft Office 3 i Server Manager
search . Startup b\ services

@ Internet Explorer ‘32| Share and Storage Management

=P B Windows Contacts  |g® Sterage Explorer
2 system Configuration
(L) Task Scheduler
ﬂ Windows Firewall with Advanced Security
W Windows Server Backup

™ Intemet Information Services (I15) Manager

Computer

Settings

Run...

‘Windows Server 2008 Enterprice

Shut Down...

In the left pane of the Internet Information Services dialog box = Expand the

server = Right click on Sites and select ADD FTP Site

"»'E Internet Information Services (IIS) Manager ]
@g) [ 81 » srs1 v sites » & - 5
File View Help

YR @) sites P

;- Qﬂ Start Page

o ~ — Set Web Site Defaults...
565 SYS1 (MICROSOFT\Administratol | | TIter* fice ~(Gyshowal | B I
+-(E) Application Paols Name ~ [o | status [ Binding @ AddFTPsite...
&8l Default Web Site 1 Started (http)  *:80 (http) Set FTP Site Defaults...
U@ Addwebsite... @ Helpi
83 Refresh Online Help

@ addrresite...

Switch to Content View

| | |

4 | ] [EllFeatures
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In Site Information screen, enter the FTP site name, and enter the path to the
home folder (Content Directory) you want to assign to this FTP site. This can be
either a local path or a UNC path of the shared folder = you can browse for this

folder if you need to = click Next.

Add FTP Site i 21x|

q Site Information

ETP site name:
f1SOLATE UsERs

Content Directory
{ Physical path:

[E-rooT [ |

Cancel

In the Bindings and SSL Settings dialog box select the IP address and port no. and
select “NO SSL”.

Add FTP Site i 21
q Binding and SSL Settings
—Binding
IP Address: Port:
|10.00.1 =

™ Enable Virtual Host Names:

tual Host (example:

V' Start FTP site automatically

—SsL
(¢ NossL

" Allow SSL

" Require SSL
SSL Certificate:

Not Selected

Previous I Next I Finish | Cancel |

Note: In one computer we cannot run 2 ftp sites on the same IP address & on the

same port number. Any one should be changed.
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10. In Authentication and Authorization Information dialog box Check the box for
Anonymous and Basic, Select All Users, Check the box for Read and Write >

click Finish.

Add FTP Site i 2]x|

@ Authentication and Authorization Information

—Authentication
V' Anonymous
v Basic

r— Authorization

Allow access to:

IAI\ users ;j
I

Permissions

V' Read
IV yrite

Previous I Next |

Cancel I

11. Select the FTP Site and select FTP User Isolation Option

“E Internet Information Services (IIS) Manager _ =]
@g} [0 » SYS1 » Sites » ISOLATEUSERS » | B 5@ -
File view Help
e ISOLATE USERS Home
ea' ld Iil |& Open Feature
‘G’a Start Page —
- . v 22 . Explore
€ 551 (MICROSOFT\Administrator) | | | STOUPOY: Area 23 e E:TP N
g It Permissions. ..
3 Application Pools FTP
E-[8] Sites . Edit Site
4@ Default Web Site ng 5 4 " i
&€ ISOLATE USERS LlE E& G WPk
(=] MICROSOFT FTP FTP FTP Current  FTP Directory [=] Basic settings...
Authentication Authorizati... Sessions Browsing
View Applications
‘ Ty = View Virtual Directories
Gid G
FTPFirewall ~ FTPIPv4  FTPLogging FTP Messages Manage FTP Site &)
Support Address a... Restart
=5 N . Start
[FTP) Stop
FTP Request FTP SSL FTP User 3
Filtering Settings Isolation Advanced Settings...
© rHep
Online Help
4 | [ =] Features view |/ 2 Content View
Ready Gﬂ
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12. Select the option “User name Physical Directory” -> click Apply.

"E Internet Information Services (IIS) Manager

File View Help

Comections ; CActons
rEETEIY 0 FTP User Isolation

| =181x]
[& - e -

[O » SYS1 » Sites b ISOLATEUSERS »

57 A
- .'G’g Start Page 5x Cancel
B- Ga SYS1 (MICROSOFT \Administrator) FTP user isolation prevents users from accessing the FTP home directory
=Y of another user on this FTP site, @ Help
{2} Application Pools
B8] Sites Jo not isolate users. Start users in: Oniine Help
- 0 Default Web Site
€9 ISOLATE USERS € ETP root directory

[-[] MICROSOFT " User name directory

‘solate users, Restrict users to the following directory:
" Usernamedirectory (disable globalvirtual directories)
& Username physical directory (enable global virtual directories)
" FTP home directory configured in Active Directory

Seti..
& Custom

[ I
: 1o ooy [y

Configuration: ‘applicationHost.config'

4
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Accessing the FTP site from the Client systems
SYS2 — CONFIGURATION
1.

Open the browser and type ftp://ftp ip _address:port number (If the ftp site
port is not default (21))

Ex: ftp://10.0.0.1:2100 or ftp://10.0.0.1

f_.: Internet Explorer Enhanced Security Configuration is enabled - 8] x|
(S L |g, ftp://10.0.0.1f j *2(| X ILive Search Foiig

— = »

v ke ) Connecting... | | [ - fy v b Page v} Tools ~

x| 2l
figuration is enabled

ently enabled on your server. This configures

== Internet and intranet Web sites. The

Web sites that might pose a security risk. For
FTP server: 10.0.0.1 n, see Effects of Internet Explorer Enhanced

Internet Explorer

? Talog on to this FTP server, type a user name and password.

User name: I |

m displaying correctly in Internet Explorer and
rerzal Naming Cenvention (UNC) shares. If
lorer functionality that has been disabled, you

anet or Trusted sites zones. For more
After you log on, you can add this server to your Favorites and return to it easily. Ecurity Configuration.

Password: I

™ Log on anonymously

|

2.  Give the username and the password.

Internet Explorer

x|
'\E‘? To log on to this FTP server, type a user name and password.
FTP server: 10.0.0.1
User name: I USER 1@MICROSOFT.COM
Password: [ooeeeees
After you log on, you can add this server to your Favorites and return to it easily.
I~ Log on anonymously
|
3.  User Home Directory will be displayed.
i8I
@; v Iﬁ. ftp://10.0.0.1/ j | X ILive Search Pl-
W A @ FTProotat 10.0.0.1 | | o - E] - f=h - b Page - () Tools »
=l
FTP root at 10.0.0.1

To view this FTP site in Windows Explorer, click Page. and then click Open FTP Site in Windows Explorer.

f2004 09:24PM

0 1.txt
/2004 09:24FPM 0 2.txt
/2004 0%9:24FM 0 3.txt
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Lab — 4: Creating Isolate user using Active Directory FTP site

SYS1 —-CONFIGURATION

1. Open any drive (Ex: D:\)and create a folder (Ex: Sales) = Open the folder and

create some files (Ex: a.txt, b.txt).

6& | . = Computer -~ Local Disk (D:) ~ sales - m} ISearch

File Edit view Tools Help

Organize * i views ~ () Bumn

Favorite Links LETE2 = I 'I e ——— I 'I g I b
| adtxt 1/4/2004 10:52 PM Text Document
Documents | bt 1/4/2004 10:52 PM  Text Document

E

E Pictures

B_._j' Music

|4 Recently Changed
E Searches

J Public

2. Select Start = Programs => Administrative Tools = Internet Information

Services (IIS) Manager.

LI

Administrator ~ Recyde Bin

Terminal Services
3@ Active Directory Domains and Trusts
= [l Active Directary Sites and Services
—— | Active Directory Users and Computers
2 ADSIEdit

WE . Compaonent Services
HOSt Nan]f Computer Management

=5 Data Sources (ODBC)

IP Addressila

Network 18] Eventviewer

71 Windows Update DNS See] 24 Group Palicy Management
= TN G_ﬁ, iSCS Initiator
YT e iseantok

| IS R G (| Memary Diagnostics Taol

i, Documents Extras and Upgrades  » |63 Relizbility and Performance Monitor

X Maintenance M| S Security Configuration Wizard
S . Microsoft Office b Th Server Manager
Search . Startup v\ Services

& Internet Explorer 'z Share and Storage Management

e e SapEr Windows Contacts "% Storage Explorer
System Configuration
(T) Task Scheduler
@ Windows Firewall with Advanced Security
W Windows Server Backup

™ Intemet Information Services (II5) Manager & My 2:04AM

j Rum...

ShutDown...

‘Windows Server 2008 Enterprise
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In the left pane of the Internet Information Services dialog box = Expand the

server = Right click on Sites and select ADD FTP Site

(5 [ » svs1 » sites » &5
File View Help
[ @) Sites e
€-id|& | i' @ Add Website...
€5 Start Page — ; = T— Set Web Site Defails...
285 SY51 (MICROSOFT \Administrato bk . - Sshow Al | E |
2} Application Pools Name ~ | | status | Binding @ AddFTP Site...
E-el Default Web Site 1 Started (http)  *:80 (http) Set FTP Site Defaults...
@ AddWebsSite... @ Heb
53 Refresh Online Help
[@ addrresite... |
| iz Switch to Content View

< | i |
’ R

In Site Information screen, enter the FTP site name, and enter the path to the
home folder (Content Directory) you want to assign to this FTP site. This can be
either a local path or a UNC path of the shared folder = you can browse for this

folder if you need to = click Next.

Add FTP Site 21x|

@ Site Information

ETP site name:
IISOLATE USER USING AD

Content Directory
Physical path:

|p:'saLes D

Previous Mext Erish Cancel
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In the Bindings and SSL Settings dialog box select the IP address and port no. and

“ ”
select “NO SSL”.
Add FTP Site j 21|
q Binding and SSL Settings
—Binding
IP Address: Port:
J10.00.1 =l o
™ Enable Virtual Host Names:
Virtual Host {(example: ftp.contoso,com):

IV start FTP site automatically

—ssL
& NossL

" Allgw SSL

" Require SSL
SSL Certificate:

I:m( Selected

Note: In one computer we cannot run 2 ftp sites on the same IP address & on the

same port number. Any one should be changed.

In Authentication and Authorization Information dialog box Check the box for
Anonymous and Basic, Select All Users, Check the box for Read and Write 2>

click Finish.

Add FTP Site i 21|

q Authentication and Authorization Information

—Authentication
v Anonymous
v Basic

— Authorization

Allow access to:

IAH users :J
|

Permissions

V' Read
V' write

Previous Next | Cancel |
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Select the FTP Site and select FTP User Isolation Option

\ﬁ Internet Information Services (IIS) Manager ]

=181x]

@@ [O » SYS1 b Sites

» ISOLATE USERS USING AD »

| 1@ -

File View Help

Q- H|% |8

Tﬁ Start Page
i) -qa SYS1 (MICROSOFT \Administrator)
e J Application Pools
(18] Sites
-4 Default Web Site
& ISOLATE USERS USING AD

Ready

0 ISOLATE USERS USING AD Home

FTP Firewall FTP IPv4
Support Address a...
= a]
T LiF®)
FTP Request FTP SSL
Filtering Settings

Group by: Area T EE-
FTP
@ « g{
S0 G G
FTP FTP FTP Current  FTP Directory
Authentication Authorizati... Sessions Browsing

Open Feature

42 Explore
Edit Permissions...

Edit Site
Bindings...
Basic Settings...

View Applications
View Virtual Directories

Manage FTP Site
Restart
Start
Stop
Advanced Settings...

Configure isolation settings for FTP sessions |

Online Help

@ Features Vi

4

Select “FTP home directory configured in Active Directory” - click Set.

™E Internet Information Services (IIS) Manager

=18]x]

@-@ [0 » SYS1 b Sites

» ISOLATE USERSUSING AD »

EEECE

File View Help

€-iH |2 |8

—ﬁg Start Page

183 SYS1 (MICROSOFT\Administrator)
) Application Pools

Sites

-4 Default Web Site

€ ISOLATE USERS USING AD

4 >

of another user on this FTP site.
" FTProot directory

" User name directory

Isolate users. Restrict users to the

(¢ FTP home directory confi

0 FTP User Isolation

FTP user isolation prevents users from accessing the FTP home directory

Do not isolate users. Start users in:

following directory:

(" Usernamedirectory (disable globalvirtual directories)
" Username physical directory (enable global virtual directories’

gured in Active Directory

{& Custom

<

Configuration: ‘applicationHost.config'

[ =] Features View |\~ Content View
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[Zx Cancel
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9. Mention the User name as Administrator@Microsoft.com, provide the password

and confirm the password - Click OK

User name:

I.-‘-\dministrator @Microsaft.com

2]

Password:

Confirm password:

Illllllll

[ o 1]

Cancel |

1-'E Internet Information Services (IIS) Manager
@ @_) [ € » svs1 b Sites b ISOLATEUSER USING AD »

File View Help

=181
|G 5@ -

0 FTP User Isolation

€-id|7 |8 5/ pply
Start Page o i X [55¢ Cancel
51 (MICROSOFT \Administratof FTP user isolation prevents users from accessing the FTP home directory of

T another user on this FTP site. @ Hel
-[E} Application Pools P

Sites Do not isolate users., Start users in: Online Help
& Default web site

& TSOLATE USER LISTNG AT

{~ FTP root directory
{~ User name directory

Isolate users. Restrict users to the following directory:
" Usernamedirectory (disable global virtual directories)
{~ Username physical directory (enable global virtual directories)
{* FTP home directory configured in Active Directory

Administrator @Microsoft. com Set...

€ Custom

Configuration: 'applicationHost. config' Qﬂ

[ | »
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How to set Active Directory properties

Open Active Directory Users and computers > click View - Select Advanced

Features
Active Directory Users and Computers ;lill’
Fie Action | view Help
ash | ¥ Add/Remove Columns... T o R
J Active Dire{  Large Icons | Description |
] Saved Small Icons Built-in account for admini...
= fj rf'l{croso List Members in this group can...
Bull ® Detail

(24| v Advanced Features
Los| Filter Options...

Users, Contacts, Groups, and Computers as containers

Customize...

K —— i3]

&, Domain Admins
Q!,Domaln Com...
82, Domain Cont...
%Domaln Guests

Security Group ...
Security Group ...
Security Group ...
Security Group ...

Members of this group are...
Members in this group can...
Members who have admini...
Members who have view-...
DNS Administrators Group
DNS dlients who are permi...
Designated administrators...
All workstations and serve...
All domain controllers in th...
All domain guests

%Domaln Users  Security Group ...  All domain users
%Enterprise A... Security Group ... Designated administrators...
%ER(ETD!’ISE R... Security Group ... Members of this group are...
&B,Group Policy ... Security Group ... Members in this group can...
.!; Guest User Built-in account for guest ...
3_. krbtgt User Key Distribution Center Se...
%RAS and IAS ... Security Group ... Servers in this group can ...
8 Read-only D... Security Group ... Members of this group are...
%Schema Admins Security Group ... Designated administrators...
2 User1 User

2 User2 User

|Enab|es/disables advanced features and objects

Right click on the User account (Ex: Userl) - Select Properties

Active Directory Users and Computers - |ﬂ L)_g
File Action View Help
T P > : e .
e | 2@ {0 XD d=z HE|3 a5 TR
: Active Directory Users and Comput | Name ] Type | Description |
] Saved Queries ui Administrator  User Built-in account for admini...
=] ‘iﬂ Microsoft.com %Allm\*ed ROD... Security Group... Members in this group can...
Builtin 82, Cert Publishers  Security Group ... Members of this group are...
Compgters %Deniad ROD... Security Group ... Members in this group can...
Dom.aln Controliers %DHCP Admini... Securitv Group Members who have admini...
Focelanseauriybrinapals .EE,DHCP Users Copy... ers who have view-...
:‘r)z:::w?::ad .S&Dns;\dmlns Add to a group... dministrators Group
Sysfem 2 DnsUpdatePr... Name Mappings... ients who are permi...
s 82 Domain Admins Disable Account ated administrators...
NTDS Quotas 82, pomain Com... ResetPassword...  kstations and serve...
S?,Domam Cont... Move... ain controllers in th...
82, Domain Guests Open Home Page hain quests
82, Domain Users Send Mail pain users
8 enterprise A... [T o , fated administrators. .
S&Enterprlse R... ers of this group are...
%Gfoup Policy ... Cut ers in this group can...
!. Guest Delete account for guest ...
2, btgt Rename stribution Center Se...
PQ,RAS and IAS ... s in this group can ...
Pr
%Readonly D... 7 rs of this group are...
Sf)Schema Admins Help ated administrators...
2 user2 User
K — 2

IOpens the properties dialog box for the current selection.
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3. Select Attribute Editor
2|

Published Certficates I Member O I Password Replication I Dial-in | Object I

Security | Environmerit I Sessions | Remote control I

' General | Address I Account I Profile I Teleph: | (8] izati
Teminal Sarvices Profile I COM+
Aftributes

Mtribute | Valueg ﬂ

account Expires {never) L

accountMameHistory Znot set>

aC5PalicyMame Znot set>

adminCount <not set>

adminDescription <not set>

admin DisplayMame <not set=
alt Securityldertities <not set=
assistant <not set=
attibuteCenfficateAttr... <not set>
audio
badPassword Time
badPwdCourt
businessCategony
=3

«

Edit |

QK I Cancel Apply Help

4, Select mslIS- FTPDir
2|

Published Certficates I Member Of I Password Replication I Dial-in | Object I

Security | Environment I Sessions | Remote cortrol I
General | Address I Account I Profile I Telephones I Organization I
Terminal Services Profile I COM+ Attribute Editor
Mtributes
Aftribute | Valuz :I
maD'S-Site-Affinity <not set>

msDS-SourceObjectDN  <not set=
msDS-SupportedEncr...  <not set=
msExchAssistantMame  <not set>
msExchHouseldentifier  <not et
msExchLabeledURI <not set= -
S-FTPDir

msl|S

msll5-FTPRoot <not sst>
mSMQDigests <not set=
mSMQDigestsMig <not set=

mSMQSignCertificates  <not set>
m3SMQSignCertficate.. <not set=
msMP AllowDialin <not et

msMPCallingStation|D  «<not set =
e , LIJ
Edit Filter |

oK I Cancel Lpply Help

5.  Click Edit and Mention the Folder name (Ex: Sales) = click OK.
]

Atribute: mslIS-FTPDir

Value:
ISaIes

Clear |
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6. Select mslIS- FTPRoot - click Edit and Mention the Path of the Directory
(Ex: D:\) = click OK.

7.  Verify the values given = click Apply & OK.
21

Published Ceriificates I Member O I Password Replication | Dial-n I Object

Securty I Environmerit | Sessions I Remote control
General I Address I Account I Profile I Telephones | Organization
Teminal Services Profile I COM+ Atribute Editor

Attriputes:
Atribute | Value d
meD5-Site-Affinity ot set

meDS-SounceObject DN <not set>
meDS-SupportedEncr...  <not set>
msExchAssistantMame  <not set>
msExchHouseldentifier  <not set>

msExchlabeledURI  <mot set> —
mslIS-FTPDir Sales

mslIS-FTFRoot D

mSMQDigests not set

mSMQDigestsMig znot set

mSMQSignCerificates  <not set>
mSMGSignCerificate...  <not set>
msMPAllowDiglin <ot set>

msNPCalingStation|D  <not set> -
g | _'I_I
Edit | Fiter |

0K Cancel

Help

Accessing the FTP site from the Client systems

SYS2 — CONFIGURATION

1. Open the browser and type ftp://ftp _ip_address:port number (If the ftp site

port is not default (21))

Ex: ftp://10.0.0.1:2110 or ftp://10.0.0.1
i8]

—_—
| A, - |g ftp://10.0.0.1/ j 4| X ILwe Search £
- = »
W & ) connecting.., | | %~ B - = - - Page ~ () Tools ~
Internet Explorer x| ;I
iguration is enabled
Tolog on to this FTP server, type a user name and password. ently enabled on your server. Thiz configures
se Internet and intranet Web sites. The
Web sites that might pose a security risk. For
FTP server: 10.0.0.1 n, see Effects of Internet Explorer Enhanced
User name: Il m displaying correctly in Internet Explorer and
wversal Naming Convention (UNC) shares. If
Passward: I lorer functicnality that has been disabled, you
anet or Trusted sites zones. For more
After you log on, you can add this server to your Favorites and return to it easily. Ecurity Cenfiguraticn.

™ Log on anonymously
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Give the username and the password.

Internet Explorer x|

? Ta log on to this FTP server, type a user name and password.

FTP server: 10.0.0.1

User name: | User1

Passward: I Ty

After you log on, you can add this server to your Favorites and return to it easily.

[~ Log on anonymously

i Cancel |

User Home Directory will be displayed.
=18 x]

———
A A e IE. fitp://10.0.0.1/] j #2 (% ILive Search 2 |-
U5 df @FTFroatat 10.0.0.1 | | %y - B] - f=h + |2k Page - () Tools =

=
FTP root at 10.0.0.1

To view this FTP site in Windows Explorer, click Page. and then clickk Open FTP Site in Windows Explorer.

01/04/2004 10:52PH J a2.THt
01/04/2004 10:52PH 0 b.txt
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ROUTING

Before working on this lab, you must have

1. A computer running windows 2008 server Domain Controller.

2. 2 computer running windows 2008 server with minimum 2 NIC cards.

3. A computer running windows 2008 server web server.

SYS1

SYS2

MICROSOFT.COM

SYSs1

Domain Controller / DNS Server

IP Address

Subnet Mask
Gateway
DNS Server
SYS3

Router - I

IP Address
Subnet Mask
Gateway

DNS Server

10.0.0.2

255.0.0.0
10.0.0.1

10.0.0.2,12.0.0.2

11.0.0.2,12.0.0.1

255.0.0.0
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SYS4

SYS3

SYS2

Router - |

IP Address 10.0.0.1, 11.0.0.1
Subnet Mask  255.0.0.0
Gateway = -

DNS Server 10.0.0.2

SYs4

Web server / DNS Server

IP Address 12.0.0.2

Subnet Mask  255.0.0.0
Gateway 12.0.0.1

DNS Server 12.0.0.2,12.0.0.1
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Lab — 1: Assighing the IP Address to Configure Routing

ON PRIVATE:

1. Logon to Private.

L

Administrator  Recyde Bin

Private

Host Name :  SYs1

IP Address : 10.0.0.2
Gateway : 10.0.0.1
DNS Server : 10.0.0.2,12.0.0.2

Internet
Explorer

Control Panel

Distart| | S, & | Zigm Wil 337PM

2.  Check the IP settings:

Right click on network icon = click Manage Network Connections = Right click

NIC card > click properties

[ metwork comectoms LI
” OO ‘@ » Control Panel =~ Network Connections - m Isearch @
File Edit WView Tools Advanced Help
Orgenize = 5 views - @
I Hame |-| Status |v| Device ll.amelvl Connec... = |v| HNetwork (‘ategorylvl owner |v| Type |-| | 4
Access to Local only (1) B
:.. 10.0.0.2

= >-.,";’ Unidentified network
@~ Realtek RTL8139/810x Fa...
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3. Right click on NIC card —>click properties >Internet Protocol Version 4
(TCP/1Pv4) - properties = Define the IP address as mentioned below.
x|

General |

‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

" Obtain an IP address automatically

IP address: W .0 .0, 2
Subnet mask: 255 . 0 .0 .0
Default gateway: o .0 .0, 1

! Obtain DS server address automatically

—{* Use the following DNS server addresses:
Preferred DMS server: w. 0 .0, 2

Alternate DNS server: 2.0 .0 .2

Advanced... |
Ok I Cancel |
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ON ROUTER 1:

1. Logon to Routerl

LI

Administrator  Recyde Bin

Router-1

Host Name :  SYS2
IP Address :  10.0.0.1,11.0.0.1

DNS Server :  10.0.0.2

Internet
Explorer

Control Panel

sl nme | G @G rom

2.  Check the IP settings:

Right click on network icon = click Manage Network Connections=> Right click

NIC card —>click properties —>Internet Protocol Version 4 (TCP/IPv4) ->

properties=> Define the IP address as mentioned below.

1o
|QWC\) |@ ~ Control Panel - Network Connections ~ & [search @]|
Fle Edit View Tools Advanced Help
Organize ~ 3= Views = @
Hame ~| Status ~| Device Hame |~ (bnnectivity'-l Hetwork Cat_egory|'| owner |-| Type |-| | >|
LAN or High-Speed Internet (2) =

10.0.0.1 -, 11001
o= Unidentified network “#=>__ Unidentified network
@” Realtek RTL8139/810x Fa... @ Intel(R) PRO/100 VE Net...
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On ROUTER 2:

1. Logonto Router2

LI

Administrator  Recyde Bin

Router-2

Host Name :  SYS3
IP Address : 11.0.0.2,12.0.0.1

DNS Server :  11.0.0.2

Internet
Explorer

Control Panel

.’*stml |ameE | Lo @y 351PM

2.  Check the IP settings:

Right click on network icon = click Manage Network Connections = Right click
NIC card —>click properties —>Internet Protocol Version 4 (TCP/IPv4) ->

properties=> Define the IP address as mentioned below.

JEIES
OO |@ ~ Control Panel - Network Connections - B |Search )
file Edit View Tools Advanced Help

Organize ~ 5= Views ~ @
Name I' Status ~| Device Name | -| Connectivity | ~| Network Catggoryl-' Owner |'| Type |'| | 4
LAN or High-Speed Internet (2) =]
c 11.0.0.2 c 12.0.0.1
“#=>__ Unidentified network “e=>__ Unidentified network
&7 Realtek RTL8139/810x Fa... £ Intel(R) PRO/ 100 VE Net...
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On PUBLIC:

1. Logon to Public

LI

Administrator  Recyde Bin

A

Computer

PUBLIC

Host Name : SYS4
IP Address : 12.0.0.2

Gateway : 12.0.0.1
DNS Server : 12.0.0.2,12.0.0.1

Internet
Explorer

Control Panel

{‘stml |ameE | Lo @y 247PM

Check the IP settings:

Right click on network icon > click Manage Network Connections.

[ nctwork comeciom

_l&x

] OWC) ‘@ » Control Panel » Network Connections & |g,gc-,,-‘:|T D]
Fle Edit Wiew Tools Advanced Help

Organize = S Views ~ @ Disable this network device  [S Diagnose this connection =1 Rename this connection  » @

Hame || Stotus | | Device Neme | - Connectvity | +| Metwork Category | +| @wner || Type

| ~| Phone = or Host Address |+
LAN or High-Speed Internet (1)
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3. Right click on NIC card —>click properties >Internet Protocol Version 4
(TCP/1Pv4) - properties> Define the IP address as mentioned below.
x|

General |

‘fou can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

" Obtain an IP address automatically

IP address: 2.0 .0 .2
Subnet mask: 255 . 0 .0 .0
Default gateway: 2.0 .0 .1

! Obtain DS server address automatically

—{* Use the following DNS server addresses:
Preferred DMS server: 2.0 .0 .2

Alternate DNS server: 2.0 .0 .1

Advanced... |
Ok I Cancel |
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Lab — 2: Installing Routing Service on Routerl & Router2

SYS2—- CONFIGURATION
1.  Click Start Programs =>Administrative Tools=> Server Manager

LI

Administrator  Recyde Bin

'

Computer

. Terminal Services
ROI ADST Edit
& Component Services
;g-\ Computer Management

= Data Sources (ODBC)
Host Name O
7—P Address 2] Eventviewer
&, iSCST Initiator

Z Local Security Policy
[ RCT O (| Miemory Diagnostics Tool

=
,;.j Documents . Extresand Upgrades b | Netwark Palicy Server
E’ . Maintenance v @ Relisbiity and Performance Monitor
Settings L4 -
¢ . Microsoft Office 3 j‘_;‘ Security Configuration Wizard
Search »| |, Startup (Y. Server Manager

. Services

'3z] Share and Storage Management

¥ Storage Explorer

= system Configuration

(5) Task Scheduler

ﬂ Windows Firewall with Advanced Security
U windows Server Backup

& Internet Explorer
Windows Contacts

Help and Support

@0

1= Run...

=7
E)] ShutDown...

'Windows Server 2008 Enterprice

S Wiy 407PM

2.  Select Roles = click Add Roles
-l

Eile Action View Help
e A0l

2. Server anager (52
= e |

& Features View the health of the roles installed on your server and add or remove
= Diagnostics " roles and features.

Gt configuration
{3 storage

(~) Roles Summary Roles Summary Help

(~) Roles: 0 of 16 installed S Add Roles
32 Remove Roles

£ Last Refresh: 9/29/2008 7:34:42 PM_Configure refresh
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Add Roles Wizard
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EE:? Select Server Roles

Before You Begin

Server Roles

Network Policy and Access Services
Role Services

Confirmation

Progress

Results

4,
->click Install

Select one or more roles to install on this server.
Roles:

] Active Directory Certificate Services

[ Active Directory Domain Services

[ Active Directory Federation Services

[ Active Directory Lightweight Directory Services
[ Active Directory Rights Management Services
[[] Application Server

L] DHCP Server

[] pus Server

[] Fax Server

[ File Services

i

[ Print Services

[] Terminal Services

[[] uopI services

] web Server (1IS)

] Windows Deployment Services

More about server roles

< Previous | Next > I

Select the Check Box for Network policy And Access Services > click Next

Description:

Network Policy and Access
Services provides Network
Policy Server (NPS), Routing
and Remaote Access, Health
Reqistration Authority (HRA),
and Host Credential
Authorization Protocol (HCAP),
which help safeguard the health
and security of your network.

Install Cancel

Add Roles Wizard

EE} Select Role Services

Before You Begin
Server Roles
Netwaork Policy and Access Services

Role Services
Confirmation
Progress

Results

Select the Check Box for Routing And Remote Access Services —>click Next

Select the role services to install for Network Policy and Access Services:

Role services:

] Network Pelicy Server
8
[¥] Remote Access Service
[ Routing
[ Health Registration Autherity
[ Host Credential Authorization Protocol

More about role services

< Previous | Next > |

Description:

Routing and Remate Access
Services provides remote users
access to resources on your
private network over virtual
private network (VPN) or dial-
up connections. Servers
configured with the Routing and
Remote Access service can
provide LAN and WAM routing
services used to connect
network segments within a
small office or to connect two
private networks over the
internat.

Install Cancel
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5. Installation will be Completed > click Close

Add Roles Wizard

EE:% Installation Results

Before You Begin

The following roles, role services, or features were installed successfully:
Server Roles

Network Policy and Access Services [t 1 warning message below

Role Services

) ) di_\ Windows automnatic updating is not enabled. To install the |atest updates, use
Confirmation = Windows Update in Control Panel to check for updates.

Progress
& Network Policy and Access

Results Services @ Installation succeeded

The following role services were installed:
Routing and Remote Access Services
Remote Access Service
Routing

Print, e-mail, or save the installation report

HNext = | Close I Cancel |

Note: - Repeat the process of LAB2 on Router-2 (SYS3) also.
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Lab — 3: Enabling Routing on Routerl & Router2

SYS2 — CONFIGURATION

1.  Click Start »Programs - Administrative Tools=> Routing And Remote Access

Administrator  Recyde Bin

'

Computer

. Terminal Services
Z ADSI Edit

. Component Services

Roi
;g' Computer Management

"? E Data Sources (ODBC)
Host Name [Eg

Network 2] Eventviewer

P Address &, ISCSI Initiatar

_55 Local Security Policy

(] Memory Diagnostics Tool
[ D R R € Network Palicy Server
. Extresand Upgrades b (@) Relisbility and Performance Moritar
. Maintenance S Routing and Remote Access
. Microsoft Office »| 3 Security Configuration Wizard
. Startup b |5 Server Manager
& Internet Explorer
Windows Contacts

,, Documents

Settings »

Search 3

4 Services

'3z] Share and Storage Management

¥ Storage Explorer

= system Configuration

(5) Task Scheduler

ﬂ Windows Firewall with Advanced Security
U windows Server Backup

Help and Support

J Run...

Shut Down...

sart |2 W & |

'Windows Server 2008 Enterprice

7

2.  Right click on system name Configure & Enable Routing and Remote Access
LIE

File Acton view Help
s [ HHEIXEC|HE
F Routing and Remote Acce Y C22) I —

% Server Status

{ Cu-nﬁgura and Enable Routing and Remote Access and Remote Access
Disable Routing and Bemote Access E provides secure remote access to private networks.
. s feess to configure the following:
een two private networks.
View (VEN) gateway.
Delet= server.
e on (NAT).
Properties
Help

TO gU0 3 ROUTTTy- oo Rembte Access server, on the Action menu, click Add Server.

For more information about setting up Routing and Remote Access server, deployment
scenarios, and troubleshooting, see Help.
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3. Click Next

Welcome to the Routing and Remote
Access Server Setup Wizard

This wizard helps you set up your server so that you can
connect to other networks and allow connections fram
remote clients

To continue, click Next.

< Back Next > Cancel

4.  Select Custom configuration > click Next.

Configuration
*fou can enable any of the following combinations of services, or you can
customize this sarver.

" Remote access {dialup or VPN)

Allow remate clients to connect to this server through either a dial-up connection ara
secure virtual private networke (VP N) Intemet connection.

£~ Network address translation (NAT)
Alow imtemal clients to connect to the Intemet using one public |P address.

€ Virtual private network (VPN) access and NAT
Allow remate clients to connect to this server through the Intemet and local clients to
connect to the Intemet using a single public IP address

" Secure connection between two private networks
Conngct this network to a remote network. such as a branch office.

% Custom configuration
Select amy combination of the features available in Routing and Remote Access.

For more information

< Back Next > Cancel

5.  Select LAN routing = Next

Custom Configuration
When this wizard closes, you can corfigure the selected services in the Routing
and Remote Access consale.

Select the services that you want to enable on this server.
™ VPN access

I™ Dialup access
™ Demand-dial connections { used for branch office routing )
= NAT

¥ LAN routing

For more information

< Back Meadt > Cancel
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6. Click Finish

Completing the Routing and Remote
Access Server Setup Wizard

You have successfully completed the Routing and Remote
Arcess Server Setup wizard.

Summary of selections:
LAN routing =]

/|

Mteryou close this wizard, corfigure the selected services
in the Routing and Remote Access console.

To close this wizard, click Finish,

< Back I Finigh I Cancel

7. Click Start service

Routing and Remote Access
Start the service

The Routing and Remote Access service is ready to use.

{Giart service | Cancel I

Starting Routing and Remote A

Flease wait while the Routing and Remote Access

@ service on 5152 starts.

Note: - Repeat the process of LAB3 on Router-2 (SYS3) also.
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Lab — 4: Configuring Static Routes

SYS2 — CONFIGURATION
ON ROUTER 1:

1. Go to Routing and Remote access = Expand System name =>Expand IPv4->Select

Static Routes—> Right click New Static Route
L

File Action View Help
&= AEld=]

& Routing and Remote Acce |- e el 1o 1

% Server Status

Destination ~ Network mask y Interface
= @ Svs2 (local)
E Network Interfaces There are no items to show in this view.
21 Remote Access Log
B 2 IPv4
H General
3 PV6 Mew Static Route. ..
Show IP Routing Table...
View 3
Refresh
Export List...
Help
| 3] B! | o

| |
2. Define the static route as mentioned below =>click OK.

Interface 11.0.0.1

Destination 12.0.0.0

Network Mask 255.0.0.0

Gateway 11.0.0.2

Metric 256

21|
Interface: |11.0.0. |
Destination: 2.0 .0.0
Metwork mask:
Gateway:
Metric: 256 _:I

¥ | Use this route to initiate demand-disl connections

For more information

oK I Cancel
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SYS3 — CONFIGURATION
ON ROUTER 2:

1. Go to Routing and Remote access >Expand System name —>Expand IPv4

->Select Static Routes—> Right click New Static Route
SER

File Action View Help
I EEEN 7 i

E Routing and Remote Acce | =i e o 1 (o]

&3 server status Destination = | Network mask Y Interface
= @ SvS3 (local)
B Network Interfaces There are no items to show in this view.
{23 Remote Access Log
= 2 1Pv4
B General
3 PV6 New Static Route...
Show IP Routing Table...
Wiew 3
Refresh
Export List...
Help
K ol o

| \
2. Define the static route as mentioned below =>click OK.

Interface 11.0.0.2

Destination 10.0.0.0

Network Mask 255.0.0.0

Gateway 11.0.0.1

Metric 256

21|

Interface:

Destination:

MNetwork mask:

Gateway:
. 356 -

Metric: G |

¥ Wse this route b initiate demand-disl connections

For more information

OK I Cancel
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Verification:

1.  Check the connectivity between 10.0.0.0 and 12.0.0.0 Networks.

2. Log on to SYS4(12.0.0.2)-> Go to Start 2>Run -CMD ->Ping 10.0.0.2 -t and
verify for reply

[ Administrator: C:\Windows\system32\cmd.exe - ping 10.0.0.2

Microsoft Windows [Uersion 6.8.68811
Copyright (c> 2886 Microsoft Corporation. All rights reserved.

C:s\Users“Administratorping 18.8.8.2 —t

Pinging 18.8.8
Reply from 18. 2: hyt 32 TTL=128
.@.2: time{ims TTL=128
time<ims TTL=128
time<{ims TTL=128
.8.8.2: time<{ims TTL=128
Reply from .B.8.2: time{ims TTL=128

3. log on to SYS1 (10.0.0.2) =->Open the Internet Explorer & access

http://www.whatismyip.com (Website is present on 12.0.0.2), so communication

is there between both networks
SEN

P

@)— - Iﬂ'; http: /v whatismyip. com/ j A I e Search

o oy »
W GRE @My WAN IP - IP Address Detection (mywanip.com) | | ’|\ -~ B - &= - |[;FPage - i} Tools -

Detect your dynamic ip address - WAN
address detection by mywanip.com

2|~

| v

‘ Download MyWANiP | Scan your web ports | Get a FREE web domain! ‘

Your Current Internet (WAN) IP:

10.0.0.2 5

Add to Favorites Show Advanced details

Free download - alwaxs know your true IP address!

If you want to run a game server, test a webserver, FTP, remote access, Bittorrent
tracker, or other server applications, you must know your Internet IP address so your
friends know where to connect to. To keep track, you can always revisit this page, OR
download myWANip to your desktop and myWANip is always available in the Windows

svstem trav! MvWANIP is fast. uses verv little memorv. and contains NO nastv spv or |
(| Done l_l_l_l_ml /" Trusted sites | Protected Mode: Off | 0% - g
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Lab — 5: Configuring Network Address Translation

SYS2 — CONFIGURATION

OnROUTER1:

1. Go to Routing and Remote access = Expand System name = Expand IPv4
2.  Right click on General > Select New Routing Protocol

> Rovting and Remotencoess R lelx
] Flle Action View Help
== [#[m0c=Hm
| E3 server Status Interf: = T 1P Add z
|2 Beveag N erface ype ress ncoming bytes
—_ L back Loopback 127.0.0.1 0
B Network Interfaces g oop ‘I: oop (I: dable
{33 Remote Access Log. Interna Interna Not avail
2 H Pua #11.0.01 Dedicated 11.0.0.1 65,156
B 'ES 10.0.0.2 Dedicated 10.0.0.2 6,426
B NewInterface...
Hm| J
Show TCP/IP Information...
Show Multicast Forwarding Table...
Show Multicast Statistics. ..
View e
Export List...
Help
Ll I I K1 | i

|add & new routing protocol

3.  Select NAT = click OK

4. Right click on NAT > Select New interface

| = Routing and Remote Access 18 x
File Acton View Help

&2 oI XE = HE

5 server status Interface ~ Total mappings Inbound packets translated
| = @ s¥s2 (local)
E Network Interfaces There are no items to show in this view.
‘3 Remote Access Log
o H w4
I General
1 static Routes

_ LN
ERCIN
Show DHCP Allocator Information. ..
Show DNS Proxy Information. ..

view v

Delete
Refresh
Export List...

Properties

Help

[Lel | i3 | K1 |

e NAT Interface
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5.  Select LAN interface =>click OK
x|

This routing protocol runs on the interface that you select below.

Interfaces:

ey 10.0.0.1
B 11.0.0.1
a?tntemat

OK I Cancel

6. Select Private interface = click OK.

NAT |

Interface Type:

(% Private interface connected to private network:

(" Public interface connected to the Intemet

™| Enatle MAT on this interface

NAT enables clients on this network to send data to and recsive
data from the Intemet using this interface.

For more information

oK I Cancel Apply
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Again Right click on NAT > Select New interface

1 Routing and Remote Access

Fie Action View Help

=181 x]

@

% 5w XD e = |HE

Y

8

3 server status Interface ~ Total mappings | Inbound packets translated
0

5 SYs2 (local)
= Network Interfaces
‘3 Remote Access Log
= 3 Pve
= General
& static Routes
EYNAT]
IO ]
Show DHCP Allocator Information...
Show DNS Proxy Information...

View »

2210.0.0.1

Select WAN Interface (11.0.0.1)=>click OK

Select Public interface, & Select Enable NAT —>click OK.

Metwork Address Translation Properties - 11.0.0.1 Pro

NAT |Mdness Pool I Services and Ports I

Interface Type:
" Private interface connected to private network
¥ Public inteface connected to the Intemet

v i

=
MAT enables clients on this network to send data to and receive
data from the Intemet using this inteface.

For more information

2]

Cancel HApphy
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Verification:

Before Natting:

On Private = Open Internet Explorer & access http://www.whatismyip.com

the IP address is shown as 10.0.0.2 Private IP.

/,‘ My WAN IP - IP Address Detection {(mywanip.com) - Windows Internet Explorer - |5| |1|
@’_\ - |;e_, http: /v . whatismyip. com, j 4| % I_'_'e Search 2~
ﬂ? ke '_féMy’ WAN IP - IP Address Detection (mywanip.com) | | ﬁ} - o= ,'_t}’EaQe - _‘J Tools -~ »

Detect your dynamic ip address - WAN B
address detection by mywanip.com

‘ Download MyWANiP | Scan your web ports | Get a FREE web domain! ‘

Your Current Internet (WAN) IP:

10.0.0.2 .

Add to Favorites  Show Advanced details

Free download - alwazs know your true IP address!

If you want to run a game server, test a webserver, FTP, remote access, Bittorrent
tracker, or other server applications, you must know your Internet IP address so your
friends know where to connect to. To keep track, you can always revisit this page, OR
download myWANip to your desktop and myWANip is always available in the Windows

svstem travl MyWANIP is fast. uses verv little memorv. and contains NO nastv sov or =
|'!__‘DDFIE ’_'_’_’_'_’_ml f Trusted sites | Protected Mode: Off | H100% - A
After Natting:

On Private = Open Internet Explorer & access http://www.whatismyip.com

the IP address is shown as 11.0.0.1 Public IP.

f,'i My WAN IP - IP Address Detection {mywanip.com) - Windows Internet Explorer =] x|

@A - IE http vhatismyip.com/ j 4| X I_'.'_ P~

ol g X A B e »
_ng VWAN IP - IP Address Detection (mywanip.com) | ﬁ ﬂ v [ v Page v {Qf Tools =

Detect your dynamic ip address - WAN
address detection by mywanip.com

|»

‘ Download MyWANiP | Scan your web ports | Get a FREE web domain! ‘

Your Current Internet (WAN) IP:

11.0.0.1 :

Add to Favorites  Show Advanced details

Free download - always know your true IP address!

If you want to run a game server, test a webserver, FTP, remote access, Bittorrent
tracker, or other server applications, you must know your Internet IP address so your
friends know where to connect to. To keep track, you can always revisit this page, OR
download myWANip to your desktop and myWANip is always available in the Windows

system travl MyWANIP is fast. uses verv little memorv. and contains MO nastv sov or =l
1| Done, but with errors on page. ’_ l_l_l_l_l_lfTrusbed sites | Protected Mode: Off | # 100% - v
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Lab — 6: Configuring DHCP Relay Agent
SYS1-CONFIGURATION

Note: Install DHCP service and create a scope with 12.0.0.10 to 12.0.0.100 with the
router IP as 12.0.0.1.

On Router2
SYS3-CONFIGURATION

1.  Go to Routing and Remote Access > Expand System name ->Expand IPv4
2. Right click General = Select New Routing Protocol

3.  Select DHCP Relay agent - click OK.
=

Click the routing protocol that you want to add, then click QK.
Routing protocols:

DHCP Relay Agent
W~ IGMP Router and Proxy

WONAT
%~ RIP Version 2 for Intemet Protocal

oK I Cancel

4.  Right click on DHCP Relay Agent, Select New Interface.

SIS

Fille Action View Help

[
]
e [FEIXE o[
!

E%)uting and Remote Access [ To 0 2B TS

Server Status =
Interface ~ Relay mode Requests received Replie

| = @ svs3 (local)

T Network Interfaces There are no items to show in this view.
3 Remote Access Logging
=B v
= General
E Static Routes
)
[ hew nterface... |

= E 1Py

View 3

Delete
Refrech
ExportList...

Properties

Help

[Lel | | E7] | ]

‘Add & new DHCP Relay Agent Interface ‘
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5. Select 12.0.0.1 Interface = click OK 2 and click OK.
|

This routing protocol runs on the interface that you select below.
Interfaces:
8211.002

e 12.0.0.1
E& Intemal

ok | cancal |

| = Routing and Remote Access =lElx
Fle Acton View Help

&% [ fFEIRE 0= HE

1 % is;\;e{':‘l:::;us Interface ~ Relay mode Requests received Replie
= Network Interfaces 12001 Enabled o o
-3 Remote Access Logging
= Pvs
E General
E static Routes
N DHCP Relay Agent]

2 1Pve

[« | 1| K7 | 1]
\ \ \

Right click on DHCP Relay Agent > Properties = Enter the IP Address of DHCP

Server (10.0.0.2)—>click Add = Apply and OK
21|

General |

(o] ]
Dynamic Host Corfiguration Protocal (DHCF) Global

The DHCP relay agent sends messages to the server addresses listed
below.

Server address:

. . . Add I
[oooz Bemove |

For more information

QK Cancel Apply
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Verification:

SYS4-CONFIGURATION

1. Log on as Administrator to DHCP Client (SYS4) and set the IP address to obtain
the IP address automatically.

Start 2 Run =Cmd 2 ipconfig /release.

Type ipconfig /renew.

An IP address will be assigned by DHCP server.

A

Check the IP Address by typing ipconfig /all.
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REMOTE ACCESS SERVICES (RAS)

Prerequisites:

Before working on this lab, you must have

1. A computer running windows 2008 server Domain Controller.

2. A computer running windows 2008 server with minimum 2 NIC car

3. A computer running windows 2008 server or windows 7.

SYS1 SYS2

MICROSOFT.COM
SYS1
Domain Controller / DNS Server
IP Address 10.0.0.2
Subnet Mask  255.0.0.0
Preferred DNS 10.0.0.2
SYS3
RAS Client (PPP Dial-in Interface)
IP Address ~ ----------
Subnet Mask =~ ----------

Preferred DNS = ----------
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RAS Server / VPN Server
IP Address 10.0.0.1
Subnet Mask  255.0.0.0

Preferred DNS 10.0.0.2




Lab — 1: Configuring MODEM on RAS Server and RAS Client
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SYS2 — CONFIGURATION

1.  Select Start = Settings = Control Panel

‘:

-

administra.. Recyde Bin

A

Computer

\'jj!

@ Default Programs

F Windows Update
-l

[ Programs

By Documents

p Search
@ Help and Support

T
'Tj Run...

'Windows Server 2008 Enterprice

[7start | o HE

E Shut Down...

RAS SERVER

SYS2

10.0.0.1
10.0.0.2
administrator

Host Name
IP Address

DNS Server
User Name

@ Network Connections
L Printers
il Taskbar and Start Menu

4wy s:53AM

2. A Control Panel wizard will appear =>Double click Phone and Modem.

B Control Panel

=181x]

}OO ~ Control Panel ~

v &Y [search 5]

File Edit View Tools Help

Control Panel Home
Classic View

Orstart| | 2 B

J ' [# control Panel

tame ~ || Category 1= — — =
- ™ - A of
| S / ( (]
Je W of \ e
Add Administr...  AutoPlay Color Date and Default Device
Hardware Tools Time 0g| Manager
1) 7= e 0 ‘ % .
= ) ==,
{ = = —
{ = —
@ ) h & ®
Ease of Folder Fonts Indexing Internet iSCSI Keyboard
Acce... Options Options Options Initiator
LA | \5
P 5P | )
Mouse  MNetwork and OfflineFiles Penand Personaliz.. [ZoREtal Power
Sharing Ce... Input... Modem Options
Options
e i =i ‘W Q =
4N F > = \
Printers Problem Programs Regional Scanners Sound Sync Center
Reports a... and Fea... and Lan... and Ca...
, % ) L
| = R W
System Tablet PC Taskbarand Textto User Windows Windows
Settings  Start Menu Speech Accounts Defender Firewall ll

& @y 5:55AM
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3. A Phone and Modem option wizard appears, go to MODEMS tab > click ADD.
|

Digling Rules  Modems |Advanced|

7  Thefolowing modems are installed

Modem I Atached To |

Remove Praperties I

ok || comcsl || e |

4. Select “Don’t detect my modem: | will select it from a list” =>click Next.

Install New Modem
Do you want Windows to detect your modem?

Windows will now try to detect your modem. Before
continuing, you should:

1. KFthe modem is attached to your
computer, make sure it is tumed on.

2. Quit any programs that may be using
the modem.

Click Mext when you are ready to continue.

¥ Dont detect my modem: | will select it from a list |

= Back et = Cancel |

5.  For Lab=> Select “Communication cable between two computers” > click Next.

Install New Modem

i~ Select the manufacturer and model of your modem. f your modem is not listed, or if you
Né have an installation disk, click Have Disk.

Manufacturer I

({Standard Modem Types)

b =l
¥ Cimmd = TAND emn B A e

[5F This driveris digitally signed. Have Disk... |

Tell me why driver signing is impartant

=

< Back et > Cancel |
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6. Select the COM1 port (Default) and click Next.

Install New Modem
Select the portis) you want to install the modem on.

You have selected the following modem:
(Communications cable between two computers

On which ports do you want to install it ?

Al ports
¥ Selected ports

= Back et = Cancel |

7. A modem installation complete wizard appears =>click Finish.

Install New Modem
Modem installation is finished!

Your modem has been set up successfully.

If you want to change these settings, double-click the
Phone and Modem Options icon in Cortrol Panel, click the
Modems tab, select this modem, and then click Properties.

< Back

Laricel |

Note: - Repeat the process of LAB1 on RAS Client (SYS3) also.
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Lab — 2: Configuring Remote Access Service

SYS2 — CONFIGURATION

1. Go to Start »>Programs - Administrative Tools = Routing & Remote Access.

LR

administra.. Recyde Bin

_Accessories "}, Terminal Services
: ¥ = Actve Directory Domains and Trusts
»
= ' Biceerillai= mﬂ Active Directory Sites and Services
i 1]
e . :Z"::;";ﬁm , I Active Directory Users and Computers

- Z ADSIEdit
. startup 3

. Component Services
& Internet Explorer

;g\ Computer Management

[[Z Windows Calendar =) Date Sources (O0EC)
Windows Contacts 2 s

i Windows Defender E_
=

Default Programs

£% Windows Live Messenger Download
3 Windows Media Player
Windows Photo Gallery
#el] ras - Shorteut

2] EventViewer

&, iSCST Initiator

3 Local Security Policy

(2] Memory Diagnostics Tool

@ Reliability and Performance Monitor
3 Security Configuration Wizard

S Server Manager

&, Services

31| Share and Storage Management
L Storage Explorer

System Configuration

() Task Scheduler

ﬂ Windows Firewall with Advanced Security
U Windows Server Backup

&> Network Policy Server

=
F1 Windows Update
il

ocuments

Settings

Search

Help and Support

| R

=

n...

2.  Right click on the server name ->Configure and Enable Routing and Remote

access.

é Routing and Remote Access

File Acton View Help
e Al |t JAENERN ? Mo

% Server Status
5752 (local); Cons .

Disable Routing and Remote Access

Routing and Remote Access Server

nd Remote Access, on the Action menu, click Configure a

All Tasks ¥ bn about setting up a Routing and Remote Access, deploy:
E Routing and Remote Access.

Miew 3

Delete
Refresh

Properties

Help
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3. Click Next.

Ro and Remote Access Server Setup Wizard

Welcome to the Routing and Remote
Access Server Setup Wizard

This wizard helps you set up your server so that you can
connect to other networks and allow connections from
remote clients.

To continue, click Next.

Cancel

4, Select Remote access.

Routing and Remote Access Server Setup Wizard

Configuration
You can enable any of the following combinations of services, or you can
customize this server.

% Hemote access {dial-up or VPN
Allow remate clients to connect to this server through either a dial-up connection ora
secure virtual private networle (VPN) Intemet connection.

" Network address translation (NAT)
Allow intemal clients to connect to the Intemet using one public |P address.

€ Virtual private network (VPN) access and NAT
Allow remote clients to connect to this server through the Intemet and local clients to
connect to the Intemet using a single public IP address.

" Secure connection between two private networks
Connect this network to a remote network, such as a branch office.

" Custom configuration
Select any combination of the features available in Routing and Remote Access.

For more information

=

< Back et = Cancel

5.  Select Dial-up and VPN - click Next.

Remote Access
You can set up this server to receive both dial-up and VPN connections.

[ VPN

A VPN server (also called a VPN gateway) can receive connections from
remote clients through the Intemet.

A dialup remote access server can receive connections directly from
remote clients through dial-up media, such as a modem.

Eor more information

< Back et = Cancel
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Select the Internet (Public) Interface i.e., 11.0.0.1 and remove the check box for
Enable Security > click Next

Select from a Specified range and click Next.

Routing and Remote Access Server Setup Wizard

IP Address Assignment
You can select the method for assigning IF addresses to remote clients.

How do you warit |P addresses to be assigned to remote clients?

" Atomatically

If you use @ DHCP server to assign addresses, confimn that it is configured property.
If you do not use a DHCP server, this server will generate the addresses.

% From a specified range of addresses

For more information

< Back

=

et Cancel I

Click New to specify the address range that this it will assign to the Remote

Clients &Specify the IP address range from: 10.0.0.10 to 10.0.0.100 - click OK.
21

Type a starting IP address and either an ending P address orthe number of
addresses in the range.

Start |F address:
End IP address:

Mumber of addresses:

Cancel

Click Next.

Address Range Assignment
You can specify the address ranges that this server will use to assign addresses to
remote clients.

Enter the address ranges (static pools) that you want to use. This server will assign all of
the addresses in the first range before continuing to the next.

Address ranges:

From | To | Mumber |
10.0.0.10 10.0.0.100 91
Mew... Edit... LDelete
< Back Cancel
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10. Select No, use Routing and Remote Access to authenticate 2> click Next.

Managing Multiple Remote Access Servers
Connection requests can be authenticated locally or forwarded to a Remote
Authertication Dial-ln User Service (RADIUS) server for authentication.

Although Routing and Remote Access can authenticate connection requests, large
networks that include multiple remote access servers often use a RADIUS server for
central authentication.

If you are using a RADIUS server on your netwaorle, you can set up this server to forward
authentication requests to the RADIUS server.

Do you want to set up this server to work with @ RADIUS server?

 No, use Routing and Remote Access to authenticate connection requests!

" Yes, set up this server to work with 3 RADIUS server

For more information

=

< Back et = Cancel

11. Click Finish.

Completing the Routing and Remote
Access Server Setup Wizard

“You have successfully configured this server as a remote
access server.

Summary:

RAS clients are assigned to the following network for -
addressing: 10.0.0.1.

Client connections are accepted and authenticated using:
remote access policies for this server.

A Connection request policy named Microsoft Routing andll

For more information about managing remote access servers,
see Routing and Remote Access Help.

To close this wizard, click Finish.

< Back Cancel

Starting Routing and Remote'#

Pleaze wait while the Routing and Remate Access

@ service on 5152 starts.
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Right click on Ports and select Properties

5 Routing and Remote Access

File Action View Help

R EE S

Server Status
= Sys2 (local)

=2

B Remote Access Clients

gin:

Routing and Remote Access Is Configured on This Serve

This server has already been configured using the Routing and Remote Acce
Wizard. To make changes to the current configuration, select an item in the ¢
then on the Action menu, click Properties.

For more information about setting up a Routing and Remocte Access, deploy
troubleshocting, see Bouting and Remote Access Help.

Select Communications cable between two computers and click Configure

Devices |
Routing and Remote Access (RRAS) uses the devices listed below.
Mame | Used By | Type | MNumb. .. I
Communications cable betwee... Mone Modem 1
WAN Miniport (PPPOE) Routing FPPoE 1
N Miniport (PPTF) None PPTP 5
M Miniport {L2TP) MNone L2TP 5
WAN Miniport (SSTF) None S5TF 5
For more information
oK Cancel Spply
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14. Select the Check box Remote access Connections - specify any phone number.
21|

You can use this device for remote access requests or demand-dial
connections.

¥ Bemote access connections inbound onfy)
[V Demand-dial routing connections {nbound and outbound)
I | Demand-dial rauting connections [authourd only]

Phone number for this device: el

“r'ou can set & mawimum port limit forn & device that supports multiple ports.

b B ports: I] _I;
For more information QK I Cancel

Lab - 3: Giving permission to user

SYS1 - CONFIGURATION

1.  On Domain Controller login as Administrator
2. Go to Active Directory Users and computers —>Select the user Ul or
Administrator >Right click <> Properties> Select Dial-in tab —>Select Allow

access 2 Apply 2> OK.
2l

Femotecontol | Terminal Sewvices Profle | COM«+
General | Addess | Account | Frofle | Telephones | Organization
Member Of Dialin Envionment | Sessions

- Remate Access Permission [Diakin or WPN)

* bl access

" Deny access

€ Cantiol aecess thouah Femote Aecess Policy

= ey CallerD: |—
i~ Callback Optiot:
&' Mo Callback

" Getby Caller (Routing and Remate Access Service only)

" Aluays Callback to
™| Assigr a Static [P Address ) ) )

| Apply Static Boutes

Define rautes to enable for this Diskin Static Fodtes .
cannection —

’TI Cancel | Apply |

137



Windows Server 2008 - Network Administration

Lab — 4: Establishing Dial-up connection from RAS Client

Note: Configure the Modem in RAS Client also as in RAS Server
SYS3 — CONFIGURATION
1. Logon to RAS Client (SYS3),Right click on Network icon > Properties.

Administrator ~ Recyde Bin

A

Computer

RAS CLIENT

Open
Explore

Map Metwork Drive...

Disconnect Metwork Drive. .. Host Nan]e - SYSS

Create Shortcut
( Delete
]

Explorer

Control Panel

[ostart| | 3 & | Egp Mk 413pM

2.  Select Set up a Connection or network

i8]

‘ OT\_) :‘: ~ Control Panel ~ Network and Sharing Center - m ISearch @‘
File Edit View Tools Help

Tasks @

Network and Sharing Center
‘iew computers and devices
' P i View full map
Connect to a network

| mt \
Setup a connection or netwark A ,I ot
- —_— e +
I

Manage network connections

SY53 mcse. com Internet
Diagnose and repair (This computer)
._.HE mcse.com {Domain network) Customize
Access Lacal only
Connections 11.0.0.2 View status
12.0.0.1 View status

2 sharing and Discovery

Metwork discovery @ Custom j
File sharing @ On j
Public folder sharing @ Off j
Printer sharing @ Off {no printers instaled) j
See also
Internet Optians Show me all the files and folders I am sharing

y Show me all the shared network folders on this computer
Windows Firewall
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3.  Select Connect to a workplace - click Next.

f"‘f"Set up a connection or network

U 1!}‘ Set up a connection or network

Windows Server 2008 - Network Administration

=101

Choose a connection option

Connect to the Internet

Set up a wireless, broadband, or dial-up connection to the Internet.

= Setup a dial-up connection
'aié Connect through a dial-up connection to the Internet.

jConnect to a workplace

[5et up a dial-up or VPN connection to your work)

lace]

cors |

4.  Select Connect Directly 2 click Next.

s Connect to a workplace

l"-:F' Connect te a workplace

o [ 3

How do you want to connect?

<) Use my Internet connection (VPN)
Connect using a virtual private network (VPN) connection through the Internet.

A @

< Dial directly
Connect directly to a phone number without going through the Internet.

A

What is a VPM connection?

Cancel |
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5.  Mention the Telephone Number (Server Phone Number) = click Next.

W< Connect to a workplace

Ay

Dial-up Connection

6. Mention the User or Administrator Credentials = click Connect.

W Connect to a workplace

<k

Microsoft\ Administrator
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7.  Wizard is dialing the connection to the mentioned phone number.

W< Connect to a workplace

8.  If the wizard cannot connect 2 click Set up the connection anyway.

W Connect to a workplace

<k
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9. Click Manage Network Connections.

=181x|

i - Control Panel -~ Network and Sharing Center - m ISEarch [Q]‘

File Edit View Tools Help
Tasks Network and Sharing Center
View computers and devices

View full map
Connect to a network

| A
Set up a connection or network i | ’
Ul | —_— N e +

Manage network connections

-
SY53 mcse. com Internet
Diagnose and repair (This computer)
._.i& mcse.com (Domain network) Customize
Access Local only
Connections 11.0.0.2 View status
12.0.0.1 View status

2} sharing and Discovery

Metwork discavery @ Custom j
File sharing @ On ﬂ
Public folder sharing @ Off j
Printer sharing © Off{no printers installed) j
See also
Internet Options Show me all the files and folders I am sharing

X Show me all the shared network folders on this computer
Windows Firewall

10. Right click on Dial-up Connection, = click Connect.

SEIE
‘@ |@ = Control Panel ~ Network Connections = m Search [g]‘

File Edit View Tools Advanced Help

Organize ¥ S Views w [ Startthis connection (=1 Rename this cornection g% Delete this connection » @
Iame | v| Status | v| Device Name | v| Connectivity |v| Network Category | v| Cwner | v| Type | v| Phone # or Host Address |v|
Dial-up (1) =

[Dial-up Connection

=

Set as Default Connection ;. 11.0.0.2

> Unidentified net
fERE L 57 Intel(R) PROJ10
Create Shortcut
Delete
Rename
Properties
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11. Mention the User or Administrator Credentials = click Dial.
x|

User name: |lv1icmsoﬂ"-_-'ldministmtor
Paseword: Iltlltttl
Domain: I

[~ Save this user name and password for the following users:

) We anly
@ ) fnyone whowses this computer

Dil: 220 =l
Dial I Cancel | Properties | Help |

12. Windows is dialing the connection = Client will be connected to RAS Server.

Connecting to Dial-up Connection...
&, Dialing 220...
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Lab — 5: Establishing VPN Connections

SYS3 — CONFIGURATION
1. Log on to RAS Client (SYS3), Right click on Network icon > Properties.

nu

Administrator ~ Recyde Bin

A

Computer

p RAS CLIENT

Explore

Map Metwork Drive. ..

Disconnect MNetwork Drive. .. HOSt Nan]e SYS3

Create Shortcut
?/ Delete
1

Explorer

Control Panel

[ostart| | 3 W&

2.  Select Set up a Connection or network

] (Gt @i wom

~i8lx

‘OT\_) Lt~ Control Panel = Network and Sharing Center - m ISearch @J‘
File Edit View Tools Help

Tasks @

Network and Sharing Center
iew t d devi
View computers and devices View full map
Connect to a network

. [ | m S,
Set up a connection or netwark 1 /| ot
= T Ny —R—
.

Manage network connections

5Y53 mcse.com Internet
Diagnose and repair (This computer)
._.?: mcse.com (Domain netwark) Customize
Arcess Local only
Connections 11.0.0.2 View status
12.0.0.1 View status
= Sharing and Discovery
Metwark discavery @ Custom ﬂ
File sharing @ on j
Public folder sharing @ off j
Printer sharing © Off(no printers installed) j
See also
Internet Options Shaow me &l the files and folders I am sharing

X Show me all the shared network folders on this computer
Windows Firewall
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3.  Connect to a workplace > click Next.

il

N .
k_) 1!}‘ Set up a connection or network

Choose a connection option

W Connect to the Internet
Set up a wireless, broadband, or dial-up connection to the Internet.

= Setup a dial-up connection
aqé Connect through a dial-up connection to the Internet.

jConnect to a workplace

[5et up a dial-up or VPN connection to your workplace;

cors |

4. Select No, Create a new connection click Next.
=10l x|

l"-:F' Connect te a workplace

Do you want to use a connection that you already have?

® Mg, create a new connectioni

 Yes, I'll choose an existing connection

Dial-up Connection

Communications cable between two computers]

=
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5.

6.

Select Use my Internet connection (VPN)->click Next.

W< Connect to a workplace

Select Use this Connection = click Next.

W Connect to a workplace

<k

1
Dizl-up Connecticn |—
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7.

8.

Mention the IP Address of VPN Server 2 click Next

W< Connect to a workplace

Ay

10.0.0.10]
YPM Connecticn

Mention the User or Administrator Credentials = click Connect.

W Connect to a workplace

<k

Microsoft\ Administrator
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9.  Wizard is dialing the connection to the VPN Server.

s Connect to a workplace =011
O T_E_F‘ Connect to a workplace

Connecting to VPN Connection...

A oY

Skip Cancel |

10. Connection is created successfully.

11. Go to Command prompt & type Ipconfig /all to view the IP Address of the Client
computer.

12. Now try to access the LAN Network.

13. Go to Start = Run = type \\LAN computer IP address\Drive$S or Share folder

name

Ex:\\10.0.0.2\c$
CITEE— x|

=== Typethe name of a program, felder, decument, or Internet
resource, and Windows will open it for you.

Open: I 1110,0.0.2\c8 j

@ This task will be created with administrative privileges.

0] 4 I Cancel Browse... |
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TERMINAL SERVICES (T S)

Prerequisites:

Before working on this lab, you must have

1.

2.

A computer running windows 2008 server or Domain Controller.

A computer running windows 2008 server or windows 7.

SYS1

SYS2

MICROSOFT.COM

SYS1

Domain Controller / Terminal Server
IP Address 10.0.0.1

Subnet Mask  255.0.0.0

Preferred DNS 10.0.0.1
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Member Server / Client
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Subnet Mask  255.0.0.0
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Lab — 1: Configuring Terminal Server in Remote Administration mode

SYS1 - CONFIGURATION

1.  Right click on Computer = Properties

LR

Administra.. Recyde Bin

Open
Explore

Manage Terminal Server
Map Network Drive. ..

) Disgonnect Network Drive. .. H SYS]-
Create Shortcut . 10_0_0_1
Delete

| . 10.0.0.1
: : Administrator

Internet
Explorer

@y

Control Panel

I‘stm“ ELrm® | « @0y 33BPM

Select Remote Settings.

=18

Owo l: ~ Control Panel ~ System

File Edit View Tools Help

Tasks View basic information about your computer
‘U Detice Managet Windows edition

¥ Remote settings Windows Server ® Enterprise
(@1 Advanced system settings Copyright © 2007 Microsoft Corporation. All rights reserved.

Service Pack 1

System
Processor: Intel(R) Celeron(R) CPU 2.66GHz 2.66 GHz
Memory (RAM): 1.00 GB
System type: 32-bit Operating System

Computer name, domain, and workgroup settings

Computer name: sysl ‘fj_j?change settings
Full computer name: sys1.microsoft.com

Computer description:

Domain: microsoft.com

Windows activation

See also ‘@ ?\, 46 day(s) to activate. Activate Windows now

Windows Update Product ID: 92516-083-1000042-76528 f@’change product key
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4. Check the box “Allow Connections from computers running any version”.
|

Computer Name | Hardwarel Advanced Remote I

1~ Remote Assistance

™| &llow Bemate Assistances connestions ba this computer

Advanced.

1~ Remote Desktop
Click an option, and then specify who can connect, if needed.
' Dont allow connections to this computer

" Alow connections from computers running any version of
Remote Desktop {less secure)

" Alow connections only from computers running Remate
Desktop with Network Level Authentication {more secure)

Help me choose Select Users
ok | cencel | ey |

5.  Click Apply 2 OK.
]

Computer Name | Hardware | Advanced Remote |

1~ Remote Assistance

™| Allow Bemete Assistance connections to this computer

Sdyanoed,

~Remote Desktop
Click an option, and then specify who can connect, f needed
" Dont allow connections to this computer

& Allow connections from computers running any version of
Remots Dasktop fess seours)

£~ Allow connections only from computers running Remote
Deskiop with Network Level Authentication {more securs)

Help me choose Select Users...
oK | cancd | ooy |

Go to Terminal Client (SYS2)

1.  Start 2 Program > Accessories > Remote Desktop Connection

(OR) Start 2Run = type MSTSC

Recyde Bin

Computer
Terminal Client

Host Name :  SYS2
IP Address : 10.0.0.2

: 10.0.0.1
 EascofAccess Jistrator

. Administrative Tooks . System Tools

. Cyberlink DVD Suite  *| [ Caleulator

. Extrasand Upgrades »|EH Command Prompt
. Maintenance *| | Notepad

. Microsoft Office

. Nero 7 Essentials

. Startup

. VideoLAN

& Internet Explorer =} wordPad
Windows Contacts
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Specify the IP Address 10.0.0.1 or computer name of terminal server —>click
Connect.

f; Remote Desktop Connection

r Remote Desktop

<_71 Connection
- - M

Computer: | =l
Username: MICROSOFT\Administrator

You will be asked for credentials when you connect.

Connect I Cancel I Help I Options >>I

Specify username as Administrator and type the password. > click OK

Windows Security

X
Enter your credentials
These credentials will be used to connect to 10.0.0.1.

‘“ 1| MICROSOFT\Administrator
| ﬂ |

|D' Use another account

[~ Remember my credentials

4.

The Administrator will connect to the Terminal Server Remotely.

.0.1 - Remote Desktop

m -icix

administrat
or

y

Computer

.
Bt 3!

T

Network

~

Internet
Explorer

Control
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Lab — 2: Configuring Terminal Server in Application Server Mode

1. Goto SYS1->Select Start >>Administrative Tools > Server Manager.

Administra.. Recycle Bin

. Terminal Services

. Compaonent Services
e— ;5‘ Computer Management
@ 8= Data Sources (0DBC)

Termina s
Host Nanle &, iSCSI Initiator

i Local Security Palicy

IP Address [2€] Memory Diagnostics Tool

@ Reliabiity and Performance Monitor

DNS Server i Security Configuration Wizard
E, Server Manager
User Name -

B Administrative Tools
| Extras and Upgrades

| LightScribe Direct Disc Labeing  » |(1) Task Scheduler

. Services
‘2| Share and Storage Management
= Storage Explorer

System Configuration

X

Documents

&

& Internet Explorer | Active Directory Users and Computers
Z ADsI Edit
£, DNS

5 Group Policy Management

B UL@0I¢

Shut Down, Windows Contacts

w
E e ¢ . Maintenance 3 ﬂ Windows Firewall with Advanced Security

E Search v| | Microsoft Office ¥ | Windows Server Backup

g . Nero @ »| €5 Internet Information Services (I15) Manager
. Help and Support . Remote Programs v| 52 Active Directory Domains and Trusts

é Aun... | Startup b |@F Active Directory Sites and Services

=

=u

P €amo |

2. In Server manager Console, Select Roles = Select Add roles.

-ioix]

File Acton View Help
o AN
& severmanager st [

7 Roles

il Features

2 m Diagnostics 3 ::gv::ltrléi health of the roles installed on your server and add or remove roles and

} Configuration .

Storage L
(~) Roles Summary Roles Summary Help

~I Roles: 3 of 16 installed

= Remove Roles
/i Active Directory Domain Services

/1. DNS Server

Web Server (IIS)
“ Active Directory Domain Services AD DS Help
Stores d y data and ication between users and domains, including

user logon processes, authentication, and directory searches.

a) Go to Active Directory Domain
~) Role Status I et

Messages: None

System Services: 9 Running, 1 Stopped

/. Events: 5 warnings, 38 informational in the
last 24 hours =l

¥ Last Refresh: 12/13/2008 4:40:37 PM _ Configure refresh
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3. In the Add roles wizard, select the check box for Terminal Services = click Next.

Add Roles Wizard

%E;E Select Server Roles

Before You Begin
Server Roles

Terminal Services
Role Services

Confirmation

Progress

Results

4. Click Next > Select the Check box for Terminal Server > Select Install Terminal

Select one or more roles to install on this server.
Roles:

[ Active Directory Certificate Services
Active Directory Domain Services (Installed)
[ Active Directory Federation Services
[] Active Directory Lightweight Directory Services
L] Active Directory Rights Management Services
] Application Server
[] DHCP Server
DNS Server (Installed)
[ Fax Server
[ File services
[ metwork Policy and Access Services
L] Print Services
Terminal Services
[l UDDI Services
Web S (IS) (Installed)
[[J windows Deployment Services

More about server roles

< Previous | Next =

Windows Server 2008 - Network Administration

Description:

Terminal Services provides
technologies that enable users
to access Windows-based
programs that are installed on a
terminal server or to access the
full Windows desktop. With
Terminal Services, users can
access a terminal server from
within your corporate network
or from the Internet.

Install | Cancel |

Server anyway (If prompted) =>click Next =>click Next.

Add Roles Wizard

ﬁé Select Role Services

Before You Begin

Server Roles

Terminal Services
Role Services

Application Compatibility
Authentication Method

Licensing Mode

User Groups
Confirmation
Progress

Results

Select the role services to install for Terminal Services:

Role services:

Terminal Server
OTs Licensing

] TS Session Broker
[ TS Gateway

[1] TS Web Access

More about role services

< Previous | Next = |

Description:

Terminal Server enables a
server to host Windows-based
programs or the full Windows
desktop. Users can connect to a
terminal server to run
programs, save files, and use
network resources on that
server.

Install Cancel
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5.  Select Do not require Network Level Authentication - click Next.

Add Roles Wizard ]

ESEE Specify Authentication Method for Terminal Server

Before You Begin Metwork Level Authentication is a news authentication method that enhances security by
providing user authentication earlier in the connection process when a client connects to a

Server Roles
Tl S terminal server. With Network Level Authentication, user authentication occurs before a full
Remote Desktep connection to the terminal server is established.
Role Services
Application Compatibili
LD L ty Specify whether Network Level Authentication is required.
Authentication Method
Licensing Mode " Require Network Level Authentication
User Groups Only computers that are running both a version of Windows and a version of the Remote
TP Desktep Connection client that supports Network Level Authentication can connect to this
terminal server. If you are remotely connected to this server, ensure that your computer
Progress supports Metwork Level Authentication to enable reconnection te this server.
Results

Do not require Network Level Authentication
Computers that are running any version of the Remote Desktop Connection client can
connect to this terminal server.

fﬁl This option is less secure than when Metwork Level Authentication is used because
=" user authentication occurs later in the connection process.

More about Network Level Authentication and supported dlients

< Previous | Install Cancel
. .
6. Select Configure later = click Next
Add Roles Wizard 3
ES:E Specify Licensing Mode
Before You Begin The Terminal Services licensing mode determines the type of Terminal Services client
Server Roles access licenses (TS CALs) that a license server will issue to dlients that connect to this

. . terminal server.
Terminal Services

Role Services Specify the Terminal Services licensing mode that you want this terminal server to use.
Application Compatibility

Authentication Method ' Configure later
Remind me to use the Terminal Services Configuration tool or Group Policy to configure

the licensing mode within the next 120 days.

Licensing Mode

User Groups
Confirmation ® e
Progress
A TS Per Device CAL must be available for each device that connects to this terminal
Results server.

" Per User

A TS Per User CAL must be available for each user that connects to this terminal server.

(i) The licensing mode that you specify must match the TS CALs that are available from
your Terminal Services license server.

< Previous | Next = | Tnstall Cancel

155




Windows Server 2008 - Network Administration

7.  Add the users who should access the Terminal Server (Can be added later). Leave

it Default = click Next = click Next =>click Install

Add Roles Wizard i x|

o
ﬁa Select User Groups Allowed Access To This Terminal Server

Before You Begin Add the users or user groups that can connect to this terminal server. These users and user groups will be
Cocver Riles added to the local Remote Desktop Users group. The Administrators group is added by default and cannot be
removed.
Terminal Services
Role Services Users or User Groups:
Application Compatibility _-Q_L_ Administrators
Authentication Method ‘?_; administrator (MICROSOFT \administrator)
Licensing Mode
Confirmation
Progress
Results

More about the Remote Desktop Users grou

< Previous | Next > l install | Cancel l

8.  Restart the server (If prompted) =>click close = Installation completed.

Resume Configuration Wizard 2

EE}' Installation Results

Resuming Cenfiguration

Frogress The following roles, role services, or features were installed successfully:

Results /1. 1 warning, 2 informational messages below

‘i\ Windows automatic updating is not enabled. To install the latest updates, use
" Windows Update in Control Panel to check for updates.
| Terminal Services @ Installation succeeded
The following role services were installed:
Terminal Server

(i) Manage processor and memory resources used by this terminal server with
WSRM.

(@ Enable Windows Vista features on this terminal sarver with Desktop Experience.

Print, e-mail, or save the installation report

< Previous Next > Cluse Cancel

Verification:

SYS1 - CONFIGURATION

1. Logon as Administrator go to Active Directory Users and Computers.

2.  Create Some User Accounts (Ex: Userl).
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SYS2 - CONFIGURATION

1. Goto Terminal Client = go to Run 2>MSTSC >click OK.

2. Specify the IP Address or computer name of terminal server 2 click Connect.
#% Remote Desktop Connection 1 =E) x|

Remote Desktop

<_7| Connection
-« =

Computer: | [TEONL |
Username: MICROSOFT\Administrator
You will be asked for credentials when you connect.

Comect | Cancel |  Hep | Options>s |

3. Specify username and type the password. =>click OK

Windows Security i x|

Enter your credentials
These credentials will be used to connect to 10.0.0.1.

|w‘ MICROSOFT\Administrator

| .‘ I userl @Microsoft.com ‘

[Sonennsd ]

Domain: Microsoft.com

[~ Remember my credentials

4. Message: The Connect was denied because the user accounts is not authorized.
x|

@ The connection was denied because the user account is not authorized for remote login.
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SYS1 - CONFIGURATION

5. To authorize the User: On Terminal Server >Right click on Computer icon

> Properties 2 Select Remote Settings > click Select Users
x|

'Computer Namel Hardware | Advanced Remote |

- Remote Assistance

™| &l B emote &ssistance connections to tis compter

Advanced... |

~ Remote Deskiop
Click an option, and then specify who can connect, if needed.
" Dont allow connections to this computer

* Allow connections from computers running any version of
Remote Deskiop ess secure)

¢ Allow connections only from computers running Remote:
Desktop with Metwork Level Authertication {more secure)

Help me choose Select Users... |

Cancel | Al |

6. Click Add =and Add the users = click OK.
2(x|

The users listed below can connect to this computer, and any members of
the Administrators group can connect even if they are not listed.

MICROSOFTN\USER1

MICROSOFT\administrator already has access.

Hemove

To create new user accounts or add users to other groups, go to Control
Panel and open User Accounts.

OK | Cancel

SYS2 - CONFIGURATION

7.  Go to Terminal Client 2 go to Run 2MSTSC —>click OK.

8.  Specify the IP Address or computer name of terminal server >click Connect.

9. Specify username and type the password. =>click OK

10. Error Message: To Logon to this computer you must be granted the allow logon

through Terminal Services right.
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SYS1 - CONFIGURATION

11. To Allow the User to Login to Terminal Server: Go to Terminal Server (SYS1) Go

to Start=> Program > Administrative Tools=> Group Policy Management

LR

administra.. Recydle Bin

. Terminal Services

. Component Services
= A Computer Management
5 Data Sources (ODBC)

Tel‘mina_ Event Viewer
o< nitiator
Host Name - P

S Local Security Policy

IP Address [a] Memory Diagnostics Taol

E. Group Policy Management

DNS Server @ Relabiity and Performance Monitor
b Security Configuration Wizard

User Name S

[
. Extras and Upgrades

Computer

" Windows Update

© Services

2] Share and Storage Management
b | Storage Explorer

v | system Configuration

. LightScribe Direct Disc Labeling

Settings 3

G . Maintenance b |(5) Task Scheduler

carch »| || Microsoft Office » | Windows Firewall with Advanced Security
. Nero8 b |{l Windows Server Backup

Help and Support » €5 Intemet Information Services (II5) Manager

»|Sa) Active Directory Domains and Trusts
[ Active Directory Sites and Services

. Remote Programs
. Startup

& Internet Explorer

Windows Contacts

j Bun...

| Active Directory Users and Computers
2 ADSI Edit

2 ons

Shut Down...

[start | @ Zo ME @ | (5] Terminal Server [Compat...

Windaws Server 2008 Enterprise

f« @G s

12. Expand Domains >Expand Domain name (Microsoft.com) >Expand Domain

Controllers=> Right click Default Domain Controllers Policy and Select Edit
=18 ]

.z, File Acton View Window Help ‘;Iﬁ.lﬁl

&9 |m=c|HE
(& Group Policy Management
= i Forest: microsoft.com
El [ Domains
B &3 microsoft.com
=2 Default Domain Pt
B [2] Domain Controller
5 Default Doma
& [ WMI Filters | Enforced
L5] Starter GPQ |, |ink Enabled

E Sttes Save Report...
§E¥ Group Policy Modeli

v, Group Policy Resulty  New Window from Here
€] st

Group Policy Management
Contents I

Name = I
¢\ Forest: microsoft.com

Delete
Rename
Refresh

Help

KT — |

|open the GPO editor
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13. In Computer Configuration Policies = Expand Policies 2 Expand Windows
Settings = Expand Security Settings > Select Local policies > Select User Rights

Assignment—> Right click Allow Log on Through Terminal Services-> Properties

-ioix
File Acton Vew Help
= [ 2[mXE = HE
_: Default Domain Controllers « | Policy | Policy Setting | O
= & Computer Configuratior Access Credential Manager as a truste... Not Defined
B[] Policies Access this computer from the network Pre-Windows 2000 Compatibl...
_| Software Setting Act as part of the operating system Not Defined
£l [} Windows Setting Add workstations to domain Authenticated Users
il Scripts (Start Adjust memory quotas for a process Administrators, NETWORK SER...
=N} %_ECI.II‘Ihf seth Allow log on locally Print Operators,Server Opera...
£ account | | e e
j Audit 1 Back up files and directories Server Operators,Backup Ope...
..=E| User R Bypass traverse chesklng Pre-Windows 2000 Corru;.latlhl...
j Securi Change the system time Server Operators,Administrat...
j Event Log Change the time zone Not Defined
4 Restrictec Create a pagefile Administrators
o System S Create a token object Not Defined
g Registry Create global objects Not Defined
g File Syste Create permanent shared objects Not Defined
[ Wired Net Create symbolic links Not Defined e
Windows | Debug programs Administrators
Network L Deny access to this computer from th.. Not Defined
{ Wireless P Deny log on as a batch job Not Defined
Public Key Deny log on as a service Not Defined
| Software Deny log on locally Not Defined
= Network.ﬁ Deny log on through Terminal Services  Not Defined
Ji .‘%Iif;-sheac:er::lt_ Enable computer and user accounts to... Administrators
- . . Force shutdown from a remote system Server Operators, Administrat...
_| Administrative T
Preferences = Generate security audits NETWORK SERVICE,LOCAL SER...
-~ -- Impersonate a client after authentica... HNot Defined
_bl_l Tnreazaca 2 nenrace wnelrinn cab Mt Nafinad LI

14. Click Add User or Group—>Add the appropriate user 20K

Allow log on through Terminal Services Propertie: 21x]
Security Policy Setting | Explain I
:4%' Allow log on through Teminal Services
=1
¥ Define these policy settings:
Add User or Group... I Bemowe
.. This setting is not compatible with computers running Windows
2000 Service Pack 1 or earier. Apply Group Policy objects
containing this setting onhy to computers running a later version of
the operating system.
ok | camcel | zopy |

15. Click Start=> Run—> type GPUPDATE
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SYS2 - CONFIGURATION

16. Go to Terminal Client = go to Run 2>MSTSC > click OK.
17. Specify the IP Address or computer name of terminal server 2 click Connect.

18. Specify username and type the password. >click OK

Windows Security 3 x|

Enter your credentials
These credentials will be used to connect to 10.0.0.1.

w' MICROSOFT\Administrator

‘ I userl @Micresoft.com I

[eosesees] |

|
=== Domain: Microsoft.com

I~ Remember my credentials

19. Now the user can also logon to Terminal server

#-410.0.0.1 - Remote Desktop

userl

iy

Computer

Network

Internet
Explorer

2

Control
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Lab — 3: Monitoring Terminal Services Sessions

Level of Controls: View the Session and Interact with the Session.

1. On Terminal Server Start =>Programs =2Administrative Tools =>Terminal

Services > Terminal Services Configuration.

LR

Administra.. Recyde Bin

Qa Remate Desktops

. Terminal Services
P N 3
Terminal vices Configuration

&

&

Component Services

Computer Management
Data Sources (ODBC)
Event Viewer
iSCSI Initiator

HOSt Nanle Local Security Policy
IP Address Memory Diagnostics Tool

Group Palicy Management

Network DNS Server Reliability and Performance Monitor

User Nan‘le Security Configuration Wizard

:

B Administrative Tools
. Extras and Upgrades
. LightSeribe Direct Disc Labeling  »
. Maintenance ]
. Microsoft Office
. MNerog 3

Server Manager

; Services

* Share and Storage Management

Documents Starage Explorer

System Configuration
Task Scheduler

‘Windows Firewall with Advanced Security

Settings

Search

Windows Server Backup

Help and Support Internet Information Services (I15) Manager

Remote Programs 3
. Startup
@ Internet Explarer

Windows Contacts

&3 Active Directory Domains and Trusts

Run...

EE Active Directory Sites and Services

: Active Directory Users and Computers
Z' ADSIEdit

£ bns

Shut Down...

File  Acktion Wiew Help

@ = m

@ Terminal Services Configuration: Actions

ﬂ Licensing Diagnosis

|+

Configuration for terminal server:
SyS] Terminal Services C... ~
. . . . . . K | G Create Mew Con...

“ou can use Terminal Services Configuration to configure settings for new connections, modi
and delete connectionz. You can corfigure settings on a per-connection basis, or for the terr Refresh

3‘3 Connect to Term...
Connections

Wigt »
Cai
Help
Connection Name: ... =

[ eroperties | . .
B Disable Connection

Renarne Connec...

w Delete

Edit setings Help
General
%] Delete termporary folders on evit Yes
%5 Use temporary folders per session Yes
7 . . .
15 Restrict sach user to a single session Yes
o
15 User logon mode Allow all connections
Licensing
|| License server discovery mode Automatic
.ﬁ. Terminal Services licensing mode Mot yet configured =
< | mis | »
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3. Select Remote Control Tab > Select Use remote control with the following
settings = Check the box Requires User’s Permission=> In level of Control Select

View the session 2> click Apply > click OK.

ﬂ
General I Log on Settings I Sessions | Environment I

Remote Control I Client Settings | Network Adapter | Security

You can use remote control to remotely control orto view a user's
session

" Usa remots control with default user settings
¢ Do net allow remate control

% s remote control with the following settings:

7 Bequire user's permission

Level of control
’7 % iew ths session

£” Interact with the session

oK | Cancel | Aoply

4. To monitor user Session Log in as an Administrator on Terminal Server using
Remote Desktop Connection.

5. Note:- By default Administrator cannot access the remote desktop of Terminal
server from Terminal Server itself. To allow Administrator

6. Go to Start = Programs=> Administrative Tools =>Terminal Services > Terminal
Services Configuration

7.  Right click Restrict each user to single session 2> properties

%% Terminal Services Configuration 181 x|

File  Action View Help

&= =

@ Terminal Services Configuration: | and delete cornections. You can corfigure settings on a per-connection basis, orforthe termi:l Actions
8 Licensing Diagnosis

Terminal Services C... «

Connections @m Create New Con...
Connection Name | Connection Type | Transport | Encryption | Com E-l Aefech
&S RDP-Tep Wicrosoft RDP 6.1 tep Cliert Compatible — =
fb Connect to Term. ..
View 4
E Help
Connection Name: -
Edit settings H teb
General
|#=| Delete temporary folders on exit Yes
=) Use temporany folders per ssssion ‘e

Restrict each user to a single session
=] User logon mode

Licensing
|#=] License server discovery mode Automatic
=] Terminal Services licensing mode Mot yet corfigured

TS Session Broker

|#=] Member of famm in TS Session Broker No
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8.  Uncheck the box Restrict each user to a single session 2> click Apply = click OK.
x|

General | Licensing I TS Session Broker I

These settings affect the performance of this terminal server.
For best results, select all check boxes.

v Delete temporary folders on exit
v Lse temporary folders per session

- Blestrict each userto a single session

— User logon mode

& Alow all connections

" Mlow reconnections, but prevent new logons

Allow reconnections, but prevent new logons urtil the
server is restarted.

ok | cancel |[ Zony

9. To monitor user Session Log in as an Administrator on Terminal Server using

Remote Desktop Connection

#% Remote Desktop Connection

r Remote Desktop

4_"] Connection
- — o

Computer: | TONONN =l
Username: MICROSOFT\Administrator
You will be asked for credentials when you connect.

Connect I Cancel I Help | Options >>|

10. Mention the Administrator Credentials = click OK.

Windows Security i x|

Enter your credentials
These credentials will be used to connect to 10.0.0.1.

CE

MICROSOFT\Administrator

[ asmanass ]

Use another account

[~ Remember my credentials

oK I Cancel
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11.

12.
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To _monitor_the Users: now go to Start (From remote Desktop) —=>Programs

->Administrative Tools = Terminal Services > Terminal Services Manager.

N U

Administra.. Recycle Bin

Terminal Services

@ Remote Deskkops

qﬁ’é Terminal Services Configuration Component Services

®_ Terminal 5

Terminal
Host Name
IP Address
Network DNS Server

r _ . Accessories 3
e | e )

B Administrative Tools

Computer Management
Data Sources {ODBC)
Event Viewer

iSCSI Initiator

Local Security Palicy
Memory Diagnostics Tool
=i Group Policy Management
Reliahility and Performance Monitor

Security Configuration Wizard

Server Manager

Services

Share and Storage Management

Documents ¥| | Extras and Upgrades Storage Explorer
. LightScribe Direct Disc Labeling System Configuration

Settings
. Maintenance Task Scheduler

Search »| |, Microsoft Office ‘Windows Firewall with Advanced Security
. Nerod Windows Server Backup

Help and Support

. Remote Programs Internet Information Services (IIS) Manager
. Startup
g Internet Explorer

=] Windows Contacts

Active Directory Domains and Trusts
Run...

Active Directory Sites and Services

Active Directory Users and Computers
ADSI Edit
DMS

Shut Down...

Tstart | @ h W © |

Windows Server 2008 Enterprise
B @R

e b LU B €15 & B O HI 6 0 b b @ B ol - &£ 1 Bl R =

>
7
-

« @0}y 5:46PM

Right click the User session = Select Remote Control

g _ O x
Fil=  Action Yiew Help
e MU 5l
m=n Terminal Services Manager Actions

= n - i :
o WIN-ESMQ4TKHIRE 2 Manage Terminal Server Group: My Group My Group N
= wie My Group -
e 5151 #Add Computer
Users |Sessions| F‘rocessesl Emply Graup
Server | Lzer | Session | D | State | IdleTime | LogOnTir Refresh
ag 5v51  administ.. Console 1 Active 12414720

Conneck

uger] RDP-Tc.
F5¢51 administ.. RDP-Tc.

2l
1214720

Connect
Disconnect
Send Message

Remote Control
Disconnect

Reset
Reset
Status

Lag CFf

Send Message

Status

Lag Off

View 3
Delete

Rename

HiX wralkes0ea

Help
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13. Select the hot keys 20K

Remote Control K E

Hat key

To end a remate contral session. press this Iw vl

ke, plug the keys zelected below:

[~ Shift ¥ Cl [~ Al

ak I Cancel | Help |

14. Now Administrator is connected to user’s session.

#%10.0.0.1 - Remote Desktop

iy

Computer

£
Network

Internet
Explorer

Control
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Lab - 4: Installing Terminal Services Web Access

SYS1 - CONFIGURATION

1. Go to SYS1 ->Select Start Programs =»Administrative Tools > Server Manager.

LR

Administra.. Recycle Bin

. Terminal Services
. Compaonent Services

g A Computer Management
@ . } =] Data Sources (ODBC)
Termlna Event Viewer

HOSt Nanle &, iSCSI Initiator

IP Address

DNS Server

35 Local Security Policy
(€] Memory Diagnostics Toal

@ Reliability and Performance Monitor
fé Security Configuration Wizard

E.

Server Manager

i Services

'] Share and Storage Management

B Administrative Tools L Storage Explorer
Documents . Extras and Upgrades System Configuration
Settings | LightScribe Direct Disc Labeling  #|(1) Task Scheduler
- . Maintenance ﬂ ‘Windows Firewall with Advanced Security
Search | Microsoft Office W Windows Server Backup

. Nerod WY Internet Information Services (IIS) Manager
Help and support . Remote Programs 5 Active Directory Domains and Trusts
3 Run... | Startup [ Active Directory Sites and Services
- & Internet Explorer ] Active Directory Users and Computers
E Shut Down... Windows Contacts Z' ADSI Edit

£, DNs
_% Group Policy Management

2.  In Server manager Console, Select Roles = Select Terminal Services =>click Add

role services.

Il

File Action View Help
e 2|

> Roles
il Features
= Diagnostics View the health of the roles installed on your server and add or remove roles and
Lo " features.
! Configuration
(23 storage Messages: None |

System Services: All Running
@) Events: 1 informational in the last 24 hours

~) Role Services: 1 installed ‘Hole Services|

I & Remove Role Services

Role Service | status

L, TerminalServer Installed
TS Licensing Not installed
TS Session Broker MNot installed J
TS Gateway Not installed

TS Web Access Hot installed

Description:

Terminal Server enables a server to host Windows-
based programs or the full Windows desktop. Users
can connect to a terminal server to run programs,
save files, and use network resources on that server.

~| Web Server (IIS) ‘Web Server (IIS) Help

£ Last Refresh: 12/13/2008 6:57:21 PH  Configure refresh
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3.  Select the check box for TS Web Access > click Next 2 click Next.
3

O .
%.m Select Role Services
Select the role services to install for Terminal Services:

Web Server (IIS) Role services:

Description:
Role Services
Terminal S (Installed) TS Web Access provides access
Confirmation O Ts L to terminal servers through a
\censing Web browser.
Progress [ Ts sSession Broker
Results ] TS Gateway

TS Web Access

More about role services

< Previous

Install | Cancel

4. Click Next =>click Next = click Install = click Close.

»
i Confirm Installation Selections
Fole Services Il the foll | | e lick I
To install the following roles, role services, or features, click Install.
‘Web Server (TIS) 9
Rale Services (i) 2 informational messages below
=
i) This server might need to be restarted after the installation completes.
Progress
Results ~| Terminal Services
TS Web Access
Default TS VWeb Access site:  http://sys1/ts
A Web Server (TIS)
(i) Find out more about Windows System Resource Manager [WSRM) and hows it
can help optimize CPU usage
Web Server
Common HTTF Features
Static Content
Default Document
Directory Browesing
HTTP Errors
HTTP Redirection
Application Development =l

Print, e-mail, or save this information

< Previous [Vext Install Cancel |
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Lab — 5: Configuring Terminal Services RemoteApp Programs

SYS1 - CONFIGURATION

1.

Select Start =>Programs =>Administrative Tools =>Terminal Services

RemoteApp Manager.

v

-
administra._.

Recydle Bin

Computer

Q] Remote Desktops

%3 T5RemoteApp Manager

1L erd)
Host Name
IP Address
DNS Server

User Name
:

Windows Update

rograms
[

Documents Extras and Upgrades

. LightScribe Direct Disc Labeling

Settings
. Maintenance

Microsoft Office
Nero &

Search

Help and Support . Remote Programs
. Startup

& Internet Explarer

Windows Contacts

File Action View Help

Gf§ Terminal Services Configuration

‘45, Terminal Services Manager

Component Services
Computer Management
Data Sources (ODBC)
Event Viewer
iSCSI Initiator
Local Security Policy
Memary Diagnostics Toal
Group Policy Management.
Reliability and Performance Monitor
Security Configuration Wizard
Server Manager

i Services

| Share and Storage Management
Storage Explorer
System Configurstion
Task Scheduler
Windows Firewall with Advanced Security
Windows Server Backup

S Internet Information Services {I15) Manager
Active Directory Domains and Trusts
Active Directory Sites and Services
Active Directory Users and Computers
ADSI Edit
DNS

'S RemoteApp Manager

[« @ roiem
In the left pane Actions = click Add RemoteApp Programs.

=1olx|

== |

Terminal Server Settings Change

(i) Clients will connect to: sysl.Zoom.com

/" Users can only start listed RemoteApp programs on
initizl connection. (Recommencled)

TS Gateway Settings Change

@ Clients will use T5 Gateway settings defined by
their domain's Group Policy.

Digital Signature Settings Change

i\ Mo digital certificate iz configured. (Using a digital

certificate may improve security.)
RDP Settings Change
(i) Clients will not use any custom RDP settings.

Distribution with TS Web Access
A\ The TS Web Access Computers group is empty.

PP pregrams may be unavailable to user

Refresh | Learn mere

&3 The RemoteApp Programs list is empty.

(i) Aremote desktop cannection for this server is no
visible in TS Wek Access, Change

'@ More about using TS Wel Access

Other Distribution Options

Select a Remotepp program and choose an option
below.

Create .rdp File

Create Windows Installer Package

'@ More about distribution options

RemoteApp Programs

Name [ Path

[ 75 Web Acce... | Arguments [

=l

Actions
TS RemoteApp Man... +

=
a
a
a
‘ﬁ

Connect to Com. ..
Add RemoteApp. ..
Terminal Server ...
TS Gateway Set...
Digital Signature. .
Export RemoteA. ..
Import RemoteA. ..
View r

Help

2> TS
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3.  Click Next.

RemoteApp Wizard ﬂ

Welcome to the RemoteApp
Wizard

This wizard helps you add programs to the RemoteApp
Programs list on this teminal server. After programs are
on the list, you can display them in TS Web Access, or
package them for distribution.

Before you run this wizard, ensure that:

-ou are logged on as the administrator for the server
that will host the RemateApp programs.
- The host server is running &t least Windows Server

2008

To continue, click MNext.

< Back Cancel |

4.  Select the Programs that you want to add and click Next.
x|

Choose programs to add to the RemoteApp Programs list
Select the programs that you wart to add to the RemoteApp Programs list. You
can also configure individual RemoteApp properties, such as the icon to display.

Mame | -
% Calculator
(& Data Sources (ODBC)
(& Disk Defragmenter
55 Getting Started ||
D'ﬁ Intemet Information Services (IIS) Manager

iSCSI Initiator

] g Light Scribe Control Panel
= Memory Diagnostics Tool
(] [@ Microsoft Clip Organizer
(1¥= Microsoft Office Access 2007
I Microsoft Office Diagnostics
) (%5 licrosch Office Excal 2007
(& Microsoft Office Groove 2
& Microsoft Offics InfoPath 2007

Select All Select Mone Properties.. Browse... |

< Back Cancel |
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5.  Click Finish.
=

Review Settings
Review the settings that you have chasen You can go back to change these
settings or click Finish to complete this wizard.

Adding 2 programs _I
Program list

Calculator

L LSYSTEMDRIVI Vindows'System
RemoteApp program is available through TS
Allow commanddine arguments: Mo

calc.exe
Web Access: Yes

Microsoft Office Excel 2007
Path: %5YSTEMDRIVE®% \Program Files"Microsoft Office \OFFICE12\EXCEL.EXE
RemoteApp program is avalable through TS Web Access: Yes
Allow commanddine arguments: Mo

-
< I B

< Back

Cancsl |

6. Verify that RemoteApp programs are added at the last of the window.

%2 15 RemoteApp Manager =1ol x|
File Action View Help

&= |5 i

Distribution with TS Web A Elfpctors
Terminal Server Settings Change istribution witl eb Access

The TS Wek Access Computers group is empty. e
(@) Clients will connect te RemoteApp programs may be unavailable to user | §3 Connect to Com...
./ Users can only start listed RemoteApp pragrams on Refresh | Learn more

initial connection. (Recommencded)

Zoom.com

Al Remotelpp programs are visible in TS Web (] Add RemoteApp. .

TS Gateway Settings Change Access. B Terminal Server ...
(i) Clients will use TS Gateway settings defined by @ a remote desktop connection for this server is Bl TS Gatenay Set

their domain's Group Policy. visible in TS Web Access. Change Way Set..

I . Bl Digital Signature...

Digital Signature Settings Change ® More about using TS Web Access
A\ No digital certificate is configured, (Using = digital # ExportRemoted...

certificate may improve security.) Other Distribution Options ) # Import Remotea...
RDP Settings Change Select 2 RemeteApp program and choose an option

below, View 3

(i) Clients will not use any custom RDP settings. Creste rdp File e

Create Windows Installer Package
@ More about distribution opticns

RemoteApp Programs

Mame Path TS Web Acce.., | Arguments
i calculator CAWindows\System32\calc.exe Yes Disabled
\¥f| Microsoft Office Excel 2007 C\Program Files\Micrasoft O.. Ves Disabled
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Accessing the Terminal Server from the Client systems

SYS2 — CONFIGURATION

1.

2.

Go to any Computer = Open Internet Explorer and type

Http://Terminal server ip address/ts and Press Enter

Ex: http://10.0.0.1/ts

Z?' nternet Explorer Enhanced Security Configuration is enabled - Windows Internet Explorer
P—

e - |E] hepiio.0.0.1 ] =l ||| x| |uive search

'?_2? ol J& Internet Explorer Enhanced Security Configuration is ... | | T’} h Eﬂ T ,'_,?\"Pagﬁ

Internet Explorer Enhanced Security Configuration is enabled

Internet Explorer Enhanced Security Configuration is currently enabled on your server. This ¢
a number of security settings that define how users browse Internet and intranet Web sites. T
configuration also reduces the exposure of your server to Web sites that might pose a securit
a complete list of the security settings in this configuration, see Effects of Internet Explorer Er
Security Confiquration,

This enhanced level of security can prevent Web sites from displaying correctly in Internet Ex
restrict access to network resources, such as files an Universal Maming Convention (UMC) she
you want to browse a Web site that requires Internet Explorer functionality that has been disa
can add the Web site to the inclusion lists in the Local intranet or Trusted sites zones, For mor
inforrnation, see Managing Internet Explorer Enhanced Security Confiquration,

)

g

Mention the user name and password =>click OK

21|
=,
R

A

Connecting to 10.0.0.1.

User name: IE user 1@microsoft.com :j ,|

Password: [eesssese

[~ Remember my password

OK I Cancel
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TS Web access Website will be displayed.

Click on the Application which u want to access (Ex: Calculator).

/2 TS Web Access - Windows Internet Explorer
@T\-—_} - |g, http://10.0.0.1/ts/en-US/Default.aspx

"Lr:? ﬁ'ﬂ? @ TS Web Access |

j LA 4 ILive Search

| B2

Remotefpp Programs

Calculator

Remote Desktop

Microsoft
Office Excel
2007

6. Click Connect> Mention the user credentials=> click OK.
Windows Security x|

Enter your credentials
These credentials will be used to connect to 10.0.0.1.

[ él“ MICROSOFT\Administrator

"- A‘ I userl @Microsoft.com ‘

I ........l ‘
— Domain: Microsoft.com
[” Remember my credentials
OK I Cancel I
7.

RemoteApp program will be starting.

ﬁ(nnned:ing to sysl.Zoom.com

=10l

RemoteApp

Starting...

Calculator

{ " Details = Y Cancel
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8. RemoteApp program will start.

B calculator =] 3
Edit View Help
| 0.

I— Backspace CE | & |
s S]] ]
o Sl
s
] ST
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WINDOWS DEPLOYMENT SERVICES (WDS)
Prerequisites:
Before working on this lab, you must have

1. A computer running windows 2008 server Domain Controller, DHCP with Scope,

DNS with Services records.

2. A computer with or without any Operating system.

SYSs1 SYS2

MICROSOFT.COM

SYs1 SYS2

Domain Controller / WDS Server WDS Client

IP Address 10.0.0.1 IP Address --——--—--
Subnet Mask  255.0.0.0 Subnet Mask ~ ----------
Preferred DNS 10.0.0.1 Preferred DNS  ----------
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Lab — 1: Installing Windows Deployment Services

SYS1 - CONFIGURATION

1.  Select Start >Programs=> Administrative Tools=> Server Manager

LR

Administra.. Recyde Bin

| Terminal Services
b =2 Active Directory Domains and Trusts
[k Active Directory Sites and Services

Computes Domain C ] Active Directory Users and Computers
Host Nam s

& Component Services

IP Address Computer Management

= Data Sources (ODBC)

DNS Servel e

Event Viewer

Group Palicy Management
ISCSI Initiator

| . Accessori

B Administrative Tools
. Extras and Upgrades Memary Diagnostics Tool

Reliability and Performance Monitor

Microsoft Office Security Configuration Wizard

Startup

& Internet Explorer

Windows Contacts

Local Security Policy

| Msintenance

%

Services IGet an overview of the status of this server, perform top
Imanagement tasks, and add or remove server roles and
[features.

Help and Support. Share and Storage Management

Storage Explorer

2 System Configuration
(5) Task Scheduler

ﬂ Windows Firewall with Advanced Security
U windows Server Backup

15 Run...

E Shut Down...

'Windows Server 2008 Enterprice

Wy 1143 AM

2. Inthe Server Manager Select Roles and Select Add Roles.
i x|

Fle Action View Help
o A= ol

)
& Features
s View the health of the roles installed on your server and add or remove roles and

= Diagnostics features.
£ift Configuration
[ Storage

~) Roles Summary Roles Summary Help

~) Roles: 2 of 16 installed 2 Add Roles

5 Remove Roles
/i Active Directory Domain Services

% DNS Server

~| Active Directory Domain Services AD DS Help

Stores directory data and manages communication between users and domains, including
user logon processes, authentication, and directory searches.

Go to Active Directory Domain

#) Role Status e

Messages: None
System Services: 9 Running, 1 Stopped

/L. Events: 8 warnings, 59 informational in the
last 24 hours

£} Last Refresh: 12/13/2008 11:43:32 AM  Configure refresh
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3. In the Select Server Roles Wizard check the box Windows Deployment Services

and click Next=> Next.

H Add Roles Wizard x|
ﬁ:é Select Server Roles
Before You Begin Select one or mare roles to install on this server.
Server Roles Roles: Description:
WDS T Ac y windows Deployment Services
provides a simplified, secure means of
Role Services rapidly andremotely deploying
S [ a W Windows operating systems to
[[] Active Directory Lightweight Directory Services computers over the network.
Progress [] Active Directory Rights Management Services
Results [] application Server
[[] DHCP Server
[ Fax Server
[ File services

[ Metwork Policy and Access Services
[ print Services

[ Terminal Services

[ upDI Services

[ vieb server (11S)

Windows Deployment Services

More about server roles

<revious | weal | cancel |

4.  Check the box Deployment Server and Transport Server, click Next.

Roles Wizard x|
ﬁ; Select Role Services
Before You Begin Select the role services to install for Windows Deployment Services:
Server Roles Role services: Description:

Deplovment Server provides the full
Deployment Server Functionality ofWindows Deployment
Services, which you can use to
configure and remately install

Transport Server

Confirmation ‘Windows operating systems. With

Progress Windows Deployment Services, you
can create and customize images and

Results then use them to reimage computers.

Deployment Serveris dependent on
the core parts of Transport Server.

More about role services

< Previous | Next > I Install Cancel

177



Windows Server 2008 - Network Administration

5.  Click Install >click Close.

hdd Roles Wizard x|

%E}:’ Installation Results

Before You Begin

The faollowing roles, role services, or features were installed successfully:
Server Roles
/¥ 1warning message below

WDs
Role Services "a_w Windows automatic updating is not enabled. To install the latest updates, use Windows Update in
£’ Control Panel to check for updates.
Confirmation

~ @
Prges Windows Deployment Services (@ Installation succeeded

The following role services were installed:
Deployment Server

Transport Server

Print, e-mail, or save the installation report

Note: SYS1 — CONFIGURATION

Install the DHCP Service (If not installed) and create a scope in the DHCP.

Give the range (10.0.0.10 — 10.0.0.100), and in the DHCP scope options mention
the Domain name (Microsoft.com) and mention the DNS server IP address

(10.0.0.1).
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Lab — 2: Configuring Windows Deployment Services

SYS1 - CONFIGURATION

1. Select Start = Programs => Administrative Tool =>Windows Deployment

Services.

8 C

Administra.. Recydle Bin

. Terminal Services
5 Active Directory Domains and Trusts
g [ Active Directory Sites and Services
e | Active Directory Users and Computers

Domain 2‘ ADSI Edit
HOSt Nanl( jd, Component Services

‘g Computer Management
1P Address Data Sources {ODEC)
2 s
DNS SE]'VE] Event Viewsr

_% Group Policy Management

User Nan]E SCST Initiator
3 Local security Policy

O N (| Memary Disgnostics Taol
. Extras and Upgrades b |88 Relisbility and Performance Monitor
. Maintenance v |3y Security Configuration Wizard
. Microsoft Office »| Sk Server Manager
| Startup »| ) Serviees
& Internet Explorer 1 Share and Storage Management
Windows Contacts 3% Storage Explorer
=) system Configuration
() Task Scheduler [Use this snap-in to manage Windows Deployment Services.

ﬂ Windows Firewall with Adwanced¥Vindows Deployment Services is used to deploy the Windows
- operating system to network attached computers.
C¥ Windows Deployment Services

J Y Windows Server Backup | w1148 AM

' Windows Update

2. Right click Server Name Select Configure Server.

File Acton View Help

€= 7mlcH6E

":« Windows Deployment Services

B 8 Servers ..f Windows Deployment Server not yet configured
5 sys L.microsoft.com N oy 4 '9

Configure Server

The Specified Windows Deployment Server needs to be configured for first use.
Remove Server

View To configure the Windows Deployment Server, select the Server node and on the Action menu, click
e Configure Server.

Refresh

Help

|Configures this server for the first use.
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3. Click Next.

I;_! Windows Deployment Services Configuration Wizard 5[
| Welcome Page r-‘E‘

You can use this wizard to configure Windows Deployment Services. After complsting
configuration you may optionally add images to the server or choose to add images
later.

To successfully install and use Windows Deployment Services. you will
need:

— This computer to be a member of Active Directory Domain Services
- An active DHCP server on your network
— An active DNS server on your networkc

- An NTFS partition on the Windows Deployment Server for storing images

< Back Cancel |

4. Browse and select any empty drive to store Image Folder (or) change the Drive

letter click Next.

I'_"S Windows Deployment Services Configuration Wizard 1'
Remcte Installation Folder Location W‘
o=
d &
g

The remate installation folder structure will contain the operating system images to be
deployed from this server. Choose an NTFS partition with enough available space for al
anticipated images.

Enter the path and folder name for the remote installation folder.
Path:

E:\Remotelnstall Browse... |

< Back Cancel |

Note: If the WDS server is a DHCP server also then one more wizard will be
displayed indicating that the WDS service should not listen on port 67.
So, we have to check the boxes, Do not listen on port 67 and Configure DHCP

option tag 60 in all DHCP scope options to PXE Client.
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5. Select Respond to all Known and Unknown Client Computers, and click Next.

[¥ Windows Deployment Services Configuration Wizard x|

PXE Server Initial Settings m‘
= p

o

Pre-boot execution environment {PXE) client computers may be pre-staged in Active
Directory Domain Services. When a client computer is pre-staged. it is also called a
kniown cliert. Clients which are not pre-staged are called unknown. Use this page to
select which client type the Windows Deployment Services server responds to, and
what action is taken when the senver responds to a known or unknown client computer.

Choose the appropriate answer policy below:
" Do not respond to any client computer
¢~ Respond only to known client computers

* Respond to all (known and unknown) client computers
™ For unknown clierts, notify administrator and respond after approval.

To configure the Windows Deployment Services server, click Finish.

More information about PXE server settings

< Back Cancel

6.  Wizard will Configure the WDS Server

I;‘__l Windows Deployment Services Configuration Wizard 1[

Configuration Progress w‘

Configuring Windows Deployment Services...

Starting Windows Deployment Services

|

< Back Eiriizhy
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Uncheck the box Add Images to Windows Deployment Server now, and click

Finish.
[ 2 windows Deployment services Configuration wizard x|
Configuration Complete -4

Congratulations! The wizard has successfully configured Windows Deployment
Services on your computer.

To be able to run the Windows Deployment Services, you will need to add imageis) to
the senver.

You can choose to add images now orto add them later using the Add Image Wizard.

™ Add images to the Windows Deployment Server now

More information about adding images

cBack [ Fmish | | Cancel |

WDS Server Service Configured Successfully and started.

[ windows Deployment Services

File Acton View Help

€9 7wz HE

i!'r Windows Deployment Services Name [
= 33 servers

[ Install Images

[<] Boot Images

L éLegacy Images

% Pending Devices
[S¥Multicast Transmissions

By - oot con

182




Windows Server 2008 - Network Administration

Lab - 3: Adding Windows 2008 Boot Image to WDS Server
Right click Boot Images Select Add Boot Image.
File Acton View Help
& | 2m= B

i'; Windows Deployment Services Image Name
= 33 servers
B I sysl.microsoft.com

1.

| Architecture [ Status [ Size  [Date [ 0Sversion |

There are no items to show in this view.
| Install Images

»
Export List...

Help

2.

Browse and Select boot.wim file from 2008 OS DVD (Ex: D:\Sources\boot.wim)

¥ Windows Deployment Services - Add Image Wizard x|
Image File

Select 3 Windows image (WIM)file that contains the image(s) to add.
File: location:

< Back Tewt > Cancel
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Click Next.

¥ windows Deployment Services - Add Image Wizard x|
Image File %IE

Select 3 Windows image (WIM}file that contains the image(s) to add.

File location:

D:sources'boot.wim Browss... |

< Back Cancel |

Give Name to image Ex: Windows Server 2008.

¥ Windows Deployment Services - Add Image Wizard x|
Image Metadata %T;

Enter a name and description for the following image:
"Microsoft Windows Longhom Setup (86)"

Image name:

II'v1ichsoﬂ Windows Server 2008

Image description:
Il'v1ic:msoﬂ Windows Longhom Setup {<86)

Image architecture:
%86

< Back Cancel
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5. Click Next.

] [,3 Windows Deployment Services - Add Image Wizard ll
Summary %Ihl:
1 "
|
[ Review the following settings before adding images.
Image group: Boot Images
Image file: D:'sources'boot wim
Image(s) selected:
MName I
Microsoft Windo...
To change any settings, click Back. To add the selected images to the server, click
MNext.
Cancel

6. Image will be added =>click Finish.

[¥ Windows Deployment Services - Add Image Wizard x|
Task Progress %Ih

| Operation complete

-

The selected images were successfully added to the server.

More information about adding images

Lanicel

< Back
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Lab — 4: Adding Windows 2008 Install Image to WDS Server

Right click Install Images Select Add Install Image.

¥ windows Deployment Services

File Acton View Help

&= |25z B

‘5 Windows Deployment Services

Image Name I Architecture I Status ] Size l Date I OS Version l
B &4 servers

B T syslmicrosoft.com
il Install Images

P Add Install Image

Add Image Group

There are no items to show in this view.

HEE
igsce |

Help

Give Name to Image Group Ex: Server Group and click Next.

i;ﬂ Windows Deployment Services - Add Image Wizard

x|
Image Group %f'
Image groups are used to group together similar images.
Enter the image group for the images you want to add:
) Select from existing image aroups I j
(+' Create a new image group |ServerGrDup
Cancel
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3. Browse and select Install.wim file from 2008 OS DVD (Ex: D:\Sources\install.wim)

= click Next.
x|
Image File %E.

Select a Windows image (WIM) file that contains the image(s) to add.

File: location:

D sourcestinstall wim Browse... |

« Back

Cancel |

4.  Select Windows Server Enterprise and click Next.

I;}_j Windows Deployment Services - Add Image Wizard

List of Available Images

The following images are available in the file. Select the images you wart to add.

MName I Archit... | Description |
O Windows Lo... 28 ‘Windows Longhom SERVERSTANDARD
Windows Lo... 86 Windows Longhom SERVERENTERFPRISE

O Windows Lo... x88 Windows Longhom SERVERDATACENTER
O Windows Lo... 86 Windows Longhom SERVERSTANDARDC...
O Windows Lo... 86 Windows Longhom SERVERENTERFPRISE...
O Windows Lo... 86 Windows Longhom SERVERDATACENTER...

¥ Use default name and description for each of the selected image

< Back Cancel
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5. Click Next

¥ windows Deployment Services - Add Image Wizard x|

Summary %—(“;

Review the following settings before adding images.

Image group: ServerGroup

Image file: D:\sourcestinstall wim

Imagels) selected:

Name |
Windows Longho...

To change any settings, click Back. To add the selected images to the server, click
Next.

< Back Cancel
6. Click Finish.
Task Progress I%! l:_
| - ; s

Operation complete

|

The selected images were successfully added to the server.

More information about adding images

< Back Cancel

Verification:

1.  Boot the Client system with PXE NIC Card

2. Press F12key when prompted to start the Installation.
3. Then mention the Administrator Credential.

4.  Select the Operating System which you want to install.

5. Select the Partition to install the O.S and follow the instructions.
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DISK MANAGEMENT
Prerequisites:

Before working on this lab, you must have

1. A computer running windows 2008 server with at least 3 Hard disks.
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Lab — 1: Creating Primary Partitions

Right click Computer > Manage

Administra.. Recyde Bin

Open
Explore

.
oo Ktk D, Domain Controller

Disconnect Metwork Drive. .. Host Nan]e:SYSl

Create Shortcut

Delete DNS Server:10.0.0.1

Rename

— IP Address:10.0.0.1
/. User Name:Administrator

Internet
Explorer

{7start| | 3 B | fo By 744am
Expand Storage, Select Disk Management, on Basic Disk Right click on
Unallocated Space to create primary partition.

Select New Simple Volume.

EzServer Manager
File Action View Help

A ? e

=
o+ Roles

i Features Volume Layout | Type | File System | Status

g Diagnostics ca () Simple Basic NTFS Healthy (System, Boot, Page File, Active,
3 j Configuration

= Storage

b windows server Bac
={ Disk Management

| | |
]
.
EJ_D'SI‘ 0 ) New Simple Volume...
Bsic C:
37.27G8 18,53 53 NTFS 17 Mew Suénned Volume...
Orling Healthy (System, Boot, Page File, ffun  Mew Striped Valume. ..

New Mirrored Volume. ..

L =Disk 1 Tew RATD-E Yalume, . .
Basic R
74,53 GB 74,53 GB Properties

Online Unallocated -

Help
L =Disk 2
Basic
74.53GB 74,53 55 -
4| | LI B Unallocated M Primary partition
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Click Next.
x|

Welcome to the New Simple
Volume Wizard

This wizard helps you create a simple volume on a disk.

A simple volume can only be on a single disk.

To continue, click Next.

< Bach: Cancel

Give Volume Size and click Next.

Specify Volume Size
Choose a volume size that is between the madmum and minimum sizes.

Manimum disk space in MB: 18163
Minimum disk space in MB: 8
! Simple volume size in MB: 2000 _I
|
|
< Back Cancel
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Assign Drive Letter > click Next

Thew Smple volume wazard x

Assign Drive Letter or Path
For easier access, you can assign a drive letter or drive path to your partition.

%" Assign the following drive letter:
= Mount in the following empty NTFS folder:

IE vl
| Browse... |

" Do not assign a drive letter or dive path

< Back Cancel |

Select the file system as NTFS = Select Perform a Quick Format > click Next

x

Format Partition
Ta store data on this partition, you must format it first.

Choose whether you want to format this volume, and  so, what settings you warnt to use.

" Do not format this volume

' Fommat this volume with the following settings:

File gystem: INTFS j
Allocation unit size: IDefaurt j
Volume label: INBW Walume

¥ Peform a quick format

[ Enable file and folder compression

< Back Cancel
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8. Click Finish.

x

Completing the New Simple
Volume Wizard

You have successfully completed the Mew Simple Volume
Wizard.

You selected the following settings:
Valume type: Simple Volume a
Disk selected: Disk 0
Volume size: 2000 MB
Drrive letter or path: E:
File system: MTFS
Allocation unit size: Default
Volume |abel: New Volume
Nuick famat - Yes LI

To close this wizard, click Finish.

Cancel

< Back
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Lab — 2: Converting Basic Disk to Dynamic Disk

1. Go to Disk Management—> Right click on Basic Disk > Select Convert to Dynamic
Disk

E,_Server Manager — 3l x]
File Action View Help

L e s E e

FNCITCEELEFEI OV Dick Management  Volume List + Graphical View | Actions
=+ Roles ;

% Features Volume Layout | Type | File System | Status Disk Mana... ~

i Diagnostics o (C) Szlmple Baszlc NTFS Healthy (Sy.stem, I!oot, .Page File, Active, More .. b

j’ﬁ Configuration CalNew Volume... Simple Basic NTFS Healthy (Primary Partition)

= Eﬁ Storage

b Windows Server Bac
=% Disk Management

< |

llx

gJ"_D_'sk o New Spanned Volume. ..
asic o w Volume (E
31.2? B Mew Si.rlped Volume... % GB NTES 15,7968
Online New Mirrored Volume. .. ialthy (Primary | || Unallocated
Iew RAID-5 Yolume.. .
L =Disk 1 = .
Basic Convert to Dynamic Disk...
74.53GB Conyett b GRT) Disk
Online
Offfine
e Properties
Basic P
74.53GB -
. Help
| | _;I Bl Unallocated ‘yg—rrmmory-parmme T

2.  Select the Disks =>click OK.
x

Select one or more basic disks to convert to dynamic disks.
Disks:

Cancel

3.  Click Convert = click Yes.
x

The disks that wil be made dynamic are shown in the following list.

Disks:
MName | Digk Contents | Will Convert
Diighe 0 System Partition, Boot Parttion, ... Yes

Details... |

{Convert Cancel
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Lab — 3: Creating Simple Volume

Right click on Computer > Manage.

Administra.. Recyde Bin

Open
Explore

.
oo Ktk D, Domain Controller

Disconnect Metwork Drive. .. Host Nan]e:SYSl

Create Shortcut

Delete DNS Server:10.0.0.1

Rename

— IP Address:10.0.0.1
User Name:Administrator

Internet
Explorer

Control Panel

{7start| | 3 B | fo By 744am
Expand Storage, Select Disk Management.

Right-click the unallocated space on dynamic disk = click New Simple Volume.

EzServer Manager
File Action View Help

e | HEHEID=E

H B
L Fertes [Vome | iayout| Type | Flesystem [stetws
g Diagnostics a (C) Simple Basic NTFS Healthy (System, Boot, Page File, Active,
~} configuration
= % Storage
@ Windows Server Bac
=7 Disk Management

< | i
|
N -
EJ-DEk U ©) New Simple Volume...
asic C:
37.27GB 18,53 GB NTFS n New Spénned Volume, ..
Orline Healthy (System, Boot, Page File, | MNew Striped Volume...

MNew Mirrored Volume...

L =Disk 1 Tev) RATD-5 Valume, .,
Basic D
74.53GB 74,53 GB Properties

COnline Unallocated -

Help

L =Disk 2

Basic
74.53GE 74.53GB -
< | 2l B Unaliocated [l Primary partition
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Click Next.
x|

Welcome to the New Simple
Volume Wizard

This wizard helps you create a simple volume on a disk.

A simple volume can only be on a single disk.

To continue, click Next.

< Bach: Cancel |

Select the dynamic Disk you want to use, and then click add =>Assign the Disk
Space for the Simple Volume

Assign Drive Letter =>click Next

fhiew Simple volume wizard x|

Assign Drive Letter or Path
For easier access, you can assign a drive letter or drive path to your partition.

% Assign the following drive letter:
™ Mourit in the following empty NTFS folder:

E =l
| Browse... |

" Do not assign a drive letter or dive path

< Back Cancel
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Select the file system as NTFS to format > Select Perform a Quick Format > click

Next

x

Format Partition
Ta store data on this partition, you must format it first.

Choose whether you want to format this volume, and  so, what settings you warnt to use.

" Do not format this volume

* Fomnat this volume with the following ssftings:

File: system: INTFS j
Allocation unit size: IDefaurt j
Volume label: INBW Walume

[V Perform a quick format
" Enable file and folder compression

< Back Cancel

8. Click Finish.

x

Completing the New Simple
Volume Wizard

You have successfully completed the Mew Simple Volume
Wizard.

You selected the following settings:
Valume type: Simple Volume a
Disk selected: Disk 0
Volume size: 2000 MB
Drrive letter or path: E:
File system: MTFS
Allocation unit size: Default
Volume |abel: New Volume
Nuick famat - Yes LI

To close this wizard, click Finish.

Cancel

< Back

9. Simple Volume is created.
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Lab — 4: Creating Spanned Volume

Right click on Computer > Manage > Expand Storage - Disk Management.
Right-click the unallocated space on the dynamic disk on which you want to

create Spanned volume and then click New Spanned Volume.

E. server Manager

File Action View Help

€& | FnEE DS

ENESCUELE OV Disk Management  Volume List + Graphical View

=+ Roles

- Features Volume Layout | Type | File System | Status

% Diagnostics = (C) Simple Dy.. MNTFS Healthy (System, Boot, Page File, Crash [
_jﬁ Configuration == New Volume... Simple Dy.. NTFS Healthy

= (25 storage

b Windows Server Bac
=¢ Disk Management

1 |

B
Tl
) 1
I':‘)JD'S_" o © 5 n MNew Simple Volume. ..
37.27 GB 12,53 GB NTFS 1,25 GB NTFS e
online Healthy (System, Boot, ||Healthy New Striped Volume. ..
Mew Mirrored Volume...
L =Disk 1 Mew RAID-5 Yolume...
Drynamic -
7453 GE 74,53 GB Properties
Online Unallocated -
Help
L=Disk 2
Drynamic
74,53 GB 74,53 GB =
«| I Bl B Unallocated [l Simple volume

Click Next.

Mew Spanned Volume

Welcome to the New Spanned
Volume Wizard

This wizard helps you create spanned volumes on disks.

A spanned volume is made up of disk space on mare than one
disk. Create a spanned volume i you need a vaolume that is too
large for a single disk. You can extend a spanned volume by
adding free space from another disk.

To continue, click Next.

< Bach:

Cancel
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4.  Select the dynamic Disk you want to use, and then click add

5.  Assign the Disk Space for the Spanned Volume for both disks =>click Next
]

Select Disks
You can select the disks and set the disk size for this valume.

Select the disk you want to use, and then click Add.

Awailable: Selected:
Disl: 0 500 MB
Diske 1 1000 MB
< Remove |
,. Hemove Al
Tatal volume size in megabytes (MB): 1500
Maximum available space in ME: 6317
Select the amount of space in MB: 1000 _I

< Back Cancel

6.  Assign Drive Letter =>click Next.
x|

Assign Drive Letter or Path
For easier access, you can assign a drive letter or drive path to your volume.

% Assign the following drive letter:
= Mount in the following empty NTFS folder:

F ]
Browsze. . |

" Do not assign a drive letter or drive path

< Back Cancel
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7.  Select the file system as NTFS > Select Perform a Quick Format - click Next.
x|

Format Volume
To store data on this volume, you must format it first.

Choose whether you want to format this volume, and if so, what settings you want to use.

" Do not format this volume

¥ Fomat this volume with the following ssttings:

File: system: INTFS j
Allocation unit size: | Defautt |
Wolume label: INew Wolume

¥ Perform a quick format
™ Enable file and folder compression

< Back Cancel

8. Click Finish.
x|

Completing the New Spanned
Volume Wizard

You have successfully completed the Wizard.

You selected the following settings:

Waolume type: Spanned -
Digks selected: Disk 0, Disk 1

Volume size: 1500 MB

Drive letter or path: F:

File system: NTFS

Allocation unit size: Default

Wolume label: New Volume

Guick fomnat: Yes ;I

To close this wizard, click Finigh.

< Back ¢ Finish Cancel

9. Spanned Volume is created
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Lab — 5: Creating Striped Volume

Right click on Computer > Manage > Expand Storage - Disk Management

> Right-click on unallocated space in dynamic disk - click New Striped Volume.

E: Server Manager

File Action View Help

L A B =)

T Senver g (515
® 2 Roles e — o Ll

i Features — .YDU ¥pe . ile System 5 - :

3w Disgnostics & () Simple  Dynamic NTFS Healthy (System, Boot, Page File, Crash T
% Configuration

= Storage

@ Windows Server Backup
=] Disk Management

1| | i
|
- -
BJDE?k 0 ()— Mew Simple Volume. ..
yramic C: )
37%7 B 18,53 GB NTFS Mew pnned Vaolume...
Cnline Healthy (System, Boot, Page F New Striped Volume...

MNew Mirrored Valume. ..
Copisk1 | W .. 05 e .

Dynamic -
74.53GB 74.53GB Properties
Online Unallocated -

Help

L_=Disk 2
Dynamic
74.53GE 74.53GB
Online Unallocated %
B Unallocated [l Simpls volume
Click Next.
New Striped Volume x|

Welcome to the New Striped Volume
Wizard

This wizard helps you create striped volumes on disks.
A striped volume stores data in stipes on two or more disks. A

striped volume gives you faster access to your data than a
simple or spanned volume.

To continue, click Next.

¢ Back Cancel
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3.  Select the dynamic disk you want to use and then click add - assign the Disk

Space for the Striped Volume for both disks = click Next.

x

Select Disks
You can select the disks and set the disk size for this volume.

Select the disks you want to use, and then click Add.

Available: Selected:
e Disk O 500 MB

< Remove |
< Remave Al |

Disk 1 500 MB

Total volume size in megabytes (MEB): 1000
Mamimum available space in ME: 7hile
Select the amourt of space in MB: 500 _I
< Back Mext > Cancel

4.  Assign Drive Letter = click Next.

Hew Striped Volume |

Assign Drive Letter or Path
For easier access, you can assign a drive |etter or drive path to your volume.

%" Assign the following drive letter:
" Mourt in the following empty NTFS folder:

e =]
Browsze. . |

" Do not assign a drive letter or dive path

< Back Mext = Cancel
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5.  Select the file system as NTFS > Select Perform a Quick Format - click Next.

New Striped Volume x|

Format Volume
To store data on this volume, you must format it first.

Choose whether you want to format this volume, and if so, what settings you want to use.

" Do not format this volume

' Fomat this volume with the following settings:

File gystem: INTFS j
Allocation unit size: IDefaurt j
Valume Iabel: INBW Wolume

¥ Perform a quick format
[™ Enable file and folder compression

< Back Cancel

6. Click Finish.

New Striped Volume x|

Completing the New Striped
Volume Wizard

You have successfully completed the Wizard.

You selected the following settings:

Waolume type: Striped -
Digks selected: Disk 0, Disk 1

Volume size: 1000 MB

Drive letter or path: G

File system: NTFS

Allocation unit size: Default

Wolume label: New Volume

Guick fomnat: Yes ;I

To close this wizard, click Finish.

Cancel

< Back

7. A Stripped Volume is created.
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Lab - 6: Creating Mirrored Volume

1.  Right click on Computer >Manage > Expand Storage - Disk Management

- Right click on unallocated space on dynamic disk = click New Mirrored
Volume.

EhServer Manager
File Action \View Help

L I EE

T Senver e (515
i’ Roles Volume Layout | T File System | Statu

il Features — yout | Type . ile System s _ .

B Diagnostics [= R (s)] Smple  Dynamic MNTFS Healthy (System, Boot, Page File, Crash T
%& Configuration

= Storage

@ Windows Server Backup
=4 Disk Management

1| | i
|
. a
L= Disk 0 MNew Simple Yolume. ..
Dynamic () MNew Spanned Volume.
57,2768 18,53 GB NTFS °
Online Healthy (System, Boot, Page F e Striped Volume..
New Mirrored Volume...

L=Disk 1 New RAID-5 Volume. ..

Dynamic

74.53GB 74,53 GB Properties

Online Unallocated

Help

L =Disk 2

Dynamic

74.53GB 74.53GB

Online Unallocated s

B Unallocated [l Simole volume

2.  Click Next
New Mirrored Volume |

Welcome to the New Mirrored
Volume Wizard

This wizard helps you create mimored volumes on disks.
A mimored volume duplicates your data on two disks. Create a

mirmared volume if you wart to keep two separate copies of all
your information to prevert data loss.

To continue, click Mesxt.

< Back Cancel
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Select the dynamic disk You want to use, and then click add > Assign the Disk
Space for the Mirrored Volume for both disks (Ex: 500)—>click Next

New Mirrored Volume x|

Select Disks

You can select the disks and set the disk size for this volume.

Select the disks you want to use, and then click Add.

Available: Selected:

Disk O 500 MB
Add > | Disk 1
< Remove |
< Remove All |

Tatal volume size in megabytes (MB):

500 MB

500
74816

Select the amount of space in MEB: K00

JU

Maximum available space in MB:

=

< Back

Cancel

4.  Assign Drive Letter = click Next

Mew Mirrored Volume

Assign Drive Letter or Path

For easier access, you can assign a drive letter or drive path to your volume.

¥ Assign the following drive letter:

™ Mount in the following empty NTFS folder:

s
Browse,.. |

{~ Do not assign a drive letter or drive path

< Back

Cancel
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5.  Select the file system as NTFS > Select Perform a Quick Format - click Next.

New Mirrored Volume x|

Format Volume
To store data on this volume, you must format it first.

Choose whether you want to format this volume, and if so, what settings you want to use.

" Do not format this volume

¥ Fomat this volume with the following settings:

File gystem: INTFS j
Allocation unit size: IDefaurt ﬂ
Valume Iabel: INBW Wolume

¥ Perform a quick format
™ Enable file and folder compression

< Back Cancel

6. Click Finish.

Hew Mirrored Volume =l

Completing the New Mirrored
Volume Wizard

You have successfully completed the Wizard.

You selected the following settings:

Wolume type: Mimor -
Digks selected: Disk 0, Disk 1

Volume size: 500 MB

Drrive letter or path: H:

File system: MTFS

Allocation unit size: Default

Volume |abel: New Volume

Quick fomat: Yes ;I

To close thig wizard, click Finish.

< Back ¢ Finish Cancel

7. The mirrored Volume is created.
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Lab — 7: Creating RAID-5 Volume

1. Right click on Computer >Manage > Expand Storage - Disk Management

- Right click on unallocated space on the dynamic disk = click New Raid5
Volume.

EhServer Manager
File Action View Help

L I =]

T Senver g (515
i’ Roles Valume Layout | T File System | Statu

il Features — .YOU ¥pe . ile System s - .

&m Diagnostics (= ] Simple  Dynamic NTFS Healthy (System, Boot, Page File, Crash T
%ﬁ Configuration

= Storage

@ Windows Server Backup
=4 Disk Management

il |

E
4
-
L =Disk 0 Mew Simple Volume...
Dynamic (c) Mew 5 d
panned Volume...
37.27GB 13,53 GB NTFS ——
Online Healthy (System, Boot, Page F B STy e
News Mirrored Volume. ..
Lok | — LT
Dynamic -
74.53GB 74.53 GB Properties
Orline Unallocated
Help
L_=Disk 2
Dynamic
7453 GB 74,53 GB
Orline Unallocated d
B Unallocated [l Simple volume

2. Click Next.

Hew RAID-5 Volume

X

Welcome to the New RAID-5 Volume
Wizard

This wizard helps vou create RAID-5 volumes on disks.

A RAID-5 volume stores data in stripes on three or more disks.
It provides a way of recovering data if part of the data is lost.

To continue, click MNext.

¢ Back

Cancel
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3.  Select the dynamic disks you want to use, and then click Add = Assign the Disk
Space for the RAID 5 Volume for all disks (Ex: 500)=>click Next.
x

Select Disks
You can select the disks and set the disk size for this volume.,

Select the disks you want to use, and then click Add.

Available; Selected:
Dislk D 500 MB
Add
4’| Disk1 500 MB
% TerE | Dislc 2 500 MB
< Remove Al |

Tatal volume size in megabytes (MB): 1000
Maimum available space in MB: 76317
Select the amount of space in MEB: K00 _:I
< Back Cancel

4.  Assign Drive Letter = click Next.
x|

Assign Drive Letter or Path
For easier access, you can assign a drive letter or drive path to your volume.

% Assign the following drive letter:
' Mount in the following empty NTFS folder:

|| vl
Browse, . |

{~ Do not assign a drive letter or drive path

< Back

Cancel
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5.  Select the file system as NTFS > Select Perform a Quick Format - click Next.

New RAID-5 Volume x|

Format Volume
To store data on this volume, you must format it first.

Choose whether you warnt to format this volume, and if so, what settings you want to use.

" Do not format this volume
¥ Fommat this volume with the following settings:

File: system: INTFS ﬂ
Allocation unit size: | Defaut |
Wolume label: INE'r\' Volume

¥ Perform a quick format

[~ Enable file and folder compression

< Back Cancel

6. Click Finish.

Hew RAID-5 Volume x|

Completing the New RAID-5
Volume Wizard

You have successfully completed the Wizard.

You selected the following settings:

Volume type: RAID-5 -
Digks selected: Disk 0, Disk 1, Disk 2

Volume size: 1000 MB

Drrive letter or path: |-

File system: NTFS

Allocation unit size: Defautt

Wolume label: New Volume

Quick fomat: Yes j

To close this wizard, click Finish.

Cancel

< Back

7. The RAID-5 Volume is created.
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SERVER CORE AND DATA BACKUP
INSTALLING WINDOWS 2008 SERVER CORE OPERATING SYSTEM
Prerequisites:

Before working on this lab, you must have

1. A Computer and Windows Server 2008 Operating System DVD.
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Lab — 1: Installing Windows 2008 Server Core Operating System

1.  Restart the System and go to BIOS.

2. Set the First Boot Device as DVD ROM.

DuD-ROH Drive

£

E:I'I ter

3.  Save the settings by Pressing F10 and click YES.

4. Insert Windows Server 2008DVD and Restart the system.
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5.  Press any key to boot from the CD or DVD.

Press any key to boot from CD or DVD

6. System copies the files from DVD.

windows is loading files...

I
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7.  Select the language to install English.

w Install Windows

3

*
Windows Server;

T

\x ‘\
A LR R LB English (United States) hd| \ 9

Enter your language and other preferences and click "Next" to continue.

Copynght © 2007 Microsoft Corporation. All ights reserved.

8. Click Install now.

w Install Windows

v;
Windows Server

Install now ‘3

What to know before installing Windows
:Bepair your computer

Copytmbm Microsoft Corporation. All rights reserved.
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9. Leave the Product Key blank, and click Next. (Product key can be entered later.)

B _L\
N L s

Type your product key for activation

You can find your product key on your computer or on the installation disc holder inside the
Windows package. Although you are not required to enter your product key now to install, failure
to enter it may result in the loss of data, information, and programs. You may be required to
purchase another edition of Windows, We strongly advise that you enter your product identification
key now.

The product key sticker looks like this:

Mcreson
XXXXX = XXXXX = XXXXK = XXXAX = XXXXX

Product key (dashes will be added automatically):

v Automatically activate Windows when I'm online

What is activation?

Read our privacy statement

1 Collecting information 2 Installing

10. Click NO.

Install Windows g

Do you want to enter your product key now?

If you choose not to enter the product key now, you might need to reinstall
Windows later and potentially lose data, information, and programs, or you might
need to purchase another edition of Windows,

| FEZTIN [ (-
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11. Select the edition of Windows-Windows Server 2008 Enterprise (Server Core
Installation) and check the box | have selected the edition of windows that |

purchased.

O -y O\
X e .

Select the edition of Windows that you purchased

Windows Version

Windows Server 2008 Standard (Full Installation)
Windows Server 2008 Enterprise (Full Installation)
Windows Server 2008 Datacenter (Full Installation)
Windows Server 2008 Standard (Server Core Installation)
ndows e re Installation)
Windows Server 2008 Datacenter (Server Core Installation)

If you enter your product key, Windows can autematically determine which edition you purchased.

To enter your product key, click the Back button to return to the previous page,

I, Ifyou choose not to enter your preduct key now, make sure that you select the edition of Windows
that you purchased. If you select the wrong edition, you will need to purchase that edition, or you
will need to reinstall the correct edition of Windows later and potentially lese files and information,

[ Ihave selected the edition of Windows that I purchased

1 Collecting information 2 Installing Windows

12. Check the box I accept the license terms

© & v O\
A i

Please read the license terms

MICROSOFT SOFTWARE LICENSE TERMS
MICROSOFT WINDOWS SERVER 2008, ENTERPRISE
These license terms are an agreement between Microsoft Corporation (or based on
where you live, one of its affiliates) and you. Please read them. They apply to the
software named above, which includes the media on which you received it, if any. The
terms also apply to any Microsoft

updates,

supplements,

Internet-based services, and

support services

1 Collecting information 2 Installing
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13. Select Custom Installation.

€ A

Which type of installation do you want?

Upgrade
Keep your files, settings, and programs and upgrade Windows,
Be sure to back up your files before upgrading.

Custom (advanced)

Install a clean copy of Windows, select where you want to install it, or make changes
to disks and partitions.

This option does not keep your files, settings, and programs.

Help me decide

Upgrade has been disabled

- The upgrade cannot be started. To upgrade, you must be running Windows Server 2003 with
Service Pack 1 (SP1), or Windows Server 2008,

- There is not enough space to upgrade Windows on partition C:. You need approximately 7899
megabytes (MB) of free space to upgrade Windows on this partition. Cancel the installation, free
some space on the partition, and then try upgrading again.

1 Collecting information 2 Installing

Where do you want to install Windows?

| Marne Total Size|  Free Space | Type
=iz DiskD Unaliocated Space 160 68 160 GB

&3 Refresh

&4 Load Driver
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15. Select Unallocated Space and click New.

Where do you want to install Windows?

Total Size] Free Space | Type

=~ Di 16.0 GB 16.0 GB

44 Refresh x Delete Jformat 3@"" New

{9 Load Driver 3 Extend

1 Collecting information 2 Installing Windows

16. Enter the size for the partition, and click Apply.

Where do you want to install Windows?

| Name Total Size | Free Space | Type
@ Disk 0 Unallocated Space 16.0 GB 16.0 GB

44 Refresh 7( Delete &/ Format 3 New
€3 Load Driver SR xtend sice [15000 = MB [apply || Cancel

1 Collecting information 2 Installing Windows
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17. Select the Partition and click Next.

Where do you want to install Windows?

| Name Total Size | Free Space | Type

|:$ Disk 0 Partition 1 ‘{E‘} 146 GB 146 GB Primary

= Disk0 Unallocated Space 13 GB 13GB
=

44 Refresh & Format

&8 Load Driver

1 Collecting information 2 Installing Windows

18. Windows Installation will Start.

gy, N

Installing Windows...

That's all the information we need right now. Your computer will restart several times during
installation.

o Copying files

J Expanding files

o/ Installing features

V, Installing updates
Completing installation

1 Collecting information 2 Installing Windows
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19. System Restarts.

Windows needs to restart to continue

[e—
Restarting in 9 seconds

1 Collecting information 2 Installing Windows

20. Completes the Installation, and system will be restarted.

Installing Windows...

That's all the information we need right now, Your computer will restart several times during
instailation,

1 Collecting infarmation 2 Installng Windows
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21. Click OK, (User’s password must be changed before logging on the first time.)

® The user's password must be changed before logging on the first time.

% Windows Server2008
Enterprise

22. Enter the New Password and Confirm the password and Press Enter.

Administrator

EE——

Create a password reset disk..

Cancel

- .
% Windows Server-2008

Enterprise
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23.

24,

Click OK. (Your password has been changed.)

Your password has been changed.

' OKR

% Windows Server2008
Enterprise

It Prepares the Desktop.

O Preparing your desktop...

% Windows Server2008
Enterprise
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25. Finally Administrator has logged in and the command prompt is opened for

management of Server Core.

[ch.| Administrator: C:\Windows' system32'cmnd.exe

C:sUsers~Administrator>
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Configuring Windows 2008 Server Core

Prerequisites:

Before working on this lab, you must have

1. A computer running windows 2008 server Domain Controller.

2. A computer running windows 2008 server core.

SYS1

SYS2

SYs1

Domain Controller / DNS Server

IP Address 10.0.0.1

Subnet Mask 255.0.0.0

Preferred DNS 10.0.0.1

MICROSOFT.COM

223

SYS2

Member Server with Server Core O.S

IP Address 10.0.0.2

Subnet Mask 255.0.0.0

Preferred DNS 10.0.0.1
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Lab — 2: Configuring Windows 2008 Server Core

1. Login as Administrator on a server running Server Core.

[Z+] Administrator: C:\ Windows'system32',cmd.exe

C:sUserssAdministrator>

2. Toview the computer name, type set c.

[&]Select Administrator: indows"system32'.cmd.exe

C:\Users\Administratorrset c

CommonProgramFil Program Files“Common Files
COMPUTERNAME=
ComSpec=C:~HWindowssystem3Z2scnd.exe

C:sUserssAdministrator>
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3. Toview the user name &user domain, type set u.

C:sUsersSAdministratoriset u
SERDOMATN=WIN-WUSIN2IYXEZ]
SERNAME=A

USERPROFILE SUzerssAdministrator

C:sUsers\Administrator>

4. To view the currently logged on account, type whoami.

C:\UserssAdministrator>whoamni

in—wuSbinZiuyxszhadministraton

C:sUserssAdministrator>

5. To View the IP Address, type ipconfig

indows" system32' cmd.exe

C:xUsers~Administrator>ipconfiyg

Windows IP Configuration

Ethernet adapter Local Area Connection:

GConnection—specific DNS Suffix
Link-local IPub Address . .
IPv4 Address. . . . . . . .
Subnet Mask . . . . . . . .
Default Gateway . . . . . .

:54eb6x2

Tunnel adapter Local Area Connection¥:

Media State . . -

C e e e e e e oa Media disconnected
GConnection—specific DNS Suffix

C:uUserssAdministrator>_
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6. Toview the network interfaces, type netsh interface ipv4 show interfaces.

18 1588 connected Local Area Connect
L8 4294967295 connected Loopback Pseudo—Interface 1

C:uUserssAdministrator>_

a. If above command does not show any interfaces then, To Install NIC Drivers, Type
“pnputil -i -a D:\LAN Drivers\Driver.inf”

[es-| Administrator: C:\Windows' system32\cmd.exe

C:\Users\Administrator>pnputil —i —a D:\Drivers\LAN\Intel\el1BBh325.inf
Microsoft PnP Utility

Processing inf : e10Bb325.inf

Successfully installed the driver on a device on the system.
river package added successfully.

Published name : oeml.inf

C:\Users\Administrator>

b. To verify the network interfaces, type netsh interface ipv4 show interfaces.

i@ 1588 connected Local Area Connection
58 4294967295 connected Loophack Pseudo—Interface 1

C:sUserssAdministrator>
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To assign the IP Address, type netsh interface ipv4 add address "Local Area
Connection"10.1.1.1 255.0.0.0

ndows'system32'cmd.exe

C:sUserssAdministratorinetsh intewrface ipv4 add address "Local Area Connection®
iB.1.1.1 255.8.8.8 .

C:sUsers Administrator>

To add Dns server address, type netsh interface ipv4 add dnsserver “Local Area

Connection” 10.0.0.1

ndows'system32%cmd.exe

C:sUserssAdministrator>netsh interface ipv4d add dnsserver "Local Area connection
" 18.8.8.1 II

C:sUserssAdministrator>

To Verify the IP Address & preferred dns address, type ipconfig /all

.cmd.exe

Windows IP Configuration

Host Mame . . . . . . . . WIN-WUSIN2IYXEZ
Primary Dns Suffix . . .

Mode Type . . . . . . . R Hybrid
IF Routing Enahled. . . . Mo
WINS Proxy Enabhled. . Mo

Ethernet adapter Local Area Connection:

Connection—specific Suffix
Description . . . . . . . .

Physical Address. . . . .
DHCP Enabled. . . . . . .
Autoconf iguration Enahled
Link—local IPub Address

Intel{R>» PRO/18B UE Network Connection
B8-13-2@-42-5F-B4
Mo

. Yes
- fel@::7cdl1:3330:abB6 54642 (Preferredd
. 18.8.8.2(Preferred?

- 255.0.0.9
Default Gateway -

DNS Servers . . . 10.6.6.1
NetBIOS over Tcpi . . Enabled
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To change the computer name, type netdom renamecomputer computername

/newname:New-computer-name

[&] Administrator: indows" system32cmd.exe

C:xlUserssAdministrator>netdom renamecomputer WIN-UWUSIN2IYRSZ /newname:sys2-core .

Thizs operation will rename the computer WIN-WUSINZIYRESZ
to sys2-core.

Certain services, such as the Certificate Authority, rely on a fixed machine
name. If any services of this type are running on WIN-WUSINZIYXSZ.

then a computer name change would have an adverse impact.

Do you want to proceed <Y or NO7

o

The computer needs to he restarted in order to complete the operation.

The command completed successfully.

C:sUserssAdministrator>

To restart the computer, type shutdown /r, Computer will restart.

A‘i’uu are about to be logged off

[ ] Windows will shut down in less than a minute.
-

To join the server to the domain, type netdom join sys2-core
/domain:Microsoft.com /UserD:Administrator /PasswordD:Microsoft_123

[&] Administrator: C:4Windows'system32' cmd.exe

C:slUserssAdninistratornetdom join sysZ2-core Adomain:Microsoft.com sUserD:Admini
strator sPasswordD:microsoft_123_ .
The computer needs to bhe restarted in order to complete the operation.

The command completed successfully.

C:xlUserssAdministrator>
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13. To View the installed roles or services, type oclist.

C:s\Users\Administrator>oclist
Use the listed update names with Ocsetup.exe to installA/wuninstall a server role
or optional feature.

Adding or removing the Active Directory role with OCSetup.exe is not supported.
It can leave your server in an unstahle state. Always use DCPromo to install or
uninstall Active Directory.

icrosoft—Windows—ServerCore—Package

ot Installed:BitLocker

ot Installed:BitLocker—RemoteAdminTool

ot Installed:ClientForMWFS-Base

ot Installed:DFSM-Server

ot Installed:DFSR-Infrastructure—ServerEdition
ot

ot irectoryServices—ADAN—ServerCore
ot irectoryServices—DomainController—ServerFoundation
ot Installed:DNS—Server—Core—Role

ot ailoverCluster—Core

ot R&—Infrastructure

ot Enstalled:IIS—HehSeruerRule

——— Hot Installed:IIS-FTPPublishingService

14. To Install any role or service, type start /w ocsetupRole or Feature name

Ex: start /w ocsetup DNS-Server-Core-Role

dows' system32%,

C:sUsersAdministrator>start Avw ocsetup DMNS-Server—Core—Role

C:sUsers“Administrator>

15. For Verification: Type oclist=> it will display DNS-Server-Core-role as Installed

C:s\UsersAdministrator>start Aw ocsetup DMNS—Server—Core—Role

C:\UsersSAdministrator>oclist
Use the listed update names with Ocsetup.exe to installAuninstall a server role
or optional feature.

hdding or removing the Active Directory role with OCSetup.exe is not supported.
It can leave your server in an unstahle state. Always use DCPromo to install ow
uninstall Active Directory.

icrosoft—Windows—ServerCore—Package
Installed:BitLocker
Installed:BitLocker—RemoteAdminTool
Installed:ClientForNFS—Base
Installed:DFSN-Server
FSR—Infrastructure—ServerEdition
HCPServerCore
irectoryServices—ADAM—ServerCore
Services—DomainController—ServerFoundation

ailoverCluster—Core
RE8-Infrastructure
Installed:II18-WebServerRole
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16. To manage the Dns server on Server core

On other system (SYS1): Go to Start—> Select Programs—> Select Administrative

Tools—> Select Server Manager - Select Features - Select Add Features.

E,: Server Manager

Fil=  Action Wew Help

I[=] B3

Lok Al ol 7|

Sk Server Manager [SYSL)
3 Roles

ﬁzj Features

m Diagnostics

ﬁﬂ' Configuration

=5 storage

*| Features Summary

%‘; Last Refresh: 12/24/2008 6:40:13 PM  Configure refresh

?& Wiew the status of features installed on this server and add or remove Features.

E Features Summary Help

& Add Features

17.

Expand Remote Server Administration Tools = Role Administration Tools 2>

Select the Check box for DNS Server tools = click Next = click Install

Add Features Wizard | x|

=

Confirmation

Frio

aress

Results

Select Features

Select one or more Features to install on this server,
Features:

] Quality Windows Audio Yidso Experisnce
[ ] Remate Assistance
["] remate Differential Campression
= [E Remote Server Administration Taols (Installed)
B [E Role Administration Tools (Installed)
[ Active Directory Certificate Services Tools
[E Active Directary Domain Services Tools {Installed
D Active Directory Lightweight Directory Services T
|:| Active Directory Rights Management Services Tog
[ DHCP Server Tools
DMNS Server Tools
[] Fax Server Tools
[] File Services Todls
[] Metwark Palicy and Access Services Tools
[] print Services Tools
[] Terminal Services Tools
[ uDDI Services Tools
[] web Server (115) Tools
[] windaws Deployment Services Tools
[ Hyper-¥ Tools

m Emmbswen Bdrnimicke skinm Tonle

l

More about Features

| o

= Previous | [exk =

Description:

Microsoft .NET Framework 3.0
combines the power of the NET
Framework 2.0 APIs with new
technologies for building applications
that offer appealing user interfaces,
protect your customers'personal
identity information, enable seamless
and secure communication, and
provide the ability to model arange of
business processes.

| Cancel I

| Inistall
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18. To Configure DNS Server of Server Core
On other system (SYS1): Go to Start—> Select Programs=> Select Administrative

Tools—> Select DNS > Right click DNS ->click Connect to DNS Server

File  Action Wiew Help

& |mlclHmE § 8E
Connect ta DMS Server. .. Iol welcome to DNS
All Tasks > o
) The Domain Mame System (DS is a hierarchical naming system used For locating computers and network
Wiew 4 services, DMS is best known For translating Friendly DS domain names to IP addresses and network
services.
Refresh
o] To add a DS server, on the Action menu, click Connect to DNS Server,
Help

|
Mention the Computer name of Server core (sys2-core) = click OK.

Connect bo DNS Server E

The Windows DS server is running on;

19.

" This computer

' The Following computer:

I sst—core|

¥ Connect to the specified computer now

[0]4 I Cancel
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20. Connected to Server Core

i DNS Manager !E
File  Action Wiew Help
! Mame
] -Care |l Global Logs
+ |§1] Global Logs | Forward Lookup Zones
# | | Forward Lookup Zones | Reverse Lookup Zones
H ] Reve.rs.e Lookup Zanes | Conditional Forwarders
+ || Conditional Forwarders || Rot Hints
|2 | Forwarders

21. To Uninstall any role or service, type start /w ocsetupRole or Feature name

/uninstall

Ex: start /w ocsetup DNS-Server-Core-Role /uninstall

[F] Administrator dows"system32cmd.exe

C:“\Users~Admninistrator>start ~w ocsetup DNE—Server—Core—Role Auninstall

C:sUsers~Administrator>

232




Windows Server 2008 - Network Administration

CONFIGURING WINDOWS SERVER BACKUP & RECOVERY
Prerequisites:

Before working on this lab, you must have

1. A Computer with Windows Server 2008 Domain Controller

SYS1

MICROSOFT.COM

SYs1

Domain Controller

IP Address 10.0.0.1
Subnet Mask 255.0.0.0

Preferred DNS 10.0.0.1
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Lab - 3: Configuring Windows Server Backup and Recovery

1. Login as Administrator, Start->Programs—=>Administrative Tools—>Server

Manager.

LR

Administra.. Recycle Bin

|, Terminal Services
" 5 Active Directory Domains and Trusts

Computer [ Active Directory Sites and Services
:] Active Directory Users and Computers

DNS 2 ADSI Edit

2 .
= Component Services

g- Computer Management
Data Sources (ODBC)
DNS
Event Viewer
Group Policy Management
|, Accessories |, ISCSI Initiator

. Administrative Tools Local Security Policy

Documents Memory Diagnostics Toal

Relizbility and Performance Monitor

. Extras and Upgrades

. Maintenance

Settings (3 i i i
. Mero 7 Essentials Security Configuration Wizard

. Startup Server Manager
@ Internet Explorer
Windows Contacts

Search

T4 Services

Help and Support Share and Storage Management

L Storage Explorer

System Configuration

® Task Scheduler

ﬂ Windows Firewall with Advanced Security
@ Windows Server Backup

j Run...

Shut Down..,

Windows Server 2008 Enterprise

« @Iy 3:28PM

2. Select Features and click Add Features.

Eh Server Manager =13l

File Acton View Help
o N
R Serve Bansger (5751

=
3 Roles

i Features
= Diagnostics View the status of features installed on this server and add or remave features,
|.!I Configuration
Storage
(| Features Summary Features Summary Help
" Features: 3 of 35installed ﬁ Add Features

ﬂ Remove Features
Group Policy Management

Remote Server Administration Tools
Role Administration Tools
Artive Directory Domain Services Tools
Active Directory Domain Controller Tools
DHCP Server Toals
DMS Server Tools
Windows Process Activation Service
Process Model
.NET Environment

Configuration APIs

£¥ Last Refresh: 12/25/2008 11:11:43 AM Configure refresh
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3.  Click Next = check Windows Server Backup Features and Next—> click Install.
X

ﬁ%l Select Features

Features Select one or more features to install on this server,
Confirmation Features: Description:
Progress ity Windor — - Windows Server Backup Features
[ Quality \.nlnt?lo ws Audio Video Experience ;I allow yau to back up and recover your
Results [ remote ""_55'515”5_5 _ operating system,applications, and
[] Remote Differential Compression data. You can schedule backups to
[E remote Server Administration Tools (Installed) run once a day or mare often, and
[ Remaovable Storage Manager can pr_otect the entire server or
] RPC over HTTP Proxy specificvolumes.

[] simple TCR/IP Services
|:| SMTP Server
[] sNMP Services
D Storage Manager for SANs
[] subsystem for UNI¥-based Applications
[] Telnet Client
[] Telnet Server
[ TFTP Client
[ windows Internal Database
PowerShel
s Py Activa o
indows Server Backup Features
[] windows System Resource Manager
[ wiNs Server
[] wireless LAN Service

-

More about features

< Previous Install Cancel

4.  After Installation click Close.
x|

ﬁ#l Installation Results

Features X X .
The following roles, role services, or features were installed successfully:
Confirmation
1 1warning message below
Progress T

[ ‘.} Vindows automatic updating is not enabled. Tainstall the latest updates, use Windows Update in
&7 Control Panel to check for updates,

~ Windows Server Backup Features '@' Installation succeeded

The following features were installed:
Windows Server Backup

Print, e-mail, or save the installation report

| = Previous | Next = |

Gancel
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Start—>Programs—>Administrative Tools>Windows Server Backup.

administrator Recyde Bin

| . Terminal Services
% Active Directory Domains and Trusts
g [ Active Directory Sites and Services
: Active Directory Users and Computers

Domain Z ADSI Edit

s .
s Component Services

Computer

;g- Computer Management
5 Data Sources (ODBC)

—_—
Fidl b

|

Windows Update
§£ Group Policy Management
Accessories » & iSCSI Initiator

. Ad Tools » i Local Security Palicy

rﬂ Programs
b

.i',;* Documents * | Extrasand Upgrades P [p] Memory Diagnostics Tool

u & st , b Maintenance L4 @ Reliability and Performance Monitor

; '/ ettings =

E— | Microsoft Office 4 iz_.' Security Configuration Wizard

& p Search » |, Startup 4 % Server Manager

? _ & Internet Explorer . Services

1

'% @ FEDETE S Windows Contacts \2| Share and Storage Management
7 =§ Run... # Storage Explorer

g 2| System Configuration

5 @ Shut Down... (%) Task Scheduler

0 Windows Firewall with Advanced Security

[Frstart | 2 mm > | s Window:

Perform a backup or recovery of this server, M
T

Select Backup Once

4l Windows Server Backup 18] x]
File Action View Help

|
Windows Server Bac
a& You can perform a single backup or schedule a reqular backup using this application.

Local +| [ Actions
Windows Server Ba... &

Q_@ Backup Schedule. ..
/1% Mo backup has been configured for this computer, Use Backup Schedule Wizard or Backup Once Wizard to perform a regu Q@ Backup Once...

E’ Recover...
Messages
Configure Perfor...

Time | Message | Description
Connect To Ano...
View 3
Help

Status

Last Backup Next Backup All Backups

Status: - Status: Total backups:

Time: - Time: Latest copy:

View details View details Oldest copy:

View details

-
« | »

|Creahes a one-time backup of your data that you can use to supplement your automatic backups. ‘
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7.  Select Different Options <> click Next
x|

wia :
. & Backup options

Badwp options Create a backup now using:

Select backup configur... The same options that youused in the Backup Schedule Wizard for scheduled
Specify destination type Backups

Specify advanced option ' Different options

Choose this option if you have not created a scheduled backup or to specify
a location or items for this backup that are different from the scheduled
Backup progress backup.

Confirmation

To continue, dick Next.

Mare about backing up your server

< Previous Backup Cancel

8.  Select Custom =>click Next
e

h )
LS i i
. & Select backup configuration

Badkup options What type of configuration do you want to schedule?

Select backup configur.... " Eull server {recommended)

Select backup items I want to back up all my server data, applications, and system state.
Specify destination type Backup size: 16.61GB

Specify advanced option % Custom

D T I want to excude some volumes from this backup.

Backup progress

Backing up only the system state of the server using the command line

< Previous Backup Cancel
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9.  Uncheck the box Enable System recovery > Next and Select which drive we want
to take backup select that drive and Next.
x|

3
e A
; '\7&/ Select backup items

Backup options What volumes do you want to back up?
Select backup configur...

| Yolumes = | Status | Size |
Select badwp items O Local disk (C:) Excluded 12.32GB

ey s TR fe O Local disk E:) Excluded 379 GE

New Volume (F:) Induded

Specify advanced option
Confirmation

Backup progress

[T Enable system recovery,

This option automatically indudes all volumes that contain operating system
components for system recovery.

< Previous | Mext = I Backup | Cancel |

10. Select the destination type Local drives —>click Next —>Select the Backup
Destination (Any Drive) = click Next.
B

A
e & - . .
p _\7&/ Specify destination type

Backup options Choose the type of storage for the backup:
Select badkup configur... & Local drives

Select backup items For example, local disk (D:), DVD drive (E:)

Spedfy destination type " Remote shared folder

Select backup destination For example, \\MyFileServer\sharedFolderiame,
Specify advanced option

Confirmation

Backup progress

< Previous Backup Cancel
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11. Select VSS copy backup and click Next.

4 Backup Once Wizard i x|

1o ... .
E& Specify advanced option

Backup options Choose what type of Volume Shadaw Copy Service (VSS) backup you want to

Selectbackup configur... S

Select backup items (% VS5 copy backup (recommended)

Spedi inati Choose this option if you are using another backup product to back up
DiestErion e applications that are on Volumes included in the current backup. This option

Select backup destination retains the application log files.

2
Corfraton Choose ﬂjis aption if you are not using any other backup product to back up
your applications. This option updates each file's backup history and clears
Backup progress the application log files.

More about ba and VSS
< Previous I Cancel
12. Confirm the Options and click Backup.
4 Backup Once Wizard i x|
I oo
C& Confirmation
Backup options A backup of the items below will now be created and saved to the specified
ok ckbrckiny confis destination.
Select b items Backup items: New Volume (F:)
iy destination Backup destination: Local Disk (E:)

e Advanced option: VS5 copy backup
Select backup destination
Specify advanced option
Backup progress

Cancel I

< Previous et I
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13. Finally click Close.
x
Jga
‘:y Backup progress

Backup options Status: Backup completed.

Select backup configur...

Select backup items —Status details

Specify destination type Backup location:  Local Disk (E:)

Select backup destination Data transferred: 30.81MB

Specify advanced option Items I

Confirmation Volume | Status | Data transferred |

_ New Volume (F:) Backup completed. 30.81MB of 30.81MB

< Previous Next>

Gancel I
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How to Recover the Data from Backup File.

Before Restoration, go to the drive and delete the data. (only for Lab purpose)

Select  Start> Programs=> Administrative  Tools=> Windows Server
Backup—> select Recover.
i8I
File Acton View Help
<= @ Em
Windows Server Backup (Local 21| Actions
& 3 ; . G Windows Server Ba... «
& You can perform a single backup or schedule a regular backup using this application. 2
< ¥ Backup Schedule...
A A scheduled backup has not been configured for this computer, Use the Backup Schedule Wizard to set up a regular, autc QQ Backup Once...
&3 data,
2 @ Recover...
e Configure Perfor...
| Time ~ | Message | Description Connect To Ano...
@ 12/25/2008 11:20 AM Backup Successful R
view
Help
Status
Last Backup Next Backup All Backups
Status: @; Successful Status: Not scheduled Total backups: 1
Time: 12/25/2008 11:20 AM Time: Latest copy: 1
g View details @ View details Oldest copy: 1
B view detais
v
< | »

Select This server and click Next.

12 Recovery Wizard

P& Getting started

Getting started ‘fou can use this wizard to recover files, applications, and volumes from a backup. You can

Select backup date
Select recovery type
Select items to recover
Specify recovery options
Confirmation

Recovery progress

recover data from the local computer or another computer.,
Which server do you want to recover data from?
¢ This server (SYS1)

" Another server

To continue, dick Next.
More about recovering your server data

< Previous

Recover I

Cancel I

Select Date and Time of the backup file to be restored, click Next.
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(% Recovery Wizard

Sun Mon Tue Wed Thu Fn Sat
2 3 4 5 @
10 11 12 13
17 18 19 20
24 26 27
31

5.  Select Files and Folders and click Next.
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6. Select the folder or files to be recovered and click Next.

13 Recovery Wizard

c$ Select items to recover

Getting started

Select backup date
Select recovery type
Specify recovery options
Confirmation

Recovery progress

Browse the tree to find the files or folders that you want to recover. Click an item to select it
for recovery.

Available items:

El- g sys1 MName | o:
Bl Local disk (F:) microsoft. txt 1
| SRECYCLE.BIN = microsoft2. ixt 1

{ [ micrasoft3. bt Y
B4 System Volume Inform

al | 4 | i

< Previous | Mext > I Recover | Cancel |

7.  Select Original Location and click Next.

12 Recovery Wizard

1
$ Specify recovery options

Getting started

Select backup date
Select recovery type
Select items to recover
Confirmation

Recovery progress

—Recovery destination
%' Original location

" Another location

—When this wizard finds files and folders in the recovery destination

¢ Create copies so I have both versions of the file or folder
 Querwrite existing files with recovered files

" Do not recover those files and folders

—Security settings

¥ Restore security settings

< Previous Recover Cancel
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8. After the Restoration click Close.

13 Recovery Wizard

4
r__' A Recovery progress

Getting started Status: Restore of files completed.

Select backup date

Select recovery type Recovery details:

Select items to recover

Specify recovery options

Windows Server 2008 - Network Administration

Item | Destination | Status | Data transferred |
Confirmation F:'\Microsoft... Fi\Microsoft Restore of fle... 0KBof0KB
_ F:\Microsoft... F:\Microsoft Restore of file... 0OKEofOKB
F:'\Microsoft... Fi\Microsoft Restore of fle... 0KBof0KB
To finish the wizard and continue, dick Close.
< Previous Mext = | Close I Cancel
oo .
Verification:

1. Go to the drive and verify for the folder and files.
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ADVANCED TOPICS

DISTRIBUTED FILE SYSTEM AND GROUPS

Prerequisites:

Before working on this lab, you must have

1. A computer running windows 2008 server Domain Controller.

2. A computer running windows 2008 server or Member Server.

SYS1

SYS2

SYS1

Domain Controller

IP Address 10.0.0.1
Subnet Mask 255.0.0.0
Preferred DNS  10.0.0.1

MICROSOFT.COM

245

SYS2

Member Server
IP Address
Subnet Mask
Preferred DNS

10.0.0.2
255.0.0.0
10.0.0.1
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DISTRIBUTED FILE SYSTEM

Installing Distributed File System (DFS)

->Server Manager - click Roles

File Action View Help

= | 7= H

E. server Manager

In SYS2 (Member Server) go to Start »Programs = Administrative Tools

=10l

i Server Manager (5Y52)

B
i Features

5 Storage

+~! Roles Summary

-~/ Roles: 0 of 16 installed

= Diagnostics View the health of the roles installed on your server and add or remove roles and
= " features.
! Configuration

Roles Summary Help

335 Add Roles

fgzi Remove Roles

£ Last Refresh: 12/23/2008 11:20:45 AM  Configure refresh

2. Click On Add Roles

H Add Roles Wizard
ﬁ Select Server Roles
Before You Begin Select one or more roles to install on this server,
Server Roles Roles: Description:
Confirmation [ Active Directory Certificate Services
Progress

D Active Directory Domain Services
D Active Directory Federation Services
e [[] Active Directory Lightweight Directory Services
El Active Directory Rights Management Services
[] application Server
D DHCP Server
] DNS Server
D Fax Server
u
] metwork Policy and Access Services
] Print Services
] Terminal Services
D UDDI Services
] web Server (I15)
] windows Deplayment Services

More about server roles

< Previous I

Mext =

File Services provides technologies
that help you manage storage, enable
file replication, manage shared
folders, ensure fast file searching, and
enable access for UNIX client
computers.

Install Cancel
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3. Select File Services 2 click Next

Add Roles Wizard

Select Server Roles

Before You Begin

Server Roles
File Services
Role Services
Confirmation
Progress

Results

Select one or more roles to install on this server,
Roles:

Description:

e Directory Certificate Sel
e Directory Domain Ser
= Directory Federation Services

e Directory Lightweight Directory Sery
ve Directory Rights Management S
[ application Server

[] oHep server

[] oms server

|:| Fax Server

File Services

[ metwork Policy and Access Services
|:| Print Services

[] Terminal Services
[] uDDI services

More about server roles

< Previous |

File Services provides technologies
that help you manage storage, enable
file replication, manage shared
folders, ensurefast file searching, and
enable access for UNIX client
computers.

Install Cancel

4.  Check the box Distributed File System-> click Next.

Select Role Services

Before You Begin
Server Roles

File Services

ces
DFS Namespaces
Mamespace Type
Mamespace Configuration
Confirmation
Progress

Results

Select the role services to install for File Services:
Role services:

Description:

DFS Mamespaces

DFS Replication
|:| File Server Resource Manager
[] services for Netwark File System

dows Search Service

Windows Server 2003 File Services
[] File Replication Service

[] indexing Service

O
20

More about role services

< Previous

Distributed File System (DFS) provides

tools and services for DFS
Namespaces and DFSReplication.

| Mext > I Install

Cancel
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5. Select Create a Namespace Later and click Next

Add Roles Wizard

Create a DFS Namespace

Before You Begin A DFS namespace is a virtual view of shared folders located on different servers in an organization. Users can

5 Rol navigate the namespace without needing to know the server names or shared folders hosting the data. When
e a user views the namespace, the folders appear in a single, virtual namespace.

File Services

‘fou can use this server to build new DFS namespaces.
Role Services

DF5 Namespaces " Create a namespace now, using this wizard
Confirmation A namespace consists of a namespace server, folders, and folder targets.
Progress Enter & name for this namespace:

Results Ir-lamespace 1

% Create s namespace |ater using the DFS Management snap-in in Server Manager

More about configuring namespaces

< Previous | Mext > I Install Cancel

6. Click Install and click Close

(Add Roles Wizard

Confirm Installation Selections

Before You Begin
To install the following roles, role services, or features, dick Install.

Server Roles
@ 2 informational messages below

Ix

File Services
Role Services ':D This server might need to be restarted after the installation completes,
DFS Namespaces +| File Services
Confirmation File Server
DFS Hamespaces Service
P
rogress Mamespace: Build later
Results DFS Replication Service

(i) DFS Replication requires further configuration, Complete your replication configuration using the
~  DFS Management snap-in in Server Manager,

Print, e-mail, or save this information

< Previous IEXE > Cancel

248




Windows Server 2008 - Network Administration

Configuring Namespace In DFS

1.  In SYS2 (Member Server) Go to Start = Programs = Administrative Tools > DFS

MANAGEMENT.

Administra.. Recycle Bin

iy

Computer

. Terminal Services
. Component Services
;g'- Computer Management
5 Data Sources (QDBC)
& oF nt
2 Dns
@ Event Viewer
_§£ Group Palicy Management
&, i5CSI Initiator
i Local Security Palicy
T Administrative Tools (2] Memory Diagnostics Tool
-—;, Documents ¥ | ExtrasandUpgrades » @ Reliability and Performance Monitor

[ .
1 windows Update
|

. Accessories

& — y Maintenance 3 i Security Configuration Wizard
o . Microsoft Office 3 % Server Manager
p Search » |, Startup b L Services
@ Internet Explorer ‘3¢] Share and Storage Management
@ Help and Support Windows Contacts = Storage Explorer

J System Configuration

® Task Scheduler

&P Windows Firewall with Advanced Security
W windows Server Backup

,5# Run...

@ Shut Down. ..
|am |

Windows Server 2008 Enterprise

2.  Right click On Namespaces and Select New Namespace

1o/
3 File Action View Window Help |_|ﬁ||1|
= | Hml=]

~ DFS Management MNamespaces Actions

o, -
O ————— e -

Replication
Add Mamespaces to Display...

e no items to show in this view. &5 Mew Namespace...

Delegate Management Permissions. .. 25 Add Namespaces to Displ...

View ’ Delegate Management P...
New Window from Here
View 4
Bl Mew Window from Here
Help |z ExportlList...
Help

Starts & wizard to create a new namespace,
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Enter the Server Name in which DFS Installed and Select Next.

E ‘New Namespace Wizard

Namespace Server

i Steps:

Enter the name of the server that will host the namespace. The server you specify
Namespace Server will be known as the namespace server.

Namespace Name and Seftings |~ Server:

s Browse... |
Namespace Type = —

Review Settings and Create
Namespace

Confimation

Fer mare information about server requil .see DFS
Management Help

< Brevious |

=lol=|

Cancel |

Enter Name for the Name Space (Public)and click Edit Settings.

New Namespace Wizard

Namespace Name and Settings

HI

|

: Steps: ; .

H Enter a name for the namespace. This name will appear after the server or domain
Namespace Server name in the namespace path, such as \\Server\Name or “\Domain“\Name.

Namespace Name and Settings

Name:
Namespace Type FLBLIC
Review Settings and Create Example: Public
Namespace
Confimation

If necessary, the wizard will create a shared folder on the namespace server. To
madify the settings of the shared folder, such as its local path and pemissions, click
Edit Settings.

< Previous MNeadt >

=lolx|

Cancel
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5. Select the Permissions Administrators have full access, other users have read

and write permissions, and click Next.

T8 e amespace winard -Inix
Namespace Name and Settings
x
; Steps: MNamespace server, L
Namespace Server |5y52
Namespace Name and Settings Shared folder:
|PUBLIC -
Namespace Type
Local path of shared folder:
Review Settings and Create
Namaspace |C-\DFSRoots\PUBLIC Browse... |
Confirmation
Shared folder pemissions: ok
= All users have read-only pemmissions
= Al users have read and write permissions
¢~ Administrators have full access; other users have read-only
permissions
¢ Administrators have full access: other users have read and wiite
permissions
' lse custom permissions Customize... |
ok ] cencel |
< Previous | Next > Cancel
6. Select Domain Based Namespace > click Next
e

Namespace Type

Steps: Select the type of namespace to create.
Namespace Server
' Domain-based namespace

Nemegpace Name and:Setings A domain-based namespace is stored on one or more namespace servers and in Active Dirsctory Domain Services.
‘You can increase the availability of a domain-based namespace by using muttiple servers. When created in
Namespace Type Windows Server 2008 mode, the namespace supports increased scalability and access-based enumeration.

Review Settings and Create

Namespace

Confirmation V' Enable Windows Server 2008 mode
Preview of domainbased namespace:
[\microsoft com\PUBLIC

" Stand-alone namespace

A stand-alone namespace is stored on a single namespace server. You can increase the availability of a
stand-alone namespace by hosting it on a failover cluster.

Preview of stand-slone namespace:

[\\sys2\PUBLIC
For more i i types and scalabili ideli see DFS
Management Help.
< Previous | Next > Cancel

7. Click on Create and Select Close
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Configuring New Folder In Namespace

1. In SYS1 (DC) open any Drive which is formatted with NTFS
2.  Create a shared folder (Sales) and give permission of Co-Owner For Everyone
3.  In SYS2 (Member Server) go to DFS Management and Expand Namespaces
4.  Right click on namespace name and Select New Folder
~=lolx|
24 Fle Acon View Window Help j TS|

ok A il N =)
&% DFS Management \\microsoft.com\PUBLIC1 (Domain-based in Windows 2000 Server mode) || X eced

=] D‘é; Namespaces :
icrosoft.com\PUBLIC1
it (e RV teR] | Namespace | Namespace Servers | Delegation | Search | \\m com\| =

) % Replication

;; New Folder...
Add Namespace Server... Add Namespace Server...
Delegate Management Permissions... -
Remove Namespace from Display... Delegate Management P...
View » Remove Namespace from...
New Window from Here View 4
Delete New Window from Here
Refies x Delete
Properties |Gl Refresh
Help

[Z] properties

Help

[create a new folder. [

5.  Give the name for NEWFOLDER (SALES) and click Add.
ewrolder x|

Name:
|SALES

Preview of namespace:
I\.\miemsoﬂ .com\PUBLIC1\SALES

Folder targets:

Add... I Edit Hemove l

For more information about namespace folders, see DES Management
Help

0K | Cancel I
4
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6.  Enter the path for folder target (\\Systemname\Sharefoldername) & Select OK.
X

Path to folder target:

|"-."-.SYS1 “SALES Browse. .. |

Example: “\Server'.Shared Folder'Folder

Cancel |
Y
7.  Click OK.
x
Name:
|SALES

Preview of namespace:
I‘\.\microsoft.com\PUBLIC1\SALES

Folder targets:
Add... Edi... Bemove
For more information about namespace folders, see DFS Management
Help
VERIFICATION:

1. InSYS2 (Member Server) Go to Run =type (\\Domainname\Namespace Name)
CIEEE——— x|

= Type the name of a pregram, folder, document, or Internet
— resource, and Windows will open it for you.

Open: \microsoft.com\publid j

\;l’j' This task will be created with administrative privileges.

oK I Cancel | Browse... |

2. It will display the contents (Folders) of Namespace.

253



file:\\SYSTEMNAME\SHAREFOLDERNAME
file:\\DOMAINNAME\NAMESPACE%20NAME

1.

Windows Server 2008 - Network Administration

GROUPS

Creating Groups

Login as Administrator on a Domain Controller.

Go to Start =»Programs —>Administrative Tools=> Active Directory Users and

Computers.

, Terminal Services
=5 Active Directory Domains and Trusts
Active Directory Sites and Services

ADSI Edit
Computer Component Services
| Computer Management
Data Sources (ODBC)
DHCP
. DNS

Event Viewer

Group Policy Management
Internet Information Services (IIS) 6.0 Manager

y i Internet Information Services (I15) Manager
|, Accessorie: » iSCSI Initiator
»| 35 Local Security Policy
| . Extras and Upgrades » [3€] Memory Diagnostics Tool
¢ . Maintenance » @ Reliability and Performance Monitor
Settings » i ) i _
| Microsoft Office »| 3 Security Configuration Wizard
Search »| | Startup » i Server Manager
& Internet Explorer 4 Services
[3=] Windows Contacts 32 Share and Storage Management
# Storage Explorer

2 System Configuration

(®) Task Scheduler

@ Windows Firewall with Advanced Security
& Windows Server Backup

Right click Users = Select New = Group.
=181

File Action View Help

e 7m0 R a=HBELRETIR

 Active Directory Users and Comput || Name | Type | Deescription |
_| Saved Queries Administrator User Built-in account for admini...
=] .fﬂ mi.crosoﬂ.com .%AIID',\'ed RODC Password Replication Group  Security Group ... Members in this group can...
‘J_ Builtin %Cert Publishers Security Group ... Members of this group are...
\J_ Comp.uters %Deniad RODC Password Replication Group  Security Group ... Members in this group can...
:iJ_ EomélnSConh.toII:r.s - SS,Domain Admins Security Group ...  Designated administrators...
\J. reign=ecurityFrincipals Domain Computers Security Group ... All workstations and serve...
— Delegate Contral... Domain Controllers Security Group ... All domain controllers in th...
Find... Domain Guests Security Group ... All domain guests
- Computer Security Group ... Al domain users
Al Tasks » Contact Security Group ...  Designated administrators...
7 main Controllers Security Group ... Members of this group are...
View L4 TEhaae uners Security Group ... Members in this group can...
Refresh MSMQ Queue Alias User Built-in account for guest ...
Tl Printer Security Group ... Servers in this group can ...
—————— s ollers Security Group ...  Members of this group are...
Properties Shared Folder Security Group ... Designated administrators...
Help

IO — ]

|Creabe a new object...
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Mention the Group name & Select the Group Scope as Domain Local& Group

type as Security.

frewotsect-orop

% Createin:  Zoom.com/Users

Group name;
| MCITP_USERS

Group name {pre-Windows 2000):
| MCITP_USERS

Groupscope ——— | Group type
% Domain local % Security
" Global " Distribution

€ Universal

oK I Cancel

Group will be created successfully.
=18 x|

File Action View Help

= = — @ .t
e Hn{d0XEc= HR A a5 TE%

: Active Directory Users and Comput | Name | Type | Description |
[ saved Queries § Administrator Lser Built-in account for admini...
=] .fi microsaft.com P&Allo'.\'ed RODC Password Replication Group  Security Group ...  Members in this group can...

J Builtin F&Cert Publishers Security Group ... Members of this group are...
L] Computers 82, Denied RODC Password Replication Group  Security Group ... Members in this group can...

= DDm..aln Conh'.o\ler.s . }E‘Domain Admins Security Group ...  Designated administrators...
j nSecuntyPnnapaIs }E,Domain Computers Security Group ... All workstations and serve...
— %Dumain Controllers Security Group ... All domain contrallers in th...
F&Domain Guests Security Group ... All domain guests
%Domain Users Security Group ... All domain users
P&Enterprise Admins Security Group ... Designated administrators...
F&Enterprise Read-only Domain Controllers Security Group ... Members of this group are...
82, Group Policy Creator Owners Security Group ... Members in this group can...
E; Guest User Built-in account for guest ...
B8, MCITP_USERS Security Group ...
}EJRAS and IAS Servers Security Group ... Servers in this group can ...
F&Read-only Domain Cantrollers Security Group ... Members of this group are...
%Schema Admins Security Group ...  Designated administrators...

255



Windows Server 2008 - Network Administration

6. To add any users to this group, Right click on User account & Select Add to a

group > Mention the group name as MCITP_USERS —>click OK.
=8|

File Action View Help

e | HElLdO0(REd= HB@E B a5 7I%

: Active Directory Users and Comput | Name Copy... || Type | Description |
_| Saved Queries 5 Administrator Add to 3 group. .. User Built-in account for admini...
B & mi.crosoﬂ.com E’JAIID}\'ed RODCI Disable Account Security Group ... Members in this group can...
| Builtin B, Cert Publishers Racet Password... Security Group ... Members of this group are...
—| Computers 82,0enied RODCP| Mave. .. Security Group .. Members in this group can...
2 | Domain Controllers 82 pomai . X . -
- N oo b, Domain Admins| Open Home Page Security Group ...  Designated administrators...
| ForeignSecurityPrincipals
T SﬂDomaln Comput Send Mail Security Group ... All workstations and serve...
- B=S SlJDomain Control ——— | Security Group ...  All domain controllers in th...
82, Domain Guests All Tasks M| security Group ... All domain guests
%Domain Users Cut Security Group ... All domain users
82 Enterprise Adm pelete Security Group ... Designated administrators...
%Enterprisa Real  Raname Security Group ...  Members of this group are...
EEGrnup Policy or ———————————————| Security Group ... Members in this group can...
2, Guest PLEEiEE User Built-in account for guest ...
S&MCI‘FP_USERS Help Security Group ...
.QERAS and IAS Servers Security Group ...  Servers in this group can ...
SﬂRead-only Domain Controllers Security Group ... Members of this group are...
E’JSChema Admins Security Group ...  Designated administrators...

O — ]

|Alluws you to add the selected objects to a group you select.

For Verification:

1. Go to Active Directory Users and Computers 2 Right click on Group =>Select

Properties = Select Members Tab = Verify for the User.
21|

"General Member Of I Managed Byl
Members:
Name Active Directory Domain Services Folder
3 MCITP1 microsoft.com./Users

Add... | Bemove |
QK I Cancel Lipply
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LIVE SETUP

MICROSOFT.COM

DC
192.168.1.101

T
& 1

Member Server Win 7 Client e
192.168.1.102 192.168.1.103 , .
ISP DNS /
Web Server o=y
61.0.0.7 I
) Web / Terminal P ¢
File / FTP Server DNS Server DHCP Server VPN Client
192.168.1.104 192.168.1.105 192.168.1.106

Web Server Terminal Server ADC Router—1/ VPN Router - Il
192.168.1.107 192.168.1.108 192.168.1.109 192.168.1.254 61.0.0.5

202.153.32.120] 202.153.32.150]
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DOCUMENTATION OF LIVE SETUP

Prerequisite:

Internal Network

Servers:
Domain Controller —192.168.1.101
File server —192.168.1.104
DNS server —192.168.1.105
DHCP server —192.168.1.106
Local Web server —192.168.1.107
FTP server —192.168.1.104
Terminal {RDP} server —192.168.1.108
Additional Domain controller —192.168.1.109
VPN server —192.168.1.254
Clients:
Member Server —192.168.1.102
Windows 7 Client —192.168.1.103
Router |
LAN Interface —192.168.1.254
WAN Interface —202.153.32.120

External Network:

Router Il
WAN Interface —202.153.32.150

WAN?2 Interface -61.0.0.5
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Clients:
Client -61.0.0.6
Web server -61.0.0.7

Configure 61.0.0.7 as Internet Web Server and DNS Server for www.Whatismyip.com

CONFIGURATION STEPS

e Configure 192.168.1.101 as Domain Controller along with DNS with the name
Microsoft.com
e Join all the systems to the domain (Windows 2008 / Windows 7)
e Create Users on DC & login using the same user from Client (Windows 2008 /
Windows 7)
e Configure 192.168.1.104 as File Server
o User profiles - Roaming
e Configure the Separate DNS server for Domain {obtain SRV Records} on
192.168.1.105
e Configure 192.168.1.106 as DHCP Server
o Scope
o Reservation for File server etc,
o Assign Dynamic IP’s to all systems

e Configure 192.168.1.107 as Web Server for www.Microsoft.com

o Create DNS zone for this site on DNS server only {192.168.1.105}.
o Access this web site from Internal network

e Configure 192.168.1.104 as FTP Server
o Access this FTP site from Internal network

e Configure 192.168.1.108 as Terminal {RDP} Server

o Access this Terminal server from Internal network
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Configure 192.168.1.109 as ADC for Microsoft.com
o Turn off the DC & login as user from Client or Member Server.
Configure 192.168.1.254 as Private Router | and WAN IP is 202.153.32.120
o Add Static Route for 61.0.0.0 network
Configure 202.153.32.150 as the Public Router Il and WAN IP is 61.0.0.5
o Add Static Route for 192.168.1.0 network

o Access www.Microsoft.comfrom External network

o Access the Local FTP site from External network
Configure Router | as NAT server
o Configure Local DNS Server to forward the request to ISP DNS
server{61.0.0.7}

o Access www.whatismyip.comfrom Internal network

Configure ROUTER1 as VPN Server

o Access the VPN server from External network
Maintain 61.0.0.6 as public client to access Terminal Server, VPN Server & Web
sites.

o Create a VPN Tunnel from 61.0.0.6 to 202.153.32.120

o Access www.Microsoft.com from External network through VPN

o Access the Terminal server from External network through VPN
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